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Preface

Welcome to the Book!

Thanks!

Thanks for your interest in developing applications for Android! Android has grown
from nothing to arguably the world’s most popular smartphone OS in a few short
years. Whether you are developing applications for the public, for your business or
organization, or are just experimenting on your own, I think you will find Android to
be an exciting and challenging area for exploration.

And, most of all, thanks for your interest in this book! I sincerely hope you find it
useful and at least occasionally entertaining.

The Book’s Structure

As you may have noticed, this is a rather large book.

To make the equivalent of 2,800+ pages of material manageable, the chapters are
divided into the core chapters and a series of trails.

The core chapters represent many key concepts that Android developers need to
understand in order to build an app. While an occasional “nice to have” topic will
drift into the core — to help illustrate a point, for example — the core chapters
generally are fairly essential.

The core chapters are designed to be read in sequence and will interleave both
traditional technical book prose with tutorial chapters, to give you hands-on
experience with the concepts being discussed. Most of the tutorials can be skipped,
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though the first two — covering setting up your SDK environment and creating a
project — everybody should read.

The bulk of the chapters are divided into trails, covering some particular general
topic, from data storage to advanced Ul effects to performance measurement and
tuning. Each trail will have several chapters. However, those chapters, and the trails
themselves, are not necessarily designed to be read in any order. Each chapter in the
trails will point out prerequisite chapters or concepts that you will want to have
covered in advance. Hence, these chapters are mostly reference material, for when
you specifically want to learn something about a specific topic.

The core chapters will link to chapters in the trails, to show you where you can find
material related to the chapter you just read. So between the book’s table of
contents, this preface, the search tool in your digital book reader, and the cross-
chapter links, you should have plenty of ways of finding the material you want to
read.

You are welcome to read the entire book front-to-back if you wish. The trails will
appear after the core chapters. Those trails will be in a reasonably logical order,
though you may have to hop around a bit to cover all of the prerequisites.

The Trails

Here is a list of all of the trails and the chapters that pertain to those trails, in order
of appearance (except for those appearing in the list multiple times, where they span
major categories):

Code Organization and Gradle

+ Working with Library Projects

+ Gradle and Legacy Projects

* Gradle and Tasks

+ Gradle and the New Project Structure
+ Gradle and Dependencies

* Manifest Merger Rules

* Signing Your App

» Distribution

* Advanced Gradle for Android Tips
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Testing

+ JUnit and Android

+ Testing with JUnitg

* MonkeyRunner and the Test Monkey
+ Testing with UlAutomator

Advanced Ul

+ Introducing GridLayout
+ Dialogs and DialogFragments
« Advanced ListViews

+ Action Bar Navigation

» Action Modes and Context Menus

+ Other Advanced Action Bar Techniques

+ AppCompat: The Official Action Bar Backport
» ActionBarSherlock

+ Implementing a Navigation Drawer
« Advanced Uses of WebView

* The Input Method Framework
 Fonts

* Rich Text

* Animators

+ Legacy Animations

* Custom Drawables

+ Mapping with Maps V2

+ Crafting Your Own Views

+ Custom Dialogs and Preferences
* Progress Indicators

» Advanced Notifications

* More Fun with Pagers

+ Focus Management and Accessibility
« Miscellaneous UI Tricks

« Event Bus Alternatives
Home Screen Effects

+ Home Screen App Widgets
+ Adapter-Based App Widgets
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Data Storage and Retrieval

+ Content Provider Theory

+ Content Provider Implementation Patterns
* The Loader Framework

» The ContactsContract Provider
» The CalendarContract Provider
* The MediaStore Provider

* Consuming Documents

+ Providing Documents

+ Encrypted Storage

+ Packaging and Distributing Data

+ Advanced Database Techniques

+ Miscellaneous Network Capabilities

+ Audio Playback

+ Audio Recording

+ Video Playback

+ Using the Camera via 3rd-Party Apps

+ Working Directly with the Camera
+ The MediaStore Provider

* Media Routes

+ Supporting External Displays

+ Google Cast and ChromeCast
e The “10 Foot UI”

+ Putting the T'Vs All Together: Decktastic
+ Creating a MediaRouteProvider

Security

* SSL

+ Encrypted Storage

* Advanced Permissions

* Restricted Profiles and UserManager
+ Tapjacking

* Miscellaneous Security Techniques
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Hardware and System Services

* Accessing Location-Based Services
» The Fused Location Provider

+ Working with the Clipboard

+ Telephony

+ Working With SMS
« NFC

* Device Administration

+ PowerManager and Wakel.ocks

* JobScheduler
» Push Notifications with GCM

» Basic Use of Sensors

+ Printing and Document Generation
+ Other System Settings and Services
* Dealing with Different Hardware

Integration and Introspection

* Responding to URLs

+ Plugin Patterns

+ PackageManager Tricks

* Searching with SearchManager

+ Remote Services and the Binding Pattern
+ Advanced Manifest Tips

* Miscellaneous Integration Tips

* Reusable Components

Scripting Languages

+ The Role of Scripting L.anguages
* The Scripting Layer for Android
* JVM Scripting Languages

Other Tools

+ Advanced Emulator Capabilities
+ Using Lint

+ Using Hierarchy View

+ Using DDMS
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+ Finding CPU Bottlenecks
+ Finding Memory Leaks with MAT

Tuning Android Applications

+ Issues with Speed

+ Finding CPU Bottlenecks

« NDK

+ Improving CPU Performance in Java
+ Finding and Eliminating Jank

 Issues with Bandwidth
« Focus On: TrafficStats

* Measuring Bandwidth Consumption
+ Being Smarter About Bandwidth

+ Issues with Application Heap

+ Finding Memory Leaks with MAT

+ Issues with System RAM

+ Issues with Battery Life

+ Other Power Measurement Options
* Sources of Power Drain

*+ Addressing Application Size Issues
Alternatives for App Development

» The Role of Alternative Environments

- HTMlL5

+ PhoneGap
e Other Alternative Environments

Miscellaneous Topics

* Anti-Patterns

Widget Catalog

+ AdapterViewFlipper
+ CalendarView

« DatePicker

+ ExpandableListView
+ SeekBar
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+ SlidingDrawer
« StackView

« TabHost
« TimePicker

+ ViewFlipper

Device Catalog

Kindle Fire

+ BlackBerry
* Wrist Wearables

* Google TV
* Amazon Fire TV

Appendices

+ Appendix A: CWAC Libraries

About the Updates

This book is updated frequently, typically every 6-8 weeks.

Each release has notations to show what is new or changed compared with the
immediately preceding release:

+ The Table of Contents shows sections with changes in bold-italic font
+ Those sections have changebars on the right to denote specific paragraphs
that are new or modified

Warescription

You (hopefully) are reading this digital book by means of a Warescription.

The Warescription entitles you, for the duration of your subscription, to digital
editions of this book and its updates, in PDF, EPUB, and Kindle (MOBI/KF8)
formats. You also have access to a version of the book as its own Android APK file,
complete with high-speed full-text searching. You also have access to other titles
that CommonsWare may publish during that subscription period.
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Each subscriber gets personalized editions of all editions of each title. That way,
your books are never out of date for long, and you can take advantage of new
material as it is made available. For example, when new releases of the Android SDK
are made available, this book will be quickly updated to be accurate with changes in
the APIs.

However, you can only download the books if either you have an active
Warescription, or until the book is updated after your Warescription expires. Hence,
please download your updates as they come out. You can find out when new
releases of this book are available via:

1. The commonsguy Twitter feed
2. The CommonsBlog

3. The Warescription newsletter, which you can subscribe to off of your

Warescription page
4. Just check back on the Warescription site every month or two

Subscribers also have access to other benefits, including:

+ “Office hours” — online chats to help you get answers to your Android
application development questions. You will find a calendar for these on
your Warescription page.

+ A Stack Overflow “bump” service, to get additional attention for a question
that you have posted there that does not have an adequate answer.

+ 80% off of live webinars hosted by Mark Murphy, the author of this book, on
Android application development topics.

Book Bug Bounty

Find a problem in one of our books? Let us know!

Be the first to report a unique concrete problem in the current digital edition, and
we will extend your Warescription by six months as a bounty for helping us deliver a
better product.

By “concrete” problem, we mean things like:
1. Typographical errors

2. Sample applications that do not work as advertised, in the environment
described in the book
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3. Factual errors that cannot be open to interpretation

By “unique”, we mean ones not yet reported. Be sure to check the book’s errata page,
though, to see if your issue has already been reported. One coupon is given per
email containing valid bug reports.

We appreciate hearing about “softer” issues as well, such as:

1. Places where you think we are in error, but where we feel our interpretation
is reasonable

2. Places where you think we could add sample applications, or expand upon
the existing material

3. Samples that do not work due to “shifting sands” of the underlying
environment (e.g., changed APIs with new releases of an SDK)

However, those “softer” issues do not qualify for the formal bounty program.

Questions about the bug bounty, or problems you wish to report for bounty

consideration, should be sent to bounty@commonsware.com.

Source Code and Its License

The source code samples shown in this book are available for download from the
book’s GitHub repository. All of the Android projects are licensed under the Apache
2.0 License, in case you have the desire to reuse any of it.

If you wish to use the source code from the GitHub repository, please follow the
instructions on that repository’s home page for details of how to use the projects in
various development environments, notably Eclipse and Android Studio.

If you are using Eclipse, please do NOT import all of the projects from the repo into
your main workspace. There are hundreds of these projects, and they may cause your
Eclipse environment to become very slow, particularly when starting it up. Instead,
import only those specific projects that you want to work with “live” as opposed to
simply reading about them in the book.

Copying source code directly from the book, in the PDF editions, works best with
Adobe Reader, though it may also work with other PDF viewers. Some PDF viewers,
for reasons that remain unclear, foul up copying the source code to the clipboard
when it is selected.
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Creative Commons and the Four-to-Free (42F)
Guarantee

Each CommonsWare book edition will be available for use under the Creative
Commons Attribution-Noncommercial-ShareAlike 3.0 license as of the fourth
anniversary of its publication date, or when 4,000 copies of the edition have been
sold, whichever comes first. That means that, once four years have elapsed (perhaps
sooner!), you can use this prose for non-commercial purposes. That is our Four-to-
Free Guarantee to our readers and the broader community. For the purposes of this
guarantee, new Warescriptions and renewals will be counted as sales of this edition,
starting from the time the edition is published.

This edition of this book will be available under the aforementioned Creative
Commons license on 1 January 2019. Of course, watch the CommonsWare Web site,
as this edition might be relicensed sooner based on sales.

For more details on the Creative Commons Attribution-Noncommercial-ShareAlike
3.0 license, visit the Creative Commons Web site

Note that future editions of this book will become free on later dates, each four years
from the publication of that edition or based on sales of that specific edition.
Releasing one edition under the Creative Commons license does not automatically
release all editions under that license.

Acknowledgments
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Key Android Concepts

No doubt, you are in a hurry to get started with Android application development.
After all, you are reading this book, aimed at busy coders.

However, before we dive into getting tools set up and starting in on actual
programming, it is important that we “get on the same page” with respect to several
high-level Android concepts. This will simplify further discussions later in the book.

Android Applications

This book is focused on writing Android applications. An application is something
that a user might install from the Play Store or otherwise download to their device.
That application should have some user interface, and it might have other code
designed to work in the background (multi-tasking).

This book is not focused on modifications to the Android firmware, such as writing
device drivers. For that, you will need to seek other resources.

This book assumes that you have some hands-on experience with Android devices,
and therefore you are familiar with buttons like HOME and BACK, the built-in
Settings application, the concept of a home screen and launcher, and so forth. If you
have never used an Android device, you are strongly encouraged to get one (e.g., a
used one on eBay, Craigslist, etc.) and spend some time with it before starting in on
learning Android application development.

1
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Programming Language

The vast majority of Android applications are written exclusively in Java. Hence, that
is what this book will spend most of its time on and will demonstrate with a
seemingly infinite number of examples.

However, there are other options:

* You can write parts of the app in C/C++, for performance gains, porting over
existing code bases, etc.

* You can write an entire app in C/C++, mostly for games using OpenGL for
3D animations

* You can write the guts of an app in HTML, CSS, and JavaScript, using tools
to package that material into an Android application that can be distributed
through the Play Store and similar venues

* And so on

Coverage of these non-Java alternatives will be found in the trails of this book, as the
bulk of this book is focused on Java.

The author assumes that you know Java at this point. If you do not, you will need to
learn Java before you go much further. You do not need to know everything about
Java, as Java is vast. Rather, focus on:

+ Language fundamentals (flow control, etc.)
» Classes and objects

» Methods and data members

* Public, private, and protected

+ Static and instance scope

+ Exceptions
* Threads

+ Collections
* Generics
« FileI/O
* Reflection
 Interfaces

The links are to Wikibooks material on those topics, though there are countless
other Java resources for you to consider.

2
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Components

When you first learned Java — whether that was yesterday or back when dinosaurs
roamed the Earth — you probably started off with something like this:

class SillyApp {
public static void main(String[] args) {
System.out.println("Hello World!");
}
}

In other words, the entry point into your application was a public static void
method named main() that took a String array of arguments. From there, you were
responsible for doing whatever was necessary.

However, there are other patterns used elsewhere in Java. For example, you do not
usually write a main() method when writing a Java servlet. Instead, you extend a
particular class supplied by a framework (e.g., HttpServlet) to create a component,
then write some metadata that enumerates your components and tell the framework
when and how to use them (e.g., WEB.XML).

Android apps are closer in spirit to the servlet approach. You will not write a
public static void main() method. Instead, you will create subclasses of some
Android-supplied base classes that define various application components. In
addition, you will create some metadata that tells Android about those subclasses.

There are four types of components, all of which will be covered extensively in this
book:

Activities

The building block of the user interface is the activity. You can think of an activity as
being the Android analogue for the window or dialog in a desktop application, or
the page in a classic Web app. It represents a chunk of your user interface and, in
some cases, a discrete entry point into your app (i.e., a way for other apps to link to

your app).

Normally, an activity will take up most of the screen, leaving space for some
“chrome” bits like the clock, signal strength indicators, and so forth.

3
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@ Action Bar Demo
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Figure 1: Activity on the screen

Services

Activities are short-lived and can be shut down at any time, such as when the user
presses the BACK button. Services, on the other hand, are designed to keep running,
if needed, independent of any activity, for a moderate period of time. You might use
a service for checking for updates to an RSS feed, or to play back music even if the
controlling activity is no longer operating. You will also use services for scheduled
tasks (akin to Linux or OS X “cron jobs”) and for exposing custom APIs to other
applications on the device, though the latter is a relatively advanced capability.

Content Providers

Content providers provide a level of abstraction for any data stored on the device
that is accessible by multiple applications. The Android development model
encourages you to make your own data available to other applications, as well as
your own — building a content provider lets you do that, while maintaining a degree
of control over how your data gets accessed.

4
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Broadcast Receivers

The system, or applications, will send out broadcasts from time to time, for
everything from the battery getting low, to when the screen turns off, to when
connectivity changes from WiFi to mobile data. A broadcast receiver can arrange to
listen for these broadcasts and respond accordingly.

Widgets, Containers, Resources, and Fragments

Most of the focus on Android application development is on the Ul layer and
activities. Most Android activities use what is known as “the widget framework” for
rendering their user interface, though you are welcome to use the 2D (Canvas) and
3D (OpenGL) APIs as well for more specialized GUIs.

In Android terms, a widget is the “micro” unit of user interface. Fields, buttons,
labels, lists, and so on are all widgets. Your activity’s Ul, therefore, is made up of one
or more of these widgets. For example, here we see label (TextView), field
(EditText), and push-button (Button) widgets:

*& RelativeLayoutDemo

TextView ——» <«—— EditText

CUCCINDIE «——— Button (2)

Figure 2: Activity with widgets

If you have more than one widget — which is fairly typical — you will need to tell
Android how those widgets are organized on the screen. To do that, you will use
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various container classes referred to as layout managers. These will let you put
things in rows, columns, or more complex arrangements as needed.

To describe how the containers and widgets are connected, you will typically create a
layout resource file. Resources in Android refer to things like images, strings, and
other material that your application uses but is not in the form of some
programming language source code. Ul layouts are another type of resource. You will
create these layouts either using a structured tool, such as an IDE’s drag-and-drop
GUI builder, or by hand in XML form.

Sometimes, your Ul will work across all sorts of devices: phones, tablets, televisions,
etc. Sometimes, your Ul will need to be tailored for different environments. You will
be able to put resources into resource sets that indicate under what circumstances
those resources can be used (e.g., use these for normal-sized screens, but use those
for larger screens).

Sometimes, supporting larger screens means you will want to “snap together” parts
of your smaller-screen UI. For example, Gmail on a tablet will show your list of
labels, the list of conversations in a selected label, and the list of messages in a
selected conversation, all in one activity. However, Gmail on a phone cannot do that,
as there is not enough screen space, so it shows each of those (labels, conversations,
messages) in separate activities. Android supplies a construct called the fragment to
help make it easier for you to implement these sorts of effects.

We will be examining all of these concepts, in much greater detail, as we get deeper
into the book.

Apps and Packages

Given a bucket of source code and a basket of resources, the Android build tools will
give you an application as a result. The application comes in the form of an APK file.
It is that APK file that you will upload to the Play Store or distribute by other means.

Each Android application has a package name. A package name must fulfill three
requirements:

1. It must be a valid Java package name, as some Java source code will be
generated by the Android build tools in this package

2. No two applications can exist on a device at the same time with the same
package

6
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3. No two applications can be uploaded to the Play Store having the same
package

Note that sometimes you will see reference to an “application ID” — this is the role
of the package name from the second and third items in the list.

When you create your Android project — the repository of that source code and
those resources — you will declare what package name is to be used for your app.
Typically, you will pick a package name following the Java package name “reverse
domain name” convention (e.g., com.commonsware.android.foo). That way, the
domain name system ensures that your package name prefix (com.commonsware) is
unique, and it is up to you to ensure that the rest of the package name distinguishes
one of your apps from any other.

Android Devices

There are well in excess of one billion Android devices in use today, representing
thousands of different models from dozens of different manufacturers. Android
itself has evolved since Android 1.0 in 2008. Between different device types and
different Android versions, many a media pundit has lobbed the term
“fragmentation” at Android, suggesting that creating apps that run on all these
different environments is impossible.

In reality, it is not that bad. Some apps will have substantial trouble, but most apps
will work just fine if you follow the guidance presented in this book and in other
resources.

Types

Android devices come in all shapes, sizes, and colors. However, there are four
dominant “form factors”:

* the phone

the tablet

* the television (TV)

* the wearable (smart watches, Google Glass, etc.)

You will often hear developers and pundits refer to these form factors, and this book
will do so from time to time as well. However, it is important that you understand
that Android has no built-in concept of a device being a “phone” or a “tablet” or a

7
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“TV”. Rather, Android distinguishes devices based on capabilities and features. So,
you will not see an isPhone() method anywhere, though you can ask Android:

+ what is the screen size?
* does the device have telephony capability?
. etc.

Similarly, as you build your applications, rather than thinking of those four form
factors, focus on what capabilities and features you need. Not only will this help you
line up better with how Android wants you to build your apps, but it will make it
easier for you to adapt to other form factors that will come about such as:

+ airplane seat-back entertainment centers
* in-car navigation and entertainment devices
+ and so on

The Emulator

While there are over a billion Android devices representing thousands of models,
probably you do not have one of each model. You may only have a single piece of
Android hardware. And if you do not even have that, you most certainly will want to
acquire one before trying to publish an Android app.

To help fill in the gaps between the devices you have and the devices that are
possible, the Android developer tools ship an emulator. The emulator behaves like a
piece of Android hardware, but it is a program you run on your development
machine. You can use this emulator to emulate many different devices, with
different screen sizes and Android OS versions, by creating one or more Android
virtual devices, or AVDs.

In an upcoming chapter, we will discuss how you install the Android developer tools
and how you will be able to create these AVDs and run the emulator.

OS Versions and API Levels

Android has come a long way since the early beta releases from late 2007. Each new
Android OS version adds more capabilities to the platform and more things that
developers can do to exploit those capabilities.

Moreover, the core Android development team tries very hard to ensure forwards
and backwards compatibility. An app you write today should work unchanged on

8
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future versions of Android (forwards compatibility), albeit perhaps missing some
features or working in some sort of “compatibility mode”. And there are well-trod
paths for how to create apps that will work both on the latest and on previous
versions of Android (backwards compatibility).

To help us keep track of all the different OS versions that matter to us as developers,
Android has API levels. A new API level is defined when an Android version ships
that contains changes that affect developers. When you create an emulator AVD to
test your app, you will indicate what API level that emulator should emulate. When
you distribute your app, you will indicate the oldest API level your app supports, so
the app is not installed on older devices.

At the time of this writing, the API levels of significance to most Android developers
are:

+ API Level 10 (Android 2.3.3)
+ API Level 15 (Android 4.0.3)
+ API Level 16 (Android 4.1)
+ API Level 17 (Android 4.2)
* API Level 18 (Android 4.3)
* API Level 19 (Android 4.4)

Here, “of significance” refers to API levels that have a reasonable number of Android
devices — 5% or more, as reported by the “Platform Versions” dashboard chart.

The latest API level for most form factors is 21, representing Android 5.0. There is an
API Level 20, which is the version of Android running on the first-generation
Android Wear devices. Unless you are specifically developing apps for Wear, you will
not be worrying much about API Level 20.

Dalvik

In terms of Android, Dalvik is a virtual machine (VM). Virtual machines are used by
many programming languages, such as Java, Perl, and Smalltalk. The Dalvik VM is
designed to work much like a Java VM, but optimized for embedded Linux
environments.

So, what really goes on when somebody writes an Android application is:

1. Developers write Java-syntax source code, leveraging class libraries published
by the Android project and third parties.

9

Licensed solely for use by Qiwen Chen


http://developer.android.com/about/dashboards/index.html

KEY ANDROID CONCEPTS

2. Developers compile the source code into Java VM bytecode, using the javac
compiler that comes with the Java SDK.

3. Developers translate the Java VM bytecode into Dalvik VM bytecode, which
is packaged with other files into a ZIP archive with the . apk extension (the
APK file).

4. An Android device or emulator runs the APK file, causing the bytecode to be
executed by an instance of a Dalvik VM.

From your standpoint, most of this is hidden by the build tools. You pour Java source
code into the top, and the APK file comes out the bottom.

However, there will be places from time to time where the differences between the
Dalvik VM and the traditional Java VM will affect application developers, and this
book will point out some of them where relevant.

Note that Android is moving to a new runtime environment, called ART. However,
the “Dalvik” term will still be used for the bytecode that is generated as part of
building an APK.

Processes and Threads

When your application runs, it will do so in its own process. This is not significantly
different than any other traditional operating system. Part of Dalvik’s magic is
making it possible for many processes to be running many Android applications at
one time without consuming ridiculous amounts of RAM.

Android will also set up a batch of threads for running your app. The thread that
your code will be executed upon, most of the time, is variously called the “main
application thread” or the “Ul thread”. You do not have to set it up, but, as we will
see later in the book, you will need to pay attention to what you do and do not do on
that thread. You are welcome to fork your own threads to do work, and that is fairly
common, though in some places Android handles that for you behind the scenes.

Don’t Be Scared

Yes, this chapter threw a lot of terms at you. We will be going into greater detail on
all of them in this book. However, Android is like a jigsaw puzzle with lots of
interlocking pieces. To be able to describe one concept in detail, we will need to at
least reference some of the others. Hence, this chapter was meant to expose you to
terms, in hopes that they will sound vaguely familiar as we dive into the details.
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Before you go much further in your Android endeavors (or, possibly, endeavours,
depending upon your preferred spelling), you will need to determine what toolchain
you will use to build your Android applications.

Android Studio

The next-generation Google-backed Android IDE is Android Studio. Based off of
Intelli] IDEA, Android Studio is the new foundation of Google’s efforts to give
Android developers top-notch development tools. While it only reached a version 1.0
status in December 2014, Android Studio had been in use for ~18 months prior to
that in various early-access and beta stages. While it still has bugs, it is certainly
stable enough for app development.

The next chapter contains a section with instructions on how to set up Android
Studio.

Eclipse

Eclipse is also a popular IDE, particularly for Java development. Eclipse was Google’s
original IDE for Android development, by means of the Android Developer Tools
(ADT) add-in, which gives the core of Eclipse awareness of Android. The ADT add-
in, in essence, takes regular Eclipse operations and extends them to work with
Android projects.
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Note, though, that Google has discontinued maintenance of ADT. The Eclipse
Foundation is setting up the “Andmore” project to try to continue work on allowing
Eclipse to build Android apps. This book does not cover the Andmore project at this
time, and developers are strongly encouraged to not use the ADT-enabled Eclipse
from Google.

For historical reasons, the next chapter contains a section with instructions on how
to set up Eclipse for Android development, as part of getting an overall Android

development environment established. Similarly, there will be Eclipse instructions in
the tutorials and notes about using Eclipse elsewhere in the book. These will be
removed from a future edition of the book, or perhaps migrated over to Andmore.

IntelliJ IDEA

While Android Studio is based off of Intelli] IDEA, you can still use the original
Intelli] IDEA for Android app development. A large subset of the Android Studio
capabilities are available in the Android plugin for IDEA. Plus, the commercial IDEA
Ultimate Edition will go beyond Android Studio in many areas outside of Android
development.

Command-Line Builds via Gradle for Android

And, of course, you do not need to use an IDE at all. While this may sound
sacrilegious to some, IDEs are not the only way to build applications. Much of what
is accomplished via the ADT can be accomplished through command-line
equivalents, meaning a shell and an editor is all you truly need. For example, the
author of this book did not use an IDE for Android development until 2011.

The recommended way to build Android apps outside of an IDE is by means of
Gradle. Google has published a Gradle plugin that teaches Gradle how to build
Android apps. Android Studio itself uses Gradle for its builds, so a single build
configuration (e.g., build.gradle files) can be used both from an IDE and from a
build automation tool like a continuous integration server.

An upcoming chapter gets into more about what Gradle (and the Gradle for Android
plugin) are all about.
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Yet Other Alternatives

Other IDEs have their equivalents of the ADT, albeit with minimal assistance from
Google. For example, NetBeans has support via the NBAndroid add-on, and
reportedly this has advanced substantially in the past few years.

You will also hear reference to using Apache Ant for doing command-line builds of
Android apps. This has largely been supplanted by Gradle for Android at this time,
and support for Apache Ant will end soon. Newcomers to Android are encouraged to
not invest time in new work with Apache Ant for Android development projects.

IDEs... And This Book

You are welcome to use Android Studio or Eclipse as you work through this book.
You are welcome to use another IDE if you wish. You are even welcome to skip the
IDE outright and just use an editor.

This book is focused primarily on demonstrating Android capabilities and the APIs
for exploiting those capabilities. Hence, the sample code will work with any IDE.
However, this book will cover some Android Studio- and Eclipse-specific
instructions, since they are the predominant answers today.

The tutorials will have instructions for both Android Studio and Eclipse.

What We Are Not Covering

In the beginning (a.k.a., 2007), we were lucky to have any means of creating an
Android app.

Nowadays, there seems to be no end to the means by which we can create an
Android app.

There are a few of these “means’, though, that are specifically out of scope for this
book.

App Inventor

You may also have heard of a tool named App Inventor and wonder where it fits in
with all of this.
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App Inventor was originally created by an education group within Google, as a
means of teaching students how to think about programming constructs (branches,
loops, etc.) and create interesting output (Android apps) without classic
programming in Java or other syntax-based languages. App Inventor is purely drag-
and-drop, both of widgets and application logic, the latter by means of “blocks” that
snap together to form logic chains.

App Inventor was donated by Google to MIT, which has recently re-opened it to the
public.

However, App Inventor is a closed system — at the present time, it does not
somehow generate Java code that you can later augment. That limits you to whatever
App Inventor is natively capable of doing, which, while impressive in its own right,
offers a small portion of the total Android SDK capabilities.

App Generators

There are a seemingly infinite number of “app generators” available as online
services. These are designed mostly for creating apps for specific vertical markets,
such as apps for restaurants or apps for grocers. The resulting apps are mostly
“brochure-ware”, with few capabilities beyond a mobile Web site, yet still requiring
the user to find, download, and install the app. Few of these generators provide the
source code to the generated app, to allow the apps to be customized beyond what
the generator generates.
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Now, let us get you set up with the pieces and parts necessary to build an Android
app.

NOTE: The instructions presented here are accurate as of the time of this writing.
However, the tools change rapidly, and so these instructions may be out of date by
the time you read this. Please refer to the Android Developers Web site for current
instructions, using this as a base guideline of what to expect.

Step #1 - Checking Your Hardware Requirements

Compiling and building an Android application, on its own, is not especially
hardware-intensive, except for very large projects. However, there are two
commonly-used tools that demand more from your development machine: your IDE
and the Android emulator. Of the two, the emulator poses the bigger problem.

The more RAM you have, the better. 8GB or higher is a very good idea if you intend
to use an IDE and the emulator together.

A faster CPU is also a good idea. However, the Android emulator only utilizes a
single core from your development machine. Hence, it is the single-core speed that
matters. The best CPU to use is one that can leverage multiple cores to give what
amounts to a faster single core, such as Intel’s Core i7 with Turbo Boost. For an
emulator simulating a larger-screened device (e.g., tablet, television), a Core i7 that
can “boost” up to 3.4GHz makes development much more pleasant. Conversely, a
CPU like a Core 2 Duo with a 2.5GHz clock speed results in a tablet emulator that is
nearly unusable.

15

Licensed solely for use by Qiwen Chen


http://developer.android.com

TUTORIAL #1 - INSTALLING THE TOOLS

Step #2 - Setting Up Java and 32-Bit Linux Support

When you write Android applications, you typically write them in Java source code.
That Java source code is then turned into the stuff that Android actually runs
(Dalvik bytecode in an APK file).

You need to obtain and install the official Sun/Oracle Java SE SDK (JDK). You can
obtain this from the Oracle Java Web site for Windows, OS X, and Linux. The plain
JDK (sans any “bundles”) should suffice. Follow the instructions supplied by Oracle
or Apple for installing it on your machine. At the time of this writing, Android
supports Java 6 and Java 7, though Java 7 is required for certain scenarios and
therefore is recommended. Java 8 works, though you may have to do additional
work to configure your IDE to have Java 8 emit Java 7-compatible bytecode.

Android also supports the Open]DK, particularly on Linux environments.

What Android does not support are any other Java compilers, including the GNU
Compiler for Java (GCJ).

If your development OS is Linux, make sure that you can run 32-bit Linux binaries.
This may or may not already be enabled in your Linux distro. For example, on
Ubuntu 14.10, you may need to run the following to get the 32-bit binary support
installed that is needed by the Android build tools:

sudo apt-get install 1ib32z1 1lib32ncurses5 1ib32bz2-1.0 1ib32stdc++6

Step #3 - Install the Developer Tools

As noted in the previous chapter, there are a few developer tools that you can choose
from.

There are three major options that this book covers:

1. Use Android Studio
2. Use Eclipse, as a fresh install via the ADT Bundle

3. Use Eclipse, adding in the ADT plugin to an existing Eclipse installation

A fourth option would be to skip either IDE and just use the Android SDK and
Gradle for Android directly. This would only be appropriate for fairly expert
developers, and so the tutorials do not walk you through this path. This book has
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several chapters on Gradle, but those chapters are presently designed for developers
already experienced in working with Android apps. For the purposes of learning
Android, you are better served working with one of the supported IDEs initially.
Later on, if you wish to drop the IDE and use Gradle for Android directly, you are
welcome to do so.

Options #2 and #3 are close to being mutually exclusive. And, as noted earlier in the
book, Eclipse support has been officially dropped by Google and, therefore, you
really should consider using Android Studio over Eclipse today. Otherwise, you are
welcome to choose one or more of these options. The installation instructions for
each are described in the sections that follow.

Option #1 - Android Studio

Visit the Android Studio download page, download the ZIP file for your platform,
and unZIP it to some likely spot on your hard drive. Windows users who choose to
download the self-installing EXE can just run that file.

Android Studio can then be run from the studio batch file or shell script from your
Android Studio installation’s bin/ directory.

Option #2 - Android ADT Bundle
The Android ADT Bundle contains:

+ The Android SDK, which gives you all the tools you need to create and test
Android applications. It comes in two parts: the base tools, plus version-
specific SDKs and related add-ons.

* A copy of Eclipse, with the Android Developer Tools (ADT) plug-in pre-

installed.

From the Android Developer site’s SDK area, choose the ADT Bundle ZIP file that is
appropriate for your development machine and unZIP it in some likely location.

Option #3 - Install the ADT for Eclipse

To use Eclipse, you will need to install the base Android SDK, then configure Eclipse.
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Install the Android SDK

The Android developer tools can be found on the Android Developers Web site.

You will want to click on “Using an Existing IDE” (even if you have not yet installed
Eclipse) and download the ZIP or TGZ file presented to you, unpacking it in some
likely spot — there is no specific path that is required. Windows users also have the
option of running a self-installing EXE file.

Configure Eclipse

If you have not yet installed Eclipse, you will need to do that first. Eclipse can be
downloaded from the Eclipse Web site. The “Eclipse IDE for Java Developers”
package will work fine. Note that the Android tools require Eclipse 3.7 (Indigo) or
newer at the time of this writing.

If you already had Eclipse installed, it is a good idea for you to go in and check your
compiler compliance level (Preferences > Java > Compiler). That should be set to 1.6.
Notably, this allows the use of @0verride annotations to indicate methods that are
implementing a Java interface, rather than truly overriding a superclass method.
This annotation is very common in Java code in Android projects (including many of
the samples in this book).

Next, you need to install the Android Developer Tools (ADT) plug-in. To do this, go
to Help | Install New Software... in the Eclipse main menu. Then, click the Add
button to add a new source of plug-ins. Give it some name (e.g., Android) and
supply the following URL: https://dl-ssl.google.com/android/eclipse/. That
should trigger Eclipse to download the roster of plug-ins available from that site:
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Available Software I
Check the items that you wish to install. - )i_ f
Work with: |Android - https://dl-ssl.google.com/android/eclipse/ v Add...

Find more software by working with the "Available Software Sites" preferences.

Name Version

¥ [ i Developer Tools

§* Android DDMS 8.0.1.v201012062107-82219
4 Android Development Tools 8.0.1.v201012062107-82219
4+ Android Hierarchy Viewer 8.0.1.v201012062107-82219
Select All Deselect All
Details
& show only the latest versions of available software Hide items that are already installed
& Group items by category What is already installed?

& Contact all update sites during install to find required software

)] ex Cancel

Figure 3: Eclipse ADT plug-in installation

Check the checkbox to the left of “Developer Tools” and click the Next button.
Follow the rest of the wizard to review the tools to be downloaded and their
respective license agreements. When the Finish button is enabled, click it, and
Eclipse will download and install the plug-ins. When done, Eclipse will ask to restart
— please let it.

Then, you need to teach ADT where your Android SDK installation is from the
preceding section. This should occur on your next restart of Eclipse, via a “welcome
wizard”. Otherwise, to do this, choose Window | Preferences from the Eclipse main
menu (or the equivalent Preferences option for OS X). Click on the Android entry in
the list on the left:
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@ Preferences

It ] @ value must be an existing directory Ao —

General
Android

Ant

Help
Install/Update
Java
Run/Debug
Tasks

Team

Android Preferences

SDK Location: Browse...

Note: The list of SDK Targets below is only reloaded once you hit 'Apply"' or 'OK".

¥ ¥ ¥ ¥ ¥ wv ¥ vjxvr

Usage Data Collecto
Validation
= XML

Restore Defaults

P
'k?) Cancel

Figure 4: Eclipse ADT Configuration

Then, click the Browse... button to find the directory where you installed the SDK.
After choosing it, click Apply on the Preferences window, and you should see the
Android SDK versions you installed previously. Then, click OK, and the ADT will be
ready for use.

Step #4 - Install the SDKs and Add-Ons

Next, we need to review what pieces of the Android SDK we have already and
perhaps install some new items. To do that, you need to access the SDK Manager.

Android Studio First Run and SDK Manager Launch

When you first run Android Studio, you may be asked if you want to import settings
from some other prior installation of Android Studio:
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Complete Installation

You canimpart your settings from a previous version of Android Studio,

© liwant to import my settings from a custom location)
Specify config Folder orinstallation home of the previous version of Android Studic:

@® |donot have a previous version of Android Studio or | do not want to impart my settings

K]
Figure 5: Android Studio First-Run Settings Migration Dialog

For most users, particularly those using Android Studio for the first time, the “I do

).

not have...” option is the correct choice to make.

Then, after a short splash screen, you will be taken to the Android Studio Setup
Wizard:

Android Studio Setup

Setup Wizard - Welcome

Android Studio

Welcome! This wizard will set up your development environment for Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studio
or create a new Android application project.

§Uo =N

Previous Next ‘ Cance| ] ‘ Finish

Figure 6: Android Studio Setup Wizard, First Page

Just click “Next” to advance to the second page of the wizard:
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Android Studio Setup

Setup Wizard

A Android Studio

Choose the type of setup you want for Android Studio:

@ Standard

Android Studio will be installed with the most common settings and options.
Recommended for most users,

() Custom

You can customize installation settings and components installed.

Previous ‘ Cance| J ‘ Finish
Figure 7: Android Studio Setup Wizard, Second Page

Here, you have a choice between “Standard” and “Custom” setup modes. “Custom”
simply allows you to indicate what should be set up:
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Android Studio Setup

L o Setup Wizard - SDK Settings

A Android Studio

Check the components you want to updatefinstall, Click Next to continue,

_ | The collection of Android platform APIs, tools and

#) android virtual Device - (1 GiB) ¢l utilities that enables you to debug, profile, and compile
‘| your apps.

The setup wizard will update your current Android SDKE
installation (if necessary) or install a new version.

Android SDK Location: Total disk space required: 3.25 GiB
Jhome/mmurphy/Android/Sdic ‘D Available disk space: 6.43 GiB

Previous ‘ Cance| ] ‘ Finish
Figure 8: Android Studio Setup Wizard, Custom Page

Most likely, right now, you need all of that anyway, so the “Standard” route would be
fine.

If you go the “Standard” route and click “Next”, you may be taken to a wizard page
explaining some information about the Android emulator:
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Android Studio Setup

Setup Wizard - Emulator Settings

- Android Studio

We have detected that your system can run the Android emulator in an accelerated perfomance mode,

Linux-based systems support virtual machine acceleration through the KM (Kernel-mode Virtual Machine)
software package.

Search for install instructions for your particular Linux configuration (Android KvM Linux Installation), and verify
that KvM is enabled for faster Android emulator performance.

Previous | ‘ Cance| ] ‘ Finish |
Figure 9: Android Studio Setup Wizard, Emulator Info Page

What is explained on this page may not make much sense to you. That is perfectly
normal, and we will get into what this page is trying to say later in the book. Just
click “Next” to advance to the next page where you will need to review the various
licenses and click “Accept” if you wish to continue. At this point, clicking “Finish”
will begin the setup process. This will include downloading a copy of the Android
SDK and installing it into a directory adjacent to where Android Studio itself is
installed.

When that is done, you will be taken to the Android Studio Welcome dialog:
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(> Android Studio

Welcome to Android Studio

Recent Projects Quick Start
=y

=hie Mew Project...

=

E Impart Project...

o

== Open Project

Check out from Version Contraol

,,;:: Configure
[F? Docs and How-Tos

Android Studio 0.8.0 Buld 1351245622, Check for updates now.

Figure 10: Android Studio Welcome Dialog

In very tiny print at the bottom of that dialog is a “Check for updates now” link.
Click that, and if there are updates available, install them. This will automatically
restart Android Studio. Android Studio should have downloaded the latest updates
as part of the initial setup, so most likely this will indicate that nothing more is
needed.

Then, in the welcome dialog, click Configure, to bring up a configuration sub-menu:
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© S Android Studio

Welcome to Android Studio

Recent Projects & Canfigure

SDK Manager

Settings

R e C

Flugins

EK{ Import Settings
E‘Q Export Settings
Create Desktop Entry

o)
om Project Defaults
By e

Android Studio 0.8.2 Build 1351267975, Check for updates now.

Figure 11: Android Studio Welcome Dialog, Configure Sub-Menu
There, tap on SDK Manager to bring up the SDK Manager.

Eclipse SDK Manager Launch

Eclipse may take a few extra moments on its first launch to get going, but it does not
do anything especially unusual.

Then, choose Windows > Android SDK Manager from the main menu, or tap on the

toolbar icon that looks like the Android “bugdroid” mascot peeking out of the top of
a box with a downward-pointing white arrow.

Using SDK Manager and Updating Your Environment

You should now have the SDK Manager window open:
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= & Android SDK Manager

SDK Path:
Packages |
I Name APl | Rev. Status ll
v | Tools I
& +" Android SDK Tools 23 | Update available: rev. 23.0.2
+ Android SDK Platform-tools 20 % Installed
#* Android SDK Build-tools 20 if Installed
“ Android 5DK Build-tools 19.1 i Not installed
Android 5DK Build-tools 19.0.3{| Not installed
' Android SDK Build-tools 19.0.2i Not installed
Android SDK Build-tools 19.0.1: Notinstalled
* Android SDK Build-tools 19 Not installed
Android SDK Build-tools 18.1.1:[| Not installed
Android SDK Build-tools 18.1 Not installed
Andenid cny Buoild Fanle 100 1171 Mnk inckallad 1
Show: [& Updates/New [ Installed [ | Obsolete Select New or Updates | Install 9 packages...
Sortby: @ APIlevel ! Repository Deselect All Delete 1 package...

M
Done loading packages. © i

Figure 12: Android SDK Manager

At this point, while you have some of the build tools, you may lack the Java files
necessary to compile an Android application. You also lack a few additional build
tools, plus the files necessary to run an Android emulator. The checkboxes indicate
which packages you want to install — by default, it pre-checks a number of them. If
you chose the “ADT Bundle”, some things will already be pre-installed for you.

You will want to install the following items, if they have not already been installed:

1. Android SDK Tools, Platform-tools, and the latest Build-tools.

2. “SDK Platform” for all Android SDK releases you want to code against — for
this version of this book API 19 (Android 4.4) is recommended, along with
any others with which you wish to experiment.

3. “ARM EABI v7a System Image’, if there is an option for that for the API level
you chose. You can also download the “Intel x86 Atom System Image”, if one
is available to you, as it is much faster, though setting that up is a bit of an
advanced topic. You are also welcome to download similar images for any
other Android API level that you are interested in testing against. However,
for the purposes of this book, DO NOT choose the Android 4.4 or 4.4W
emulator images, as the Android 4.4 emulator has a bug and the Android
4.4W emulator is only for Android Wear devices.

4. “Documentation for Android SDK” for the latest Android SDK release.
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5. “Samples for SDK” for the Android SDK release you chose in item #2 above,
and perhaps for older releases if you wish.

6. Android Support Library and the Android Support Repository (in the Extras
group at the bottom of the tree).

If you are running Windows, also choose the Google USB Driver (in the Extras group
at the bottom of the tree).

Also, if anything that you presently have installed has updates available, they should
already be pre-checked and will be updated when you install the items that you are
adding.

Then, click the Install button beneath the tree on the right, which brings up a
license confirmation dialog:

@ & Choose Packages to Install

Package Description & License

Packages
¥ Google APIs, Android API 16, revis -Google APIs, Android API 16, revision 3
-Google APIs, Android API 15, revision 2

i Google APIs, Android API 15, revis

License
Terms and Conditions

This is the Android Software Development Kit License

Agreement.

1. Introduction

1 1 Tha Andraid Snfhuwara Neualanment Kik frafarrad Fain 7

Copy to clipboard |

Print Accept License

Cancel

Figure 13: Android SDK Manager Installing Packages

Review and accept the licenses, then click the Install button.

When the download is complete, you can close up the SDK Manager.

In Our Next Episode...

... we will create an Android project that will serve as the basis for all our future
tutorials, plus set up our emulator and device.
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When you work on creating an app for Android, you will do so by working in a
“project”. The project is a directory containing your source code and other files, like
images and UI definitions. Your IDE or other build tools will take what is in your
project and generate an Android app (APK) as output.

The details of how you get started with a project vary based upon what IDE you are
using, so this chapter goes through the various possibilities.

Common Concepts

The various ways we set up Android projects have some common elements.

The “Application Name” is the initial name of your project as seen by the user, in
places like your home screen launcher icon and the list of installed applications.

The “Project Name” is the name of the project as it is represented inside of the IDE.
As you type in an application name, the project name will automatically be filled in
to match the application name, with whitespace and other invalid characters
removed. Of course, you can change this as you see fit. In the case of Android
Studio, the project name also forms the name of the directory that will hold the
project.

The “Package Name” refers to a Java package name (e.g.,

com. commonsware.empublite). This package name will be used for generating some
Java source code, and it also is used as a unique identifier of this package, as was
mentioned earlier in this book.

29

Licensed solely for use by Qiwen Chen



ANDROID AND PROJECTS

The “Minimum Required SDK” refers to how far back in Android’s version history
you are willing to support. The lower the value you specify here, the more Android
devices can run your app, but the more work you will have to do to test whether
your app really does support those devices. Nowadays, for new development, a
minimum required SDK of 15 is reasonable, and you can change your chosen value
later on if needed.

The “Target SDK”, roughly speaking, is the version of Android you were thinking of
when you were writing the code for this app. Usually, you will set this to be the
latest shipping Android API level, then change it over time as new versions of
Android are released and you decide that you are ready for some of those changes.
We will be exploring the ramifications of target SDK versions throughout the book.

The “Compile With” (a.k.a., “build SDK” or compileSdkVersion) is the version of
Android whose classes and methods you want to compile against. This can be newer
than the minimum required SDK, and it often is newer. On newer devices running
newer versions of Android, you might want to take advantage of some new features,
and you will “route around” that code on older devices to maintain backwards
compatibility. Hence, typically, your build SDK is set to a fairly new version of
Android, certainly one new enough to support all of the classes and methods from
the Android SDK that you want to use. Note that to set this to API Level 21 or higher,
you will need to be using Java 7 or higher for your Java compiler.

The “Theme” is a general statement of the look and feel of your app, particularly in
terms of color scheme. The current default (“Holo Light with Dark Action Bar”)
means that the body of your UI will be dark text on a light background, except for
the “action bar” across the top, which will be light text on a dark background. You
will be able to create your own custom themes, overriding various characteristics
from one of these stock themes, to set up your own color scheme and the like. We
will explore that process later in the book.

Projects and Android Studio

You may have chosen to use Android Studio as your IDE.

With Android Studio, to work on a project, you can either create a new project from
scratch, you can copy an existing Android Studio project to a new one, or you can
import an existing Android project into Android Studio. The following sections will
review the steps needed for each of these.
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Creating a New Project
You can create a project from one of two places:
+ Ifyou are at the initial dialog that you first encountered when you opened
Android Studio, choose the “Create Project...” menu item
+ Ifyou are inside the Android Studio IDE itself, choose File > Create Project...

from the main menu

This brings up the new-project wizard:

Create New Project

New Project
Android Studio

Configure your new project

Application name: | [T [E1ll5] ]

Company Domain: | mmurphy.example.com ‘

Package name: com.example. mmurphy.myapplication Edit

Project location: JSmp/MyApplication |B

| Previous ‘ m Cancel Finish ‘

Figure 14: Android Studio Create-Project Wizard, First Page

The first page of the wizard is where you can specify:
+ The application name
* The package name

+ The directory where you want the project files to go

By default, the package name will be made up of two pieces:
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1. The domain name that you specify in the “Company Domain” field
2. The application name, converted into all lowercase with no spaces or other
punctuation

If this is not what you want, click the tiny “Edit” link on the far right side of the
proposed package name, which will now allow you to edit the package name

directly:

Create New Project

New Project

Android Studio

Configure your new project

Application name: | My Application ‘

Lompany Domain: | commonsware, com ‘

Package name: [com.commonsware.andmld.myapphcat\on !Done

Project location: ftmp/Myapplication |D

Figure 15: Android Studio Create-Project Wizard, First Page, with Editable Package
Name

Clicking “Next” will advance you to a wizard page where you indicate what sort of
project you are creating, in terms of intended device type (phones/tablets, TVs, etc.)
and minimum required SDK level:
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Create New Project

New Project

Android Studio

Select the form factors your app will run on

Different platforms require separate SDKs

] Phone and Tablet

Minimum SDK API 15: Android 4.0.3 {lceCreamSandwich) n

Lower APl levels target more devices, but have fewer features available. By targeting AP115
and later, your app will run on approximately 84.3% of the devices that are active on the
Google Play Store, Help me choose,

O
Minimum SDK [ |
] wear

Minimum SDK

[ Glass (Mot Installed)

Minimum SDK | |

Figure 16: Android Studio Create-Project Wizard, Second Page

Developers just starting out on Android should only check “Phone and Tablet” as
the device type.

Clicking “Next” advances you to the third page of the wizard, where you can choose
if Android Studio should create an initial activity for you, and if so, based on what

template:
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Create New Project

Add an activity to Mabile

e
it et f
| : /
| I f

Add No Activity I i
! l
| SR, -

Fullscreen Activity Google Maps Activity

A il Annn

-

-4 -

=

Figure 17: Android Studio Create-Project Wizard, Third Page

“Blank Activity” is a good choice for first-time Android developers.

If you choose any option other than “Add No Activity”, clicking “Next” will advance

you to a page in the wizard where you can provide additional details about the
activity to be created:
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> Create New Project

Choose options for your new file

Creates a new blank activity with an action bar.

(Il ~onn
Activity Name! | MaimActivit__y |
Layout Name: |activity7main ‘
Title: | MainActivity ‘

Menu Resource Name:! |merwu_mair1 ‘

Blank Activity

The name of the activity class to create

| Previous | | Nex ‘ | cancel |
Figure 18: Android Studio Create-Project Wizard, Fourth Page

What options appear here will vary based upon the template you chose in the
previous page. Common options include “Activity Name” (the name of the Java class
for your activity), “Layout Name” (the base name of an XML file that will contain a
UI definition of your activity), and “Title” (the caption that should appear at the top
of your activity).

Clicking “Finish” will generate your project files.
Copying a Project
Android Studio projects are simply directories of files, with no special metadata held

elsewhere (as is the case with Eclipse). Hence, to copy a project, just copy its
directory.

Importing a Project
You can import a project from one of two places:

+ Ifyou are at the initial dialog that you first encountered when you opened
Android Studio, choose the “Import Project..” menu item
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+ Ifyou are inside the Android Studio IDE itself, choose File > Import Project...
from the main menu

Then, choose the directory containing the project to be imported.

What happens now depends upon the nature of the project. If the project was
already set up for use with Android Studio, or at least with Gradle for Android, the
Android Studio-specific files will be created (or updated) in the project directory.

However, if the project was not set up for Android Studio or Gradle for Android, but
does have Eclipse project files (or at least a project.properties file), you will be led
through an Eclipse import wizard.

The first page of that wizard is where you specify where Android Studio should
make a copy of the project, so it does not modify anything with the original

directory:

< X

Import Project from ADT (Eclipse Android)

Imparting a project creates a full copy of the project and does not alter the
original Eclipse project.

Import Destination Directory:

| /tmp/imagetiew2 ] [=

Figure 19: Android Studio Eclipse Import Wizard, First Page

Clicking “Next” will bring up a page where you can configure some automatic fixes
that the import wizard will apply to the imported project code. The details of what is
going on here are well past what we have covered so far in the book. Normally, the
defaults are fine.
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Import Project from ADT (Eclipse Android)

The ADT project imparter can identify some .jar files and even whole source

copies of libraries, and replace them with Gradle dependencies. However, it

cannot figure out which exact version of the library to use, so it will use the

latest. If your project needs to be adjusted to compile with the latest library,
you can either import the project again and disable the following options, or
better yet, update your project.

) Replace jars with dependencies, when possible

] Replace library sources with dependencies, when possible

Other Import Options:

[V cCreate Gradle-style (camelCase) module names

i Erevious | | cancal | | Help |

Figure 20: Android Studio Eclipse Import Wizard, Second Page

Clicking “Finish” will perform the project conversion. Android Studio will open up
an import-summary.txt file outlining some details of how the conversion was
accomplished. At this point, the copied-and-modified project is ready for use.

Projects and Eclipse

You may have chosen to use Eclipse with the ADT plugin as your IDE, whether based
on the downloadable ADT Bundle or by adding the ADT plugin and Android SDK to
an existing copy of Eclipse.

As with Android Studio, to work on a project in Eclipse, you can either create a new
project from scratch, you can copy an existing Eclipse project to a new one, or you
can import an existing Android project into Eclipse. The following sections will
review the steps needed for each of these.

Creating a New Project

From the Eclipse main menu, choose File > New > Project... to bring up the first page
of the “New Project” wizard:
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e New Project
Select a wizard >

Create an Android Application Project [

Wizards:

[ @
2% Java Project
# Java Project from Existing Ant BuildFile
%2 Plug-in Project
» (= General
¥ (= Android
{& Android Application Project
& Android Project from Existing Code
& Android Sample Project
Ji Android Test Project
> = CfC++

®

| Next> | cancel

Figure 21: Eclipse New Project Wizard

Choose “Android Application Project” from the types of projects and click “Next >”
to proceed to the next page of the wizard:
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New Android Application

New Android Application

@ Enter an application name (shown in launcher)

Application Name:O[

Project Name:@

Package Name:@

Minimum Required SDK:2| API 8: Android 2.2 (Froyo) 2
Target SDK:®| API 19: Android 4.4 (KitKat) =
Compile with:2| API 19: Android 4.4 (KitKat) 2

Theme:2| Holo Light with Dark Action Bar =

« The application name is shown in the Play Store, as well as in the Manage Application
list in Settings.

@ < Back Mext Cancel

Figure 22: Eclipse New Android Application Project Wizard, As Initially Launched

The elements on this wizard page are described in the “Common Elements” section
that opened this chapter.

Once those are filled in, you can click “Next >” to move to the next page of the
wizard:
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@ & New Android Application
New Android Application y 9
Configure Project ,

[& Create custom launcher icon

[& Create activity
] Mark this project as a library

[& Create Project in Workspace

Working sets
¥4 Add project to working sets

Working sets: | Omnibus 2 Select...

':"T’i' < Back I 11— Cancel

Figure 23: Eclipse Wizard, Other Project Settings, As Initially Launched

The “Create custom launcher icon” checkbox is asking you if you want to customize
your app’s icon right now or not. You can always do this later, so for your first few
projects, it is simplest if you uncheck this option. We will explore how to customize
your app’s icon later in this book. If you leave this unchecked, the new-project
wizard will give you a stock icon at the outset.

The “Create activity” checkbox indicates if you want the new-project wizard to also
create your first “activity” for you — in other words, creating the first screen of your
UI. You do not have to have the new-project wizard create this for you, as you can
add activities later on yourself, whether through a separate new-activity wizard or by
just creating the appropriate files yourself. Hence, whether you leave this checked or
not is up to you.

The “Mark this project as a library” checkbox indicates whether you are building an
app or a library to be used by other apps. Most times, you will be creating an app,
and so you will leave this checkbox unchecked. We will see what Android library
projects are and what they mean later in the book.

The remaining options on this wizard page are for Eclipse:
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+ Choose where you want the project files to be placed, either by leaving
“Create Project in Workspace” checked, or unchecking it and choosing a
directory on your development machine in which to place the files

+ If you are using Eclipse’s working sets, choose your working set (if you do not
know what working sets are in Eclipse, you are not using them, and so you
can safely ignore this option)

Once you have filled in this page of the wizard, there are three possible next steps:

1. Ifyou left the “Create custom launcher icon” item checked, clicking “Next >”
will take you to a wizard page, from the new-icon-set wizard, for creating
your launcher icon. We will explore that wizard later in this book.

2. Ifyou unchecked both the “Create custom launcher icon” and the “Create
activity” checkboxes, the “Finish” button will be enabled, and clicking it will
create your project.

3. Ifyou left the “Create activity” checkbox checked, the “Next >” button will

take you to a wizard page, from the new-activity wizard, for creating your
first activity:

New Android Application

Create Activity f X
Select whether to create an activity, and if so, what kind of activity.

& Create Activity

Blank Activity

Blank Activity with Fragment

Empty Activity

Fullscreen Activity

Master/Detail Flow o
Navigation Drawer Activity

Really Blank Activity

Tabbed Activity

Blank Activity
Creates a new blank activity with an action bar.

o

2) <Back | MNext> | Cancel

Figure 24: Eclipse New Android Project Wizard, Create Activity Page
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Here, you choose which template activity you want to use as a starting point. The
exact roster of templates will vary based upon what is shipping with Android and
what third-party templates you may have installed. “Empty Activity” generates the
least code for you; everything else adds more stuff that you can use (if you want) or
rip out (if you did not want it).

Clicking “Next >” will bring up a wizard page where you can fill in details to be used
by your chosen activity template:

@ @ New Android Application

Empty Activity ,
Creates a new empty activity

Activity Name®|MainActivity |

Layout Name® activity_main

w The name of the activity class to create

'C?\' <Back Cancel | Finish |

Figure 25: Eclipse New Android Project Wizard, New Empty Activity Page

At minimum, the wizard page should ask you for an “Activity Name” (the name of
the Java class for your activity) and the “Layout Name” (the base name of an XML
file that will contain a UI definition of your activity). Other fields, drop-down lists,
and so forth may be available depending upon the particular template that you
chose.

Once you click the “Finish” button on the wizard, the wizard will generate your
project for you and take you to it in Eclipse’s Package Explorer.
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Copying a Project

If you already have a project in Eclipse that you just want to copy and use as a
starting point for a new project, just right-click over the project in the Eclipse
Package Explorer and choose “Copy” from the context menu. Or, use your platform’s
standard hot-key for the copy operation (e.g., <Ctrl>-<C> on Windows and Linux).

Then, you can paste in the project to the Package Explorer, either through Edit >
Paste in the Eclipse main menu or through a hot-key (e.g., <Ctr1>-<v> on Windows
and Linux). This will bring up a “Copy Project” Eclipse dialog:

@ & Ccopy Project

Project name: |.Copy of ActionModeManual |

& Use default location

/?\' Cancel | 0K |

Figure 26: Eclipse Copy Project Dialog

Here, you can choose the name of the project copy and where to copy its files to on
your development machine. After clicking OK, Eclipse will copy the project.

Importing a Project
It may be that you have some source code to an Android project, such as from a

public open source project, that you want to load into Eclipse. Eclipse has a means
of importing such projects, and we will see how to do that in the next tutorial.

Starter Project Generators

In addition to creating projects through an IDE’s new-project wizard, there are
various Web sites that offer online project generators:

* Android Bootstrap
» Android Kickstartr

On those sites, you provide basic configuration data, such as your application’s
package name, and they generate a complete starter project for you. These projects
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tend to be significantly more advanced than what you get from the IDE wizards. On
the plus side, you get a more elaborate “scaffold” on which you can “hang” your own
business logic. However, understanding what those generators create and how to
change the generated code requires a fair bit of Android development experience.
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Creating an Android application first involves creating an Android “project”. As with
many other development environments, the project is where your source code and
other assets (e.g., icons) reside. And, the project contains the instructions for your
tools for how to convert that source code and other assets into an Android APK file
for use with an emulator or device, where the APK is Android’s executable file
format.

Hence, in this tutorial, we kick off development of a sample Android application, to
give you the opportunity to put some of what you are learning in this book in
practice.

About Our Tutorial Project

The application we will be building in these tutorials is called EmPubLite. EmPubLite
will be a digital book reader, allowing users to read a digital book like the one that
you are reading right now.

EmPubLite will be a partial implementation of the EmPub reader used for the APK
version of this book. EmPub itself is a fairly extensive application, so EmPubLite will
have only a subset of its features. The main EmPub app, however, will be used
elsewhere in this book to illustrate more advanced Android capabilities.

The “Em” of EmPub and EmPubLite stands for “embedded”. These readers are not
designed to read an arbitrary EPUB or MOBI formatted book that you might
download from somewhere. Rather, the contents of the book (largely an unpacked
EPUB file) will be “baked into” the reader APK itself, so by distributing the APK, you
are distributing the book.
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About the Rest of the Tutorials

Of course, you may have little interest in writing a digital book reader app.

The tutorials presented in this book are certainly optional. There is no expectation
that you have to write any code in order to get value from the book. These tutorials
are here simply as a way to help those of you who “learn by doing” have an
opportunity to do just that.

Hence, there are any number of ways that you can use these tutorials:

* You can ignore them entirely. That is not the best answer, but you are
welcome to do it.

* You can read the tutorials but not actually do any of the work. This is the
best low-effort answer, as it is likely that you will learn things from the
tutorials that you might have missed by simply reading the non-tutorial
chapters.

* You can follow along the steps and actually build the EmPubLite app.

* You can download the answers from the book’s GitHub repository. There,
you will find one directory per tutorial, showing the results of having done
the steps in that tutorial. For example, you will find a T2-Project/ directory
containing a copy of the EmPubLite sample app after having completed the
steps found in this tutorial. There are separate directories for Android Studio
(EmPubLite-AndroidStudio/) and Eclipse (EmPubLite/) editions of the
projects. You can import these projects into your IDE, examine what they
contain, cross-reference them back to the tutorials themselves, and run
them.

Any of these are valid options — you will need to choose for yourself what you wish
to do.

About Our Tools

The instructions in the remaining tutorials should be accurate for:

* Android Studio 1.0
* Version 23.0.x of the Eclipse ADT plugin

The instructions may work for other versions of these IDEs, but there may also be
some differences.
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Step #1: Creating the Project

We need to create the Android project for EmPubLite.

First, visit the book’s GitHub repository’s “releases” area and download the ZIP file
that corresponds with this version of the book and the tools that you wish to use:

+ For Android Studio, download EmPubLiteStarter-AndroidStudio.zip
+ For Eclipse, download EmPubLiteStarter-Eclipse.zip

Then, unZIP that ZIP archive into some directory on your development machine
outside of where your IDE resides. The ZIP archive will expand into a set of files and
subdirectories. Most likely, you will want to place those into an empty existing
directory. Eclipse users should NOT unZIP the archive directly into the Eclipse
workspace, as Eclipse gets confused easily.

Many steps in the tutorials have the same basic instructions regardless of IDE or
toolchain that you wish to use. Some steps, though, have tool-specific instructions.

This step has two sets of instructions:

1. Importing the starter project into Android Studio
2. Importing the starter project into Eclipse

Just click on the link to jump to the set of instructions that you wish to follow.

Android Studio Project Import
You can import a project from one of two places:

+ Ifyou are at the initial “welcome” dialog that you first encountered when you
opened Android Studio, choose the “Import Non-Android Studio Project..”
menu item

+ Ifyou are inside the Android Studio IDE itself, choose File > Import Project...
from the main menu

Then, just choose the EmPubLite/ directory inside where you unzipped
EmPubLiteStarter-AndroidStudio.zip.

Since this project is already set up for use with Android Studio, you should be taken
right into the main IDE.
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Android Studio has two ways of viewing the contents of Android projects. The
default one, that you are presented with when importing the project, is known as
the “Android project view”

EmPublLite
' Android - [« BEE - 28 |
= EmPubLite (- /F |

# Gradle Scripts
# build.gradle (EmF
Jl gradle.properties
2 settings.gradle (Project S

g 1 Project |

il gradle-wrapper.properties
ill local. properties

< 7: Structure

Figure 27: Android Studio “Android Project View”

While you are welcome to navigate your project using it, the tutorial chapters in this
book, where they have screenshots of Android Studio, will show the classic project
view:

EmPublite

[ Project &l [ - O

v [2 EmPublLite (~/EmPublLite)

] .idea

app

I gradle
 build.gradle
II EmPublLite.iml
[ gradle.properties
[ local.properties
2 settings.gradle

1: Project |

=] 7: Structure

il External Libraries

Figure 28: Android Studio “Classic Project View”

To switch to this classic view — and therefore match what the tutorials will show
you — click on the drop-down list that currently shows “Android” as selected and
choose “Project” instead.

Eclipse Project Import

In Eclipse, choose File > Import from the main menu, to bring up the import wizard:
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Select G

=]
select animport source:
[ |
IZ; Archive File -
1 Existing Projects into Workspace
[, File System
E. Preferences
¥ (= Android
{& Existing Android Code Into Workspace
> = CVS
> & Install
# = Plug-in Development
* (= Run/Debug
> = Team -

@ Back | Next> Cancel
Figure 29: Eclipse Import Wizard, First Page

Choose “Existing Android Code Into Workspace” and click the Next button to bring
up the next page of the wizard:
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Import Projects

@ select a directory to search for existing Android projects

Root Directory:

Browse...

Projects:

Project to Import New Project Name Select All

Deselect All
Refresh

"] Copy projects into workspace
Working sets

& Add project to working sets

Working sets: | CWAC = Select...

&)

| <Back | : Cancel

Figure 30: Eclipse Import Wizard, Second Page

Click the “Browse..” button towards the upper-right of the wizard, and from there
choose the directory containing the unZIPped version of
EmPubLiteStarter-Eclipse.zip.

This will change the wizard to show the project. Click on “EmPubLiteActivity” in the

table, which will then become editable. Change EmPubLiteActivity to be
EmPubLite:
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Import Projects

Select a directory to search For existing Android projects

Root Directory: | /tmp/BP Browse...
Projects:

Project to Import New Project Name Select All

Deselect All
Refresh

"] Copy projects into workspace

Working sets

& Add project to working sets

Working sets: | Scrap 2 Select...

@ <Back Next Cancel \ Finish

Figure 31: Eclipse Import Wizard, Second Page, After Directory Selected

If you want to have the contents of your chosen directory copied into your Eclipse
workspace, click the “Copy projects into workspace” checkbox. Otherwise, Eclipse
will keep the project files where they are.

If you are using Eclipse’s working sets, choose your working set (if you do not know
what working sets are in Eclipse, you are not using them, and so you can safely
ignore this option).

Then, click Finish. Afterwards, you should be able to find EmPubLite in the Eclipse
Package Explorer:
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¥ 2 EmPubLite
¥ @src
¥ & com.commonsware.android.blank
> ] MainActivity.java
*» 2 gen [Generated Java Files]
b =4 Android 4.4.2
Z= assets
» & bin
2 libs
v o res
> = drawable-hdpi
= drawable-ldpi
» (= drawable-mdpi
* = drawable-xhdpi
> = layout
= menu
» = values
|al AndroidManifest.xml
B proguard-project.bxt
[E project.properties

Figure 32: Eclipse Package Explorer, Showing EmPubLite from Import

You may encounter some problems, if the imported project is set to build with an
Android SDK that you have not installed. To check your settings for this, right-click
over the EmPublLite entry in the Package Explorer, and choose Properties. In the
Properties dialog, click the Android entry in the list on the left:
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© @ Properties for EmPubLite

| Android & x =
» Resource e
. Project Build Target
ST EE— Target Name Vendor Platform  APILeve
Builders Android 1.5 Android Open Source Project 15 3
Java Build Path Android 1.6 Android Open Source Project 16 4
> Java CodeSStyle Google APIs Googlenc. 16 4
> Java Compiler Android 2.1 Android Open Source Project 21 7
> Java Editor Google APIs Googlelnc. 21 7
Javadoc Location Android 2.2 Android Open Source Project 22 8
Project References Google APIs Googlelnc. 22 8
Refactoring History Android 2.3.3 Android Open Source Project 233 10
Run/Debug Settings Google APIs GoogleInc. 233 10
Task Tags Android 3.0 Android Open Source Project 30 1
XML Syntax Android 3.1 Android Open Source Project 34 12
Android 4.0 Android Open Source Project a0 1
Google APIs GoogleInc. a0 14
Android 4.0.3 Android Open Source Project 403 15
Android 4.1.2 Android Open Source Project 412 16
SonyAdd-onSDK2.1  Sony a12 16
Android 4.2.2 Android Open Source Project 422 17
Google APIs GoogleInc. 422 17
Android 4.3 Android Open Source Project a3 18
Google APIs GoogleInc. a3 18
@ Android 4.4.2 Android Open Source Project 442 19
Google APIs GoogleInc. 442 19
Library
Is Library
Reference Project T
Restore Defaults Apply
@

cancel | (G

Figure 33: Eclipse Project Properties

If none of the entries in the API level checklist are checked, check the highest one
that you have installed, if that is 15 or higher.

Step #2 - Set Up the Emulator

The Android tools include an emulator, a piece of software that pretends to be an
Android device. This is very useful for development — not only does it mean you
can get started on Android without a device, but the emulator can help test device
configurations that you do not own.

Your first decision to make is whether or not you want to bother setting up an
emulator image right now. If you have an Android device, you may prefer to start
testing your app on it, and come back to set up the emulator at a later point.

Your second decision to make is whether you want to go ahead and set up the x86

emulator support. The vast majority of Android devices have ARM CPUs, while the
vast majority of development machines have x86 CPUs. The ARM emulator is slow
on x86 machines, as every ARM instruction must be translated into corresponding
x86 instruction(s) before it can be executed. However, setting up the x86 emulator
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support is a bit complicated, and your development machine may not be able to
support it. If you wish to try to set up the x86 emulator right away, there are
instructions for doing that later in the book that you can review and follow.

The Android emulator can emulate one or several Android devices. Each
configuration you want is stored in an “Android virtual device”, or AVD. The AVD

Manager is where you create these AVDs.

Android Studio now has its own implementation of the AVD Manager that is
separate from the one Android developers have traditionally used.

AVD Manager in Android Studio
To open the AVD Manager in Android Studio, choose Tools > Android > AVD
Manager from the main menu. You should see a table of available virtual devices

(AVDs), possibly including one already set up for you:

AVD Manager

, g Tour Virtual Devices

M Andreid Studio

| LType | MName | Resolution s 3 Target | CPUABI | Size on Disk | Actions

E MNexus 5 AP 21 86 1080 x 1920: wxhdpi 21 Google APIs =86 750 MB | A

-+ Create Virtual Device... J @
m Cancel

Figure 34: Android Studio AVD Manager, First Page

To define a new AVD, click the “Create Virtual Device” button in the AVD Manager,
which brings up a “Virtual Device Configuration” wizard:
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Virtual Device Configuration

Select Hardware

Choose a device definition

& )
Category | | Names | Size | Resolution |  Density |
ﬁ 27" QVGA i 240x320 ldpi
Tablet 27"QvGAsl. | 27" 240x320 ldpi
Wear 32"HVGAsl. | 32" 320x480 mdpi )
Mo Device Selected
TV 32" QVGA(A. | 32" 320%480 mdpi
33" WQVGCA 33" 240x400 Idpi
34" WOQVGA 34" 240x432 ldpi
37" FWVGA . 37" 480x854 hdpi
27" AN = FiksTatvi=Talal =
New Hardware Profile (%] | Create Device..
| Previols | I Next I l Cancel ] | Fimish }

Figure 35: Android Studio Virtual Device Configuration Wizard, First Page

The first page of the wizard allows you to choose a device profile to use as a starting
point for your AVD. The “New Hardware Profile” button allows you to define new
profiles, if there is no existing profile that meets your needs.

Since emulator speeds are tied somewhat to the resolution of their (virtual) screens,
you generally aim for a device profile that is on the low end but is not completely
ridiculous. For example, an 800x480 phone would be considered by many people to
be fairly low-resolution. However, there are plenty of devices out there at that
resolution (or lower), and it makes for a reasonable starting emulator.
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Virtual Device Configuration

Select Hardware

Choose a device definition

@ ) [] Nexus S
Catego | Narme = | Size | Resolution | Densit |
Tablet Nexus One 3.7" 480x800 hdpi ol
Size: normal
" F Ratio:  long
Wear MNexus § 5.96 144042560 560dpi
P Density: hdpi
™ Mexus 5 4.95" 1080x1920 schdpi
4.0 800px
MNexus 4 47" 768x1280 xhdpi
Galaxy Nexus 4.85" 720%1280 xhdpi
5.4" FWVGA 5.4" 480x854 mdpi
31" WAVGA ki 4801800 mdpi
4.7" WXGA 47" 720x1280 xhdpi
Mew Hardware Profile } [ Import Hardware Profiles J (4] Clone Device... J
| Previous Cancel | Finish |

Figure 36: Android Studio Virtual Device Configuration Wizard, First Page, Nexus S
Selected

If you want to create a new device profile based on an existing one — to change a
few parameters but otherwise use what the original profile had - click the “Clone
Device” button once you have selected your starter profile.

However, in general, at the outset, using an existing profile is perfectly fine.

Clicking “Next” allows you to choose an emulator image to use, based on the ones
that you downloaded using the SDK Manager:
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Virtual Device Configuration

System Image

Select a system image

Release Name | APllevel> | ABI | Target [
Lollipop 21 *B86 Google APIs (Google Inc.) - google_
Lollipop Download 21 armeabiv7a | Android SDK Platform 5.0
Lollipop Download 21 x86_64 Android SDK Flatform 5.0
Lollipop Download 21 x86 Android SDK Flatfarm 5.0
Lollipop Download 21 armeabiv7a | System Image armeabiw7a with Go
Lollipop Download 21 X86_64 System Image x86_64 with Google
KitKat 19 armeabiv7a  Android 4.4.2 Mo System Image Selected
Kitkat Download 19 x86 Android SDK Platform 4.4.2
Jelly Bean Download 18 armeabiv7a | Android SDK Piatform 4.3
Jelly Bean Download 18 x86 Andiroid SDK Flatform 4.3
Jelly Bean Download 17 armeabiv7a Android SDK Piatform 4.2.2
Jelly Bean Download 17 x86 Android SDK Platfarm 4.2
Jelly Bean Download 17 mips Android 4.2.1
lellv Rean NDownload 15 armeahiv7a | Android SDK Platfarm 4.1
¥ show dewnloadahle system images @

I Previous J | Next | [ Cancel ! | Finish

Figure 37: Android Studio Virtual Device Configuration Wizard, Second Page

For the tutorials in this book, you want an API Level 18 or 21 image, and for the
armeabi-v7 CPU architecture (unless you have gone ahead and configured x86
emulator support). You do not need one with the “Google APIs” — those are for
emulators that have Google Play Services in them and related apps like Google
Maps. The ones with “Download” next to them will trigger a one-time download of
the files necessary to create AVDs for that particular API level and CPU architecture
combination.

Clicking “Next” allows you to finalize the configuration of your AVD:
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Virtual Device Configuration

Android Virtual Device (AVD)

Verify Configuration

AVDName  [NexusSAPI21 |

[ NexusS  4.0" 480x800 hdpi Change..

\é" Lellipop  Android 5.0.1 armeabi-u7a

Startup size

and Scale: ‘AUtO n Mothing Selected
orientation

Emulated [ Use Host GPU

Perfarmance

[ Stere a snapshot For Faster startup
You can either use Host GPU or Snapshots

Show Advanced Settings

lE_revious ] | Next } i Cancel l
Figure 38: Android Studio Virtual Device Configuration Wizard, Third Page

A default name for the AVD is suggested, though you are welcome to replace this
with your own value. The rest of the default values should be fine.

Clicking “Finish” will return you to the main AVD Manager, showing your new AVD.
You can click “OK” to return to the main IDE window.

AVD Manager in Eclipse

To open the AVD Manager in Eclipse, choose Window > Android Virtual Device
Manager from the main menu.

The AVD Manager starts up on a screen listing the AVDs you have available -
initially, the list will be empty:

58

Licensed solely for use by Qiwen Chen



TUTORIAL #2 - CREATING A STUB PROJECT

Android Virtual Device (AVD) Manager

|Android Virtual Devices|| Device Definitions

List of existing Android Virtual Devices located at /root/.android/avd

ame | Target Name | Plat _;-' Lev CPU/ABI Create...
- No AVD available - -

Refresh
& A repairable Android Virtual Device. 3 An Android Virtual Device that failed to load. Click 'Deta

Figure 39: AVD Manager, From Fresh Installation
You will notice that there is a “Device Definitions” tab. This provides a catalog of

device hardware configurations that you can use as the starting point for your
emulator:

" Android Virtual Device (AVD) Manager

Android Virtual Devices | |Device Definitions

List of known device definitions. This can later be used to create Android Virtual Devices.
Device “reate AVD
Android TV (1080p) by Google

| Screen: 55.0", 1920 x 1080, X-Large xhdpi
RAM: 2GiB Create Device...

Android TV (1080p) by Google ==
Screen: 55.0", 1920 = 1080, X-Large xhdpi S
RAM: 2GiB

Android TV (1080p) by Google
Screen: 55.0", 1920 = 1080, X-Large xhdpi
RAM: 2GiB

Android TV (720p) by Google
Screen: 55.0", 1280 = 720, X-Large tvdpi
RAM: 2GiB

Android TV (720p) by Google
Screen: 55.0", 1280 = 720, X-Large tvdpi
RAM: 2GiB

g d o d

Refresh

3

| Auser-created device definition. [ | A generic device definition.

Figure 40: AVD Manager, Device Definitions Tab
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For now, though, on the “Android Virtual Devices” tab, click the New... button to

create a new AVD file. This brings up a dialog where you can configure what this
AVD should look and work like:

@ @ Edit Android Virtual Device (AVD)

AVD Name: 4.3-WVGA

Device: Nexus S (4.0", 480 x 800: hdpi)

Targek: Android 4.3 - APl Level 18

CPU/ABI: Intel Atom (x86)

Keyboard: & Hardware keyboard present

Skin: No skin

Front Camera: None

Back Camera: None

Memory Options:  RAM: |343 VM Heap: |32

Internal Storage: 200 MiB

SDcard. @ size: |32 MiB
File:

Emulation Options: Snapshot [ |Use Host GPU

Cancel OK

Figure 41: Adding a New AVD
You need to provide the following:

1. A name for the AVD. Since the name goes into files on your development
machine, you will be limited by filename conventions for your operating
system (e.g., no backslashes on Windows).

2. Which one of the available device templates from the “Device Definitions”
tab you wish to use. Since the emulator runs slower with higher resolution
screens, the Nexus S is a likely candidate, as it offers a not-too-unrealistic
resolution and better emulator speed.

3. The Android version you want the emulator to run (a.k.a., the “target”).
Choose one of the SDKs you installed via the drop-down list. Note that in
addition to “pure” Android environments, you will have options based on the
third-party add-ons you selected. For example, you probably have some
options for setting up AVDs containing the Google APIs, and you will need
such an AVD for testing an application that uses Google Maps.
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10.

The CPU architecture your emulator will emulate. If you went ahead and set
up x86 emulator support, choose your x86 emulator image here. Otherwise,
choose your ARM emulator image.

Whether or not a hardware keyboard is present. Having this checked can
ease your data entry on the emulator, as your development machine’s
keyboard will act as a keyboard for the emulated device.

Whether there should be a portion of the emulator window set aside to
show hardware controls, such as a D-pad. This is usually a good idea,
particularly while you are getting familiar with the Android environment.
Values for the memory and internal storage — the defaults are perfectly fine
selections.

Details about the SD card the emulator should emulate. Since Android
devices invariably have some form of “external storage”, you probably want to
set up an SD card, by supplying a size in the associated field. However, since
a file will be created on your development machine of whatever size you
specify for the card, you probably do not want to create a 2GB emulated SD
card. 32MB is a nice starting point, though you can go larger if needed.
Whether or not “snapshot” mode is enabled. This can speed up restarting
the emulator at the cost of hard disk space. For now, leave it unchecked.
Whether or not you wish to use the development machine’s graphics card
(GPU) to accelerate the emulator’s graphics. Usually, this helps emulator
performance, so checking that is worth trying. If you encounter problems
running the emulator, try editing the AVD definition and unchecking this
value.

Click the OK button, and your AVD stub will be created.

To start the emulator, highlight it in the list and click “Start...”. You can skip the
launch options for now and just click Launch. The first time you launch a new AVD,
it will take a long time to start up. The second and subsequent times you start the
AVD, it will come up a bit faster, and usually you only need to start it up once per
day (e.g., when you start development). You do not need to stop and restart the
emulator every time you want to test your application, in most cases. Also, Eclipse
will automatically start an emulator if you do not have one started and you try
running an application.

The emulator will go through a few startup phases, typically first with a plain-text
“ANDROID” label (for pre-Android 4.0) or a blank screen (for Android 4.0+):
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@ ® 5554:4.2-WVGAS00

Figure 42: Android emulator, initial startup segment

... then a graphical Android logo:
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@ ® 5554:4.2-WVGAS00

Figure 43: Android emulator, secondary startup segment

before eventually landing at the home screen, a welcome page (shown below, for
Android 4.0), or the keyguard:
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5554:4.2-WVGCAS00

Make yourself at home

You can put your favorite apps here.

To see all your apps, touch the circle.

() -

Figure 44: Android 4.0 emulator welcome page

If you get the keyguard (shown below), press the MENU button, or slide the lock on
the screen to the right, to get to the emulator’s home screen:
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@ ® 5554:4.2-WVGAS00

NS

Connect your charger.

ANDROID

Figure 45: Android 4.0 keyguard

Step #3 - Set Up the Device

You do not need an Android device to get started in Android application
development. Having one is a good idea before you try to ship an application (e.g.,
upload it to the Play Store). And, perhaps you already have a device — maybe that is
what is spurring your interest in developing for Android.

If you do not have an Android device that you wish to set up for development, skip
this step.

The first step to make your device ready for use with development is to go into the
Settings application on the device. What happens now depends a bit on your
Android version:

+ On Android 1.x/2.x, go into Applications, then into Development
* On Android 3.0 through 4.1, go into “Developer options” from the main
Settings screen
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* On Android 4.2 and higher, go into About, tap on the build number seven
times, then press BACK, and go into “Developer options” (which was
formerly hidden)

= Developer options

USB debugging

Debug mode when USB is connected

Development device ID
B6CM-4DQT-GQAX-7

SEVEVELE 7
Screen will never sleep while charging

Allow mock locations
Allow mock locations

Desktop backup password
Desktop full backups aren't currently protected.

USER INTERFACE

Strict mode enabled

Flash screen when apps do long
operations on main thread
Pointer location

Screen overlay showing current touch
data

!

Figure 46: Android device development settings

You may need to slide a switch in the upper-right corner of the screen to the “ON”
position to modify the values on this screen.

Generally, you will want to enable USB debugging, so you can use your device with
the Android build tools. You can leave the other settings alone for now if you wish,
though you may find the “Stay awake” option to be handy, as it saves you from
having to unlock your phone all of the time while it is plugged into USB.

Note that on Android 4.2.2 and higher devices, before you can actually use the
setting you just toggled, you will be prompted to allow USB debugging with your
specific development machine via a dialog box:
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The computer's RSA key fingerprint is:
DA:A8:61:07:C6:DE:ED:B9:3A:78:58:28.CB:9C:5F:FC

Always allow from this computer

Figure 47: Allow USB Debugging Dialog

This occurs when you plug in the device via the USB cable and have the driver
appropriately set up. That process varies by the operating system of your
development machine, as is covered in the following sections.

Windows

When you first plug in your Android device, Windows will attempt to find a driver
for it. It is possible that, by virtue of other software you have installed, that the
driver is ready for use. If it finds a driver, you are probably ready to go.

If the driver is not found, here are some options for getting one.

Windows Update

Some versions of Windows (e.g., Vista) will prompt you to search Windows Update
for drivers. This is certainly worth a shot, though not every device will have supplied
its driver to Microsoft.

Standard Android Driver

In your Android SDK installation, if you chose to install the “Google USB Driver”
package from the SDK Manager, you will find an extras/google/usb_driver/
directory, containing a generic Windows driver for Android devices. You can try
pointing the driver wizard at this directory to see if it thinks this driver is suitable
for your device. This will often work for Nexus devices.

Manufacturer-Supplied Driver

If you still do not have a driver, the OEM USB Drivers in the developer
documentation may help you find one for download from your device manufacturer.
Note that you may need the model number for your device, instead of the model
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name used for marketing purposes (e.g., GT-P3113 instead of “Samsung Galaxy Tab 2
7.0”).

OS X and Linux

Odds are decent that simply plugging in your device will “just work”. You can see if
Android recognizes your device via running adb devices in a shell (e.g., OS X
Terminal), where adb is in your platform-tools/ directory of your SDK. If you get
output similar to the following, the build tools detected your device:

List of devices attached
HT9CPP809576 device

If you are running Ubuntu (or perhaps other Linux variants), and this command did
not work, you may need to add some udev rules. For example, here is a
51-android.rules file that will handle the devices from a handful of manufacturers:

SUBSYSTEM=="usb", SYSFS{idVendor}=="0bb4", MODE="0666"

SUBSYSTEM=="usb", SYSFS{idVendor}=="22b8", MODE="0666"

SUBSYSTEM=="usb", SYSFS{idVendor}=="18d1", MODE="0666"

SUBSYSTEMS=="usb", ATTRS{idVendor}=="18d1", ATTRS{idProduct}=="0c01",
MODE="0666", OWNER="[me]"

SUBSYSTEM=="usb", SYSFS{idVendor}=="19d2", SYSFS{idProduct}=="1354", MODE="0666"
SUBSYSTEM=="usb", SYSFS{idVendor}=="04e8", SYSFS{idProduct}=="681c", MODE="0666"

Drop that in your /etc/udev/rules.d directory on Ubuntu, then either reboot the
computer or otherwise reload the udev rules (e.g., sudo service udev reload).
Then, unplug and re-plug in the device and see if it is detected.

The CyanogenMod project maintains a page on their wiki with more on these udev
rules, including rules from a variety of manufacturers and devices.

Step #4: Running the Project

Now, we can confirm that our project is set up properly by running it on a device or
emulator. Once again, there are separate sections of instructions below for Android
Studio versus Eclipse development — please follow the instructions that are
appropriate for you.
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Android Studio

Press the Run toolbar button (usually depicted as a green rightward-pointing
triangle).

You will then be presented with a dialog indicating where you want the app to run:
on some existing device or emulator, or on some newly-launched emulator:

Choose Device

(O choose a running device

(*) Launch emulator
Android virtual device: | 4.3-WVGA | =

[] uUse same device for future launches

()
Figure 48: Android Studio Device Chooser Dialog
If you do not have an emulator running, choose one from the drop-down menu

towards the bottom of the dialog, then click OK. Android Studio will launch your
emulator for you.

And, whether you start a new emulator instance or reuse an existing one, your app
should appear on it.

Eclipse

Press the Run toolbar button (usually depicted as a white “play” triangle in a green
circle). The first time you run the project, you will see a “Run As” dialog, prompting
you to declare how you want to run the app:
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Select a way to run "EmPublLite’:

;-d—*: Al

vid Application
Ji Android JUnit Test
Bl Java Applet

1 Java Application

Ju JuUnit Test

Description
Runs an Android Application

'/;': Cancel _ | OK ]

Figure 49: Eclipse Run As Dialog
Click on “Android Application” and click “OK” to proceed.
At this point, if you have a compatible running emulator or device, the app will be
installed and run on it. If you have more than one, you will be given a dialog where
you can choose what to use. Otherwise, Eclipse will start up a suitable emulator,

from the AVDs you created previously, then will install and run the app on it.

Results

You should see your app on the device or emulator:
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Fil EmPubLite

Hello world!

Figure 50: Android 4.3 Emulator with EmPubLite

Note that you will have to unlock your device or emulator to actually see the app
running — it will not unlock automatically for you.

In Our Next Episode...

... we will modify the AndroidManifest.xml file of our tutorial project.
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Getting Around Android Studio

Eclipse has been around for a very long time and has proven to be a very popular
IDE. As a result, there is quite a bit of material written about it, from books and
blogs to Stack Overflow questions and official project documentation.

Android Studio shares a lot of functionality with its parent, Intelli] IDEA. However,
IDEA itself has not achieved Eclipse’s level of popularity, even though it has long
been the IDE of choice for many “power developers”. And Android Studio’s changes
to IDEA are largely undocumented.

Hence, this chapter will serve as a quick tour of the Android Studio IDE, to help you
get settled in. Other Android-specific capabilities of Android Studio will be explored
in the chapters that follow.

Navigating The Project Explorer

After the main editing area — where you will modify your Java source code, your
resources, and so forth — the piece of Android Studio you will spend the most time
with is the project explorer, usually available on the left side of the IDE window:
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» Android - 0 = |8
=}
© v Ciapp
(o .
St manifests
s java
ires
(7]
5 drawable
=3
z layout
= = activity_main.xml

menu
values
2 Gradle Scripts

Figure 51: Android Studio Project Explorer, Showing Android Project View

This explorer pane has two main “project views” that an Android developer will use:
the Android project view and the classic project view.

Android Project View

By default, when you create or import a project, you will wind up in the Android
project view.

In theory, the Android project view is designed to simplify working with Android
project files. In practice, it may do so, but only for some advanced developers. On
the whole, it makes the IDE significantly more complicated for newcomers to
Android, as it is rather difficult to see where things are and what relates to what.

We will return to the Android project view a bit later in the book and explain its
benefits relative to resources and Gradle’s sourcesets.

However, for most of the book — most importantly, for the tutorials - we will use
the classic project view.

Classic Project View

To switch to the classic project view, click the drop-down just above the tree in the
explorer, and choose Project:
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@ Android -

B Project

B Packages
scopes

* Project Files

* Problems

* Production

* Tests

Figure 52: Android Studio Project Explorer, Showing Project View Drop-Down

This will change the contents of the tree to show you all of the files, in their
associated directories:
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& Project 5 (IR - A
= MyApplication |
idea
1app
build
libs
src
androidTest
main
java
ires
drawable
drawable-hdpi
drawable-mdpi
drawable-xhdpi
E1 drawable-xxhdpi
layout
& ackivity_main.xml
menu

+ 1:Project |

=1 7. Structure

values
values-w820dp
= AndroidManifest.xml
=l .gitignore
I app.iml
# build.gradle
=l proguard-rules pro

2 Favorites

Build Variants

Figure 53: Android Studio Project Explorer, Showing Classic Project View

This project view is much like its equivalent in other IDEs, allowing you to find all of
the pieces of your Android project. We will be exploring what those pieces are, and
how their files are organized in our projects, in the next chapter.

Context Menus in the Explorer

Right-clicking over a directory or file in the explorer will give you a context menu
with a variety of options. Some of these will be typical of any sort of file manager,
such as “cut”, “copy”, and/or “paste” options. Some of these will be organized
according to how Intelli] IDEA manages application development, such as the
“Refactor” sub-menu, where you can rename or move files around. Yet others will be
specific to Android Studio, such as the ability to invoke wizards to create certain

types of Android components or other Java classes.

Running Projects

As noted in Tutorial #2, to run your project, just press the Run toolbar button
(usually depicted as a green rightward-pointing triangle). You will then be presented
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with a dialog indicating where you want the app to run: on some existing device or
emulator, or on some newly-launched emulator:

Choose Device

() choose a running device

(*) Launch emulator
Android virtual device: | 4.3-WWVGA =

[ use same device for future launches

m |_Cancel
Figure 54: Android Studio Device Chooser Dialog

If you do not have an emulator running, choose one from the drop-down menu
towards the bottom of the dialog, then click OK. Android Studio will launch your
emulator for you. Whether you start a new emulator instance, reuse an existing one,
or request that your app run on an attached Android device, your app should appear
on 1it.

Viewing Output

Beyond your app itself, Android Studio will generate other sorts of diagnostic
output, in the form of “console”-style transcripts of things that have occurred. The
two of these that probably will matter most for you are the Gradle console and
Log(at.

Gradle Console

By default, docked in the lower-right corner of your Android Studio window is a
“Gradle Console” item. Tapping on that will open up a pane showing the output of
attempts to build your application:
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Gradle Consale

rapp:complleDebughidl UP-TO-DATE
;app:compileDebugRenderscript UP-TO-DATE
rapp:generateDebugBuildConfig UP-TO-DATE
rapp:generateDebughssets UP-TO-DATE
rapp:mergeDebugAssets UP-TO-DATE
rapp:generateDebugResValues UP-TO-DATE
app:generateDebugResources UP-TO-DATE
rapp:mergeDebugResources UP-TO-DATE
rapp:processDebugManifest UP-TO-DATE
;app:processDebugResources UP-TO-DATE
rapp:generateDebugSources UP-TO-DATE

I
e

BUILD SUCCESSFUL

ETotal time: 2.12 secs

Figure 55: Android Studio Gradle Console

This may automatically appear from time to time, if specific build problems are
detected, and you can always go examine it whenever you need.

Click on the “Gradle Console” item again to collapse the view and get it out of your
way.

LogCat

Messages that appear at runtime — including the all-important Java stack traces
triggered by bugs in your code — are visible in LogCat. The “Android” item docked
towards the lower-left corner of your Android Studio window will display LogCat

when tapped:

Android DDMS - L
Devices | logcat | ADB logs =*| &4 Log level: |Verbose @ ) [NoFiers
1§ Devices | & logeat +
% 8 Emutator 43w | 08-22 11:31:21.540 1132-1152/systen_process V/TAG bug 7643792: fitSystemWindows([0,38][0,0]) - o
e 08-22 11:31:22.440  1132-1279/systen_process D/Tethering. MasterInitialState.processMessage what=3
T 08-22 11:31:22.440  1132-1279/systen_process D/Tethering. MasterInitialState.processhessage what=3
android.process.mec 1575-1792/con . android. calendar D/AlertService Beginning updateAlertMotification PN
com.android.calend: 1575-1792/con . android. calendar D/AlertService. Mo fired or scheduled alerts
comandrgid-deskad 1575-1792/con . android. calendar D/AlertService. Scheduling next alarm with AlarmScheduler. sEventReminderReceived: null +
; s 1575-1792/con. android. calendar D/AlarnScheduler: No events found starting within 1 week, i
com.android. dialer ( 1575-1602/con. android. calendar D/InitAlarmsService: Clearing and rescheduling alarms. &)
com.android.email (1 08-22 11:31:50,850 1132-1199/systen_process D/dalvikwm. GC_FOR_ALLOC freed 1105K, 40% free S979K/9932K, paused 15ms, total loms =
{1}

com.android.exchan 08-22 11:32:13.691 1132-1146/systen_process I/audioService. AudioFocus abandonAudioFocus() from android.media. AudioManagereb3lccedOcom.android. music, Mediap”

i pdeni ot o)

Figure 56: Android Studio LogCat View

LogCat is explained in greater detail a bit later in this book.

Accessing Android Tools

Not everything related to Android is directly part of Android Studio itself. In some
cases, tools need to be shared between users of Android Studio, users of Eclipse, and
users of “none of the above”. In some cases, while the long term direction may be to
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incorporate the tools’ functionality directly into Android Studio, that work simply
has not been completed to date.

Here are some noteworthy Android-related tools that you can access via the Tools >
Android main menu option.

SDK and AVD Managers

As we saw in Tutorial #1, the SDK Manager is Android’s tool for downloading pieces
of the Android SDK, including:

+ “SDK Platform” editions, allowing us to compile against a particular API level
+ ARM and (sometimes) x86 emulator images

* Documentation

+ Updates to the core build tools

 Etc.

You can launch the SDK Manager via Tools > Android > SDK Manager from the
Android Studio main menu, or by clicking on the “droid in a box” toolbar button:

4+

Figure 57: Android Studio SDK Manager Toolbar Icon

The AVD Manager is the tool for creating emulators that emulate certain Android
environments, based upon API level, screen size, and other characteristics.

You can launch the AVD Manager via Tools > Android > AVD Manager from the
Android Studio main menu, or by clicking the “droid and a screen” toolbar button:
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Figure 58: Android Studio AVD Manager Toolbar Icon

Android Device Monitor

Elsewhere in this book, you will see references to tools associated with the Dalvik
Device Monitor Service (DDMS), such as using it to help inspect your running apps
for memory or threading issues. You will also see references to tools like Hierarchy
View, for trying to make sense of your Ul as it appears at runtime, after you have
programmatically made lots of changes to it.

In Eclipse, DDMS and Hierarchy View are “perspectives”, added to Eclipse via the
ADT plugin.

For everyone not using Eclipse — including Android Studio users — DDMS and
Hierarchy View are available via the Android Device Monitor standalone tool.
Android Studio users can launch the Monitor via Tools > Android > Android Device
Monitor from the main menu.

This will first bring up a splash screen:

80

Licensed solely for use by Qiwen Chen



GETTING AROUND ANDROID STUDIO

Android Device Monitor

Figure 59: Android Device Monitor Splash Screen
followed by the Monitor itself:

Android Device Monitor

Q ‘ﬁ |@®ooms| & B Qo
B Devices = = O ||% Threads| ® Heap| @ Allocat... |® Metwo... |if: File Ex... 52 |@ Emulat... = Syste... =]
b Name Size Date
Name
& Logcat B Console BBl =® B3> = O
OpenGL Trace View
[ | o

Figure 60: Android Device Monitor, As Initially Opened

If you read about things available from DDMS or Hierarchy View online, such as in
blog posts or Stack Overflow answers, most of those capabilities should be available
to you via the Android Device Monitor.
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Android Studio and Release Channels

When you install Android Studio for the first time, your installation will be set up to
get updates on the “stable” release channel. Here, a “release channel” is a specific set
of possible upgrades. The “stable” release channel means that you are getting full
production-ready updates. Android Studio will check for updates when launched,
and you can manually check for updates via Help > Check for Update... in the main
menu.

If an update is available, you will be presented with a dialog box showing you details
of the update:

Anew Android Studio 1.0.1 is available in the stable chanmel.

Current version: 1.0.0 (build 135.1629389)
New version: 1.0.1 (build 135.1641136)
Patch size: 3 MB

To configure automatic update settings, see the Updates dialog of your IDE Settings.

Update and Restart | | Release MNotes | | lgnore This Update | Remind Me Later

Figure 61: Android Studio Update Dialog

Choosing “Release Notes” will bring up a Web page with release notes for the new
release. Clicking “Update and Restart” does pretty much what the button name
suggests: it downloads the update and restarts the IDE, applying the update along
the way.

Clicking the “Updates” hyperlink in the dialog brings up yet another dialog, allowing
you to choose which release channel you want to subscribe to:
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Updates

Android Studio can automatically check For new and updated versions of itself, using your internet connection (when
active).

™ Check For updates in channel |StéBLe Channel m | “heck Nc |

Current Android Studio version: Android Studio 1.0 Bulld number: Al-135.1629389

Last checked For updates: Moments ago
| Cancel | | | | Help |

Figure 62: Android Studio Update Release Channel Dialog

You have four channels to choose from:

+ Stable, which is appropriate for most developers

* Beta, which will get updates that are slightly ahead of stable

* Dev, which is even more ahead than is the beta channel

+ Canary, which is updated very early (and the name, suggestive of a “canary in
a coal mine”, indicates that you are here to help debug the IDE)
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Contents of Android Projects

The Android build system is organized around a specific directory tree structure for
your Android project, much like any other Java project. The specifics, though, are
fairly unique to Android — the Android build tools do a few extra things to prepare
the actual application that will run on the device or emulator.

Making things more complicated is that the default structure is different for the
classic tools (e.g., Eclipse) and the new generation of tools (e.g., Android Studio).

Here is a quick primer on the project structure, to help you make sense of it all,
particularly for the sample code referenced in this book.

What You Get, In General

The details of exactly what files are in your project depend upon your choice of IDE.
However, regardless of whether you go with Android Studio or Eclipse, there are
many elements in common.

The Manifest

AndroidManifest.xml is an XML file describing the application being built and what
components — activities, services, etc. — are being supplied by that application. You
can think of it as being the “table of contents” of what your application is about,
much as a book has a “table of contents” listing the various parts, chapters, and
appendices that appear in the book.

We will examine the manifest a bit more closely starting in the next chapter. |
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The Java

When you created the project, you supplied the fully-qualified class name of the
“main” activity for the application (e.g., com.commonsware.android.SomeDemo). You
will then find that your project’s Java source tree already has the package’s directory
tree in place, plus a stub Activity subclass representing your main activity (e.g.,
src/com/commonsware/android/SomeDemoActivity.java). You are welcome to
modify this file and add Java classes as needed to implement your application, and
we will demonstrate that countless times as we progress through this book.

Elsewhere — in directories that you normally do not work with — the Android build
tools will also be code-generating some source code for you each time you build
your app. One of the code-generated Java classes (R. java) will be important for
controlling our user interfaces from our own Java code, and we will see many
references to this R class as we start building applications in earnest.

The Resources

You will also find that your project has a res/ directory tree. This holds “resources”
— static files that are packaged along with your application, either in their original
form or, occasionally, in a preprocessed form. Some of the subdirectories you will
find or create under res/ include:

res/drawable/ for images (PNG, JPEG, etc.)

res/layout/ for XML-based UI layout specifications

res/menu/ for XML-based menu specifications

res/raw/ for general-purpose files (e.g., an audio clip, a CSV file of account
information)

res/values/ for strings, dimensions, and the like

res/xml/ for other general-purpose XML files you wish to ship

W N A

o

Some of the directory names may have suffixes, like res/drawable-hdpi/. This
indicates that the directory of resources should only be used in certain
circumstances — in this case, the drawable resources should only be used on devices
with high-density screens.

We will cover all of these, and more, later in this book.
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The Build Instructions

The IDE needs to know how to take all of this stuff and come up with an Android
APK file. Some of this is already “known” to the IDE based upon how the IDE was
written. But some details are things that you may need to configure from time to
time, and so those details are stored in files that you will edit, in one means or
another, from your IDE.

In Android Studio, most of this knowledge is kept in one or more files named
build.gradle. These are for a build engine known as Gradle, that Android Studio
uses to build APKs and other Android outputs.

In Eclipse, this knowledge is scattered among several files, some of which you might
edit manually (e.g., project.properties) and some of which you would only change
through Eclipse itself (e.g., .classpath).

The Contents of an Android Studio Project

An Android Studio project is significantly more complex than is an Eclipse project.
That complexity is designed to give you more power when you become an expert
Android developer.

In the short term, though, it may be a bit confusing.

The Root Directory

In the root directory of your project, the most important item is the app/ directory,
where your application code resides. We will look at that in the next section.

Beyond the app/ directory, the other noteworthy files in the root of your project
include:

* build.gradle, which is part of the build instructions for your project, as is
described above

* Various other Gradle-related files (settings.gradle, gradle.properties,
and so forth)

* local.properties, which indicates where your Android SDK tools reside

* An .iml file, where Android Studio holds some additional metadata about
your project
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The App Directory

The app/ directory, and its contents, are where you will spend most of your time as a
developer. Rarely do you need to manipulate the files in the project root.

The most important thing in the app/ directory is the src/ directory, which is the
root of your project’s sourcesets, which will be described in the next section.

Beyond the src/ directory, there are a few other items of note in app/:

* A build/ directory, which will hold the outputs of building your app,
including your APK file

* Abuild.gradle file, where most of your project-specific Gradle
configuration will go, to teach Android Studio how to build your app

* An app.iml file, containing more Android Studio metadata

The Sourcesets

Sourcesets are where the “source” of your project is organized. Here, “source” not
only refers to programming language source code (e.g., Java), but other types of
inputs to the build, such as your resources.

The sourceset that you will spend most of your time in is main/. You will also have a
stub sourceset named androidTest, for use in creating unit tests, as will be covered
later in the book.

Inside of a sourceset, you can have:

* Java code, in a java/ directory

* Resources, in a res/ directory

* Assets, in an assets/ directory, representing other static files you wish
packaged with the application for deployment onto the device

* Your AndroidManifest.xml file
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Figure 63: Android Studio Project Explorer, Showing EmPubLite

The Contents of an Eclipse Project

When you create a new Android project in Eclipse, you get several items in the
project’s root directory, including:

1. AndroidManifest.xml, as is described above

2. bin/, which holds the application once it is compiled (note: this directory
will be created when you first build your application)

3. res/, which holds your resources, as is described above

4. src/, which holds the Java source code for the application

In addition to the files and directories shown above, you may find any of the
following in Android projects:

1. assets/, which holds other static files you wish packaged with the
application for deployment onto the device

2. gen/, where Android’s build tools will place source code that they generate

3. libs/, which holds any third-party Java JARs your application requires

4. *.properties, containing configuration data for your builds
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5. proguard.cfg or proguard-project.txt, which are used for integration with
ProGuard for obfuscating your Android code
6. Hidden Eclipse project files (e.g., .classpath)

What You Get Out Of It

As part of running your app on a device or emulator, the IDE will generate an APK
file. You will find this:

+ in the build/outputs/apk directory of your Android Studio project, if the
project has no modules (e.g., no app/ directory), or

* in the build/outputs/apk directory of your module’s directory, (e.g., app/
build/outputs/apk for a traditional Android Studio project), or

+ in the bin/ directory of your Eclipse project

The APK file is a ZIP archive containing your compiled Java classes, the compiled
edition of your resources (resources.arsc), any un-compiled resources (such as
what you put in res/raw/), and the AndroidManifest.xml file. If you build a debug
version of the application — which is the default — you will have
yourapp-debug.apk as your APK, for an app named yourapp.
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Introducing Gradle and the Manifest

In the discussion of Android Studio, this book has mentioned something called
“Gradle”, without a lot of explanation.

In this chapter, the mysteries of Gradle will be revealed to you.

(well, OK, some of the mysteries...)

)

We also mentioned in passing in the previous chapter the concept of the “manifest’,
as being a special file in our Android projects.

On the one hand, Gradle and the manifest are not strictly related. On the other
hand, some (but far from all) of the things that we can set up in the manifest can
be overridden in Gradle... for Android Studio users. Since Eclipse users are not
using Gradle, their definitions will always be in the manifest itself.

So, in this chapter, we will review both what Gradle is, what the manifest is, what
each of their roles are, and the basics of how they tie together.

Gradle: The Big Questions

First, let us “set the stage” by examining what this is all about, through a series of
fictionally-asked questions (FAQs).

What is Gradle?

Gradle is software for building software, otherwise known as “build automation
software” or “build systems”. You may have used other build systems before in other
environments, such as make (C/C++), rake (Ruby), Ant (Java), Maven (Java), etc.
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These tools know — via intrinsic capabilities and rules that you teach them — how
to determine what needs to be created (e.g., based on file changes) and how to
create them. A build system does not compile, link, package, etc. applications
directly, but instead directs separate compilers, linkers, and packagers to do that
work.

Gradle uses a domain-specific language (DSL) built on top of Groovy to accomplish
these tasks.

What is Groovy?

There are many programming languages that are designed to run on top of the Java
VM. Some of these, like JRuby and Jython, are implementations of other common
programming languages (Ruby and Python, respectively). Other languages are
unique, and Groovy is one of those.

Groovy scripts look a bit like a mashup of Java and Ruby. As with Java, Groovy
supports:

* Defining classes with the class keyword

+ Creating subclasses using extends

+ Importing classes from external JARs using import
* Defining method bodies using braces ({ and })

* Objects are created via the new operator

As with Ruby, though:

+ Statements can be part of a class, or simply written in an imperative style,
like a scripting language

+ Parameters and local variables are not typed

* Values can be automatically patched into strings, though using slightly
different syntax ("Hello, $name" for Groovy instead of "Hello, #{name}"
for Ruby)

Groovy is an interpreted language, like Ruby and unlike Java. Groovy scripts are run
by executing a groovy command, passing it the script to run. The Groovy runtime,
though, is a Java JAR and requires a JVM in order to operate.

One of Groovy’s strengths is in creating a domain-specific language (or DSL).
Gradle, for example, is a Groovy DSL for doing software builds. Gradle-specific
capabilities appear to be first-class language constructs, generally indistinguishable

92

Licensed solely for use by Qiwen Chen


http://groovy.codehaus.org/
http://en.wikipedia.org/wiki/Domain-specific_language

INTRODUCING GRADLE AND THE MANIFEST

from capabilities intrinsic to Groovy. Yet, the Groovy DSL is largely declarative, like
an XML file.

To some extent, we get the best of both worlds: XML-style definitions (generally
with less punctuation), yet with the ability to “reach into Groovy” and do custom
scripting as needed.

What Does Android Have To Do with Gradle?

Google has published the Gradle for Android plugin, which gives Gradle the ability
to build Android projects. Google is also using Gradle and Gradle for Android as the
build system behind Android Studio.

Why Did We Move to Gradle?

Originally, when we would build an app, those builds were done using Eclipse and
Ant. Eclipse was the IDE, while Ant was the command-line tool. Eclipse does not
use Ant for building Android projects, but rather has its own build system. And we
were successfully building a million-plus apps using these tools. Those tools still
work today, though Ant support is fading fast.

So, why change?
There appear to be several contributing factors, including:

+ Maintaining two separate build systems (Ant and Eclipse’s native approach)
was becoming time-consuming, and would become worse with the advent of
Android Studio and yet another build system. Hence, Google wishes to
standardize on a single build system, based upon Gradle, for IDE and
command-line scenarios.

+ Getting Ant scripts to do everything that Google needed for builds was
getting a bit creaky.

+ Ant has no first-class support for “external artifacts” (e.g., libraries) and
dependency management of those libraries. While there are ways to graft
Maven onto Ant, or use Maven’s own build system, Google never endorsed
that approach. Gradle offers much better support in this area than do Eclipse
or Ant, and will help make it easier for developers to reliably consume
libraries from a variety of authors.

+ Gradle is designed to be integrated into IDEs as a library, much more than
Ant is.
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As to why Google chose Gradle over Maven... you would have to ask Google.

How Does Gradle Relate to Android Studio?

As noted above, Android Studio uses the new Gradle-based build system as its native
approach for building Android projects. While the Intelli] IDEA IDE that serves as
Android Studio’s core also has its own build system (much like Eclipse has one),
IDEA is more amenable to replaceable build systems.

Over time, this will allow Google to focus on a single build system (Gradle) for all
supported scenarios, rather than having to deal with a collection of independent
build systems.

How Does Gradle Relate to Eclipse?

At the time of this writing, Eclipse has no ability to use Gradle for Android build
scripts, either directly or as a source of project configuration data for imports. The
Android Developer Tools (ADT) plugin for Eclipse does have the ability to export a

generated Gradle build file for a project.

It is unclear to what extent that Eclipse will ever get Gradle for Android support. It is
best to assume that this will not be possible any time soon.

Obtaining Gradle

As with any build system, to use it, you need the build system’s engine itself.

If you will only be using Gradle in the context of Android Studio, the IDE will take
care of getting Gradle for you. If, however, you are planning on using Gradle outside
of Android Studio (e.g., command-line builds), you will want to consider where your
Gradle is coming from. This is particularly important for situations where you want
to build the app with no IDE in sight, such as using a continuous integration (CI)
server, like Jenkins.

Direct Installation

What most developers looking to use Gradle outside of Android Studio will wind up
doing is installing Gradle directly.
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The Gradle download page contains links to ZIP archives for Gradle itself: binaries,
source code, or both.

You can unZIP this archive to your desired location on your development machine.

Linux Packages

You may be able to obtain Gradle via a package manager on Linux environments. For
example, there is an Ubuntu PPA for Gradle.

The gradlew Wrapper

If you are starting from a project that somebody else has published, you may find a
gradlew and gradlew.bat file in the project root, along with a gradle/ directory.

This represents the “Gradle Wrapper”.

The Gradle Wrapper consists of three pieces:

+ the batch file (gradlew.bat) or shell script (gradlew)

* the JAR file used by the batch file and shell script (in the gradle/wrapper/
directory)

* the gradle-wrapper.properties file (also in the gradle/wrapper/ directory)

Android Studio uses the gradle-wrapper.properties file to determine where to
download Gradle from, for use in your project, from the distributionUrl property
in that file:

#wed Apr 10 15:27:10 PDT 2013

distributionBase=GRADLE_USER_HOME

distributionPath=wrapper/dists

zipStoreBase=GRADLE_USER_HOME

zipStorePath=wrapper/dists
distributionUrl=https\://services.gradle.org/distributions/gradle-2.2.1-all.zip

When you create or import a project, or if you change the version of Gradle

referenced in the properties file, Android Studio will download the Gradle pointed
to by the distributionUrl property and install it to a .gradle/ directory (note the
leading .) in your project. That version of Gradle will be what Android Studio uses.

RULE #1: Only use a distributionurl that you trust.
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If you are importing an Android project from a third party — such as the samples for
this book — and they contain the gradle/wrapper/gradle-wrapper.properties

file, examine it to see where the distributionUrl is pointing to. If it is loading from
services.gradle.org, or from an internal enterprise server, it is probably
trustworthy. If it is pointing to a URL located somewhere else, consider whether you
really want to use that version of Gradle, considering that it may have been
tampered with.

The batch file, shell script, and JAR file are there to support command-line builds. If
you use gradlew, it will use a local copy of Gradle installed in .gradle/ in the
project. If there is no such copy of Gradle, gradlew will download Gradle from the
distributionUrl, as does Android Studio. Note that Android Studio does not use
gradlew for this role — that logic is built into Android Studio itself.

RULE #2: Only use a gradlew that you REALLY trust.

It is relatively easy to examine a .properties file to check a URL to see if it seems
valid. Making sense of a batch file or shell script can be cumbersome. Decompiling a
JAR file and making sense of it can be rather difficult. Yet, if you use gradlew that
you obtained from somebody, that script and JAR are running on your development
machine, as is the copy of Gradle that they install. If that code was tampered with,
the malware has complete access to your development machine and anything that it
can reach, such as servers within your organization.

Note that you do not have to use the Gradle Wrapper at all. If you would rather not
worry about it, install a version of Gradle on your development machine yourself
and remove the Gradle Wrapper files. You can use the gradle command to build
your app (if your Gradle’s bin/ directory is in your PATH), and Android Studio will
use your Gradle installation (if you teach it where to find it, such as via the
GRADLE_HOME environment variable).

Versions of Gradle and Gradle for Android

The Gradle for Android plugin that we will use to give Gradle “super Android
powers!” is updated periodically. Each update has its corresponding required version
of Gradle.

The rules, according to Google, are:
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* Android Studio 1.x works with any Gradle for Android plugin version 1.x,

where the values for “x” do not need to match.
+ Gradle for Android 1.x should work with all Gradle 2.x versions

If you are using the Gradle Wrapper, you are using an installation of Gradle that is
local to the project. So long as the version of Gradle in the project matches the
version of Gradle for Android requested in the build.gradle file — as will be
covered in the next chapter — you should be in fine shape.

If you are not using the Gradle Wrapper, you will need to decide when to take on a
new Gradle for Android release and plan to update your Gradle installation and
build.gradle files in tandem at that point.

Gradle Environment Variables

If you installed Gradle yourself, you will want to define a GRADLE_HOME environment
variable, pointing to where you installed Gradle, and to add the bin/ directory inside
of Gradle to your PATH environment variable.

You may also consider setting up a GRADLE_USER_HOME environment variable,
pointing to a directory in which Gradle can create a .gradle subdirectory, for per-
user caches and related materials. By default, Gradle will use your standard home
directory.

Examining the Gradle Files

An Android Studio project may have two build.gradle files, one at the project level
and one at the “module” level (e.g., in the app/ directory). That split is not required
for single-module projects — those could just as easily have one build.gradle file
for the module and nothing else.

Regardless of whether your build. gradle file is in one or two pieces, there are a few
common elements that you will find, outlined in this section.

buildscript

The buildscript closure (i.e., code section wrapped in braces) in Gradle is where
you configure the JARs and such that Gradle itself will use for interpreting the rest of
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the file. Hence, here you are not configuring your project so much as you are
configuring the build itself.

buildscript {
repositories {
mavenCentral()

¥
dependencies {
classpath 'com.android.tools.build:gradle:1.0.0"

¥
b

The repositories closure inside the buildscript closure indicates where
dependencies can come from, typically in the form of Maven-style repositories.
Here, mavenCentral() is a built-in method that sets up the repository information
for Maven Central, where Google is now publishing its required libraries.

The dependencies closure indicates what is required to be able to run the rest of the
build script. classpath 'com.android.tools.build:gradle:1.0.0" is not especially
well-documented by the Gradle team. However the
"com.android.tools.build:gradle:1.0.0' portion means:

+ Find the com.android. tools.build group of artifacts in a repository
+ Find the gradle artifact within that group
+ Ensure that we have version 1.0.0 of the artifact

The first time you run your build, with the buildscript closure as shown above,
Gradle will notice that you do not have this dependency. It will then visit Maven
Central and find the com.android. tools.build group and the gradle artifact within
that group, then download version 1.0.0.

Sometimes, the last segment of the version is replaced with a + sign (e.g., 1.0.+).
This tells Gradle to download the latest version, thereby automatically upgrading
you to the latest patch-level (e.g., 1.0.3 at some point).

apply plugin

The 'com.android.tools.build:gradle:1.0.0 dependency contains an
implementation of the Gradle for Android plugin, to teach Gradle Android-specific
constructs, such as those found in the android closure covered later in this chapter.
However, just downloading the dependency does not actually apply anything in it.
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The apply plugin: 'com.android.application’ statement actually adds the
Gradle for Android plugin to Gradle for this build. In particular, it indicates that we
are building an Android application.

dependencies

The dependencies closure in the buildscript closure specifies dependencies for the
build script. The dependencies closure in the root of the build.gradle file, by
contrast, specifies dependencies for the app.

However, the definition of “dependency” is largely the same: it is some library or
similar artifact that we need in addition to our project’s source code.

We will get into the concept of these libraries later in the book.

android

The android closure contains all of the Android-specific configuration information.
This closure is what the Android plugin enables.

But before we get into what is in this closure, we should “switch gears” and talk
about the manifest file, as what goes in the android closure is related to what goes
in the manifest file.

Introducing the Manifest

The foundation for any Android application is the manifest file:
AndroidManifest.xml. This will be in your project root for Eclipse projects and in
your app module’s src/main/ directory for classic Android Studio projects.

Here is where you declare what is inside your application — the activities, the
services, and so on. You also indicate how these pieces attach themselves to the
overall Android system; for example, you indicate which activity (or activities)
should appear on the device’s main menu (a.k.a., launcher).

When you create your application, you will get a starter manifest generated for you.
For a simple application, offering a single activity and nothing else, the auto-
generated manifest will probably work out fine, or perhaps require a few minor
modifications. On the other end of the spectrum, the manifest file for the Android
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API demo suite is over 1,000 lines long. Your production Android applications will
probably fall somewhere in the middle.

As mentioned previously, some items can be defined in both the manifest and in a
build.gradle file. The approach of putting that stuff in the manifest still works,
and for Eclipse it is the only option, as Eclipse is not looking at a build. gradle file.
For Android Studio users, you will probably use the Gradle file and not have those
common elements be defined in the manifest.

Things In Common Between the Manifest and
Gradle

There are a few key items that can be defined in the manifest and can be
overridden in build.gradle statements. These items are fairly important to the
development and operation of our Android apps as well.

Package Name and Application ID
The root of all manifest files is, not surprisingly, a manifest element:

<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.commonsware.empublite">

Note the android namespace declaration. You will only use the namespace on many
of the attributes, not the elements (e.g., <manifest>, not <android:manifest>).

The biggest piece of information you need to supply on the <manifest> element is
the package attribute.

The package attribute will always need to be in the manifest, even for Android
Studio projects. The package attribute will control where some source code is
generated for us, notably some R and BuildConfig classes that we will encounter
later in the book.

Since the package value is used for Java code generation, it has to be a valid Java
package name. Java convention says that the package name should be based off of a
reverse domain name (e.g., com.commonsware.empublite), where you own the
domain in question. That way, it is unlikely that anyone else will accidentally
collide with the same name.
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The package also serves as our app’s default “application ID”. This needs to be a
unique identifier, such that:

* no two apps can be installed on the same device at the same time with the
same application ID

* no two apps can be uploaded to the Play Store with the same application ID
(and other distribution channels may have the same limitation)

By default, the application ID is the package value, but Android Studio users can
override it in their Gradle build files. Specifically, inside of the android closure can
be a defaultConfig closure, and inside of there can be an applicationId
statement:

android {
// other stuff

defaultConfig {
applicationId "com.commonsware.empublite"
// more other stuff

}

Not only can Android Studio users override the application ID in the
defaultConfig closure, but there are ways of having different application ID values
for different scenarios, such as a debug build versus a release build. We will explore
that more later in the book.

minSdkVersion and targetSdkVersion

Your manifest may also contain a <uses-sdk> element as a child of the <manifest>
element, to specify what versions of Android you are supporting. It can contain,
among other things, android:minSdkVersion and android: targetSdkVersion
attributes. Eclipse projects will always have this element. Android Studio projects
may not have this element, because the values are defined as minSdkVersion and
targetSdkVersion properties in the defaultConfig closure, where applicationId
can be defined.

Of the two, the more critical one is minSdkVersion. This indicates what is the
oldest version of Android you are testing with your application. The value of the
attribute is an integer representing the Android API level. So, if you are only testing
your application on Android 4.1 and newer versions of Android, you would set your
minSdkVersion to be 16.
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You can also specify a targetSdkVersion. This indicates what version of Android
you are thinking of as you are writing your code. If your application is run on a
newer version of Android, Android may do some things to try to improve
compatibility of your code with respect to changes made in the newer Android.
Nowadays, most Android developers should specify a target SDK version of 14 or
higher. We will start to explore more about the targetSdkVersion as we get deeper
into the book; for the moment, whatever your IDE gives you as a default value is
probably a fine starting point.

The XML element looks like:

<uses-sdk android:minSdkVersion="14" android:targetSdkVersion="19" />
The corresponding entries in build.gradle go in the defaultConfig closure:

android {
// other stuff

defaultConfig {
applicationId "com.commonsware.empublite"
minSdkVersion 15
targetSdkVersion 18
// more other stuff

Version Code and Version Name

Your manifest can also specify android:versionName and android:versionCode
attributes, up on the root <manifest> element. An Android Studio project, though,
frequently skips those and defines them via versionName and versionCode
properties in the defaultConfig closure.

These two values represent the versions of your application. The versionName value
is what the user will see for a version indicator in the Applications details screen for
your app in their Settings application:
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i “( & 05:40

= App info

[T Barcode Scanner
L version 4.2

Force stop Uninstall

STORAGE

Total 0.96MB
App 0.91TMB
USB storage app 0.00B
Data 56.00KB
USB storage data 0.00B

Clear data

CACHE

Cache

LAUNCH BY DEFAULT

Figure 64: Barcode Scanner App Screen in Settings, Showing Version 4.2

Also, the version name is used by the Play Store listing, if you are distributing your
application that way. The version name can be any string value you want.

The versionCode, on the other hand, must be an integer, and newer versions must
have higher version codes than do older versions. Android and the Play Store will
compare the version code of a new APK to the version code of an installed
application to determine if the new APK is indeed an update. The typical approach
is to start the version code at 1 and increment it with each production release of
your application, though you can choose another convention if you wish. During
development, you can leave these alone, but when you move to production, these
attributes will matter greatly.

Other Gradle Iltems of Note

You will always have at least two statements directly in the android closure:
compileSdkVersion and buildToolsVersion.

android {
compileSdkVersion 19
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buildToolsVersion "21.1.2"
}

compileSdkVersion specifies the API level to be compiled against, usually as a
simple API level integer (e.g., 19). An Eclipse project would pull this out of the
project.properties file in the root of the project directory.

buildToolsVersion indicates the version of the Android SDK build tools that you
wish to use with this project. While downloading the android plugin from Maven
Central gives us parts of what is needed, it is not complete. The rest comes from the

“Android SDK Build-tools” entry in the SDK Manager:

‘' Android SDK Manager

SDK Path:
Packages
i Name APl | Rev. Status
¥ O & Tools
+" Android SDK Tools 23.0.2 |f# Installed
«" Android SDK Platform-tools 20 (i@ Installed
+" Android SDK Build-tools 20 | Installed
¢ Android SDK Build-tools 19.1 B Installed
# Android SDK Build-tools 19.0.3i] Not installed
Android SDK Build-tools 19.0.2 [ Notinstalled
/" Android SDK Build-tools 19.0.1 | Installed
* Android SDK Build-tools 19 B Installed
¢ Android SDK Build-tools 18.1.1 ] Not installed
¢ Android SDK Build-tools 18.1 | Installed
Android SDK Build-tools 18.0.1i{| Not installed
Android SDK Build-tools 17 i[C| Notinstalled -
show: [ Updates/New & Installed [ | Obsolete select New or Updates
sort by: @ API level ) Repository Deselect All

O

Done loading packages.

Figure 65: SDK Manager, Showing “Android SDK Build-tools”

Note that the SDK Manager will allow you to download the latest version of the
build tools used by Gradle (appearing as 20 in the above screenshot) plus prior

versions (e.g., 18.0.1 and 17 in the above screenshot). This corresponds with the

buildToolsVersion in your build.gradle file.

So, your android closure could look like:

android {
compileSdkVersion 19
buildToolsVersion "20.0.0"
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defaultConfig {
applicationId "com.commonsware.empublite"
versionCode 1
versionName "1.0"
minSdkVersion 15
targetSdkVersion 18

}

Eclipse does not really have the notion of a configurable build tools version, so
there is no analogue for buildToolsVersion in an Eclipse project.

The Rest of the Manifest

Not everything in the manifest can be overridden in the Gradle build files. Here are
a few key items that will always appear in the manifest, regardless of whether this
project is to be built by Android Studio, Eclipse, or other means.

An Application For Your Application

In your initial project’s manifest, the primary child of the <manifest> element is an
<application> element.

By default, when you create a new Android project, you get a single <activity>
element inside the <application> element:

<?xml version="1.0"?>

<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.commonsware.android.skeleton"
android:versionCode="1"
android:versionName="1.0">

<application>
<activity
android:name="Now"
android:label="Now">
<intent-filter>
<action android:name="android.intent.action.MAIN"/>

<category android:name="android.intent.category.LAUNCHER"/>
</intent-filter>
</activity>
</application>

</manifest>
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This element supplies android:name for the class implementing the activity,
android:label for the display name of the activity, and (sometimes) an
<intent-filter> child element describing under what conditions this activity will
be displayed. The stock <activity> element sets up your activity to appear in the
launcher, so users can choose to run it. As we'll see later in this book, you can have
several activities in one project, if you so choose.

The android:name attribute, in this case, has a bare Java class name (Now).
Sometimes, you will see android:name with a fully-qualified class name (e.g.,

com. commonsware.android.skeleton.Now). Sometimes, you will see a Java class
name with a single dot as a prefix (e.g., .Now). Both Now and .Now refer to a Java class
that will be in your project’s package — the one you declared in the package
attribute of the <manifest> element.

Supporting Multiple Screens

Android devices come with a wide range of screen sizes, from 2.8” tiny smartphones
to 46” TVs. Android divides these into four buckets, based on physical size and the
distance at which they are usually viewed:

Small (under 3”)

Normal (3” to around 4.5”)
Large (4.5” to around 10”)
Extra-large (over 10”)

W DN

By default, your application will support small and normal screens. It also will
support large and extra-large screens via some automated conversion code built into
Android.

To truly support all the screen sizes you want, you should consider adding a
<supports-screens> element to your manifest. This enumerates the screen sizes you
have explicit support for. For example, if you are providing custom Ul support for
large or extra-large screens, you will want to have the <supports-screens> element.
So, while the starting manifest file works, handling multiple screen sizes is
something you will want to think about.

You wind up with an element akin to:

<supports-screens
android:largeScreens="true"
android:normalScreens="true"
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android:smallScreens="false"
android:xlargeScreens="true" />

Much more information about providing solid support for all screen sizes, including
samples of the <supports-screens> element, will be found later in this book as we
cover large-screen strategies.

Other Stuff

As we proceed through the book, you will find other elements being added to the
manifest, such as:

* <uses-permission>, to tell the user that you need permission to use certain
device capabilities, such as accessing the Internet

+ <uses-feature>, to tell Android that you need the device to have certain
features (e.g., a camera), and therefore your app should not be installed on
devices lacking such features

* <meta-data>, for bits of information needed by particular extensions to
Android, such as the Google Play Services library.

These and other elements will be introduced elsewhere in the book.

Learning More About Gradle

This book will go into more about Gradle, both in the core chapters and in the trails.
But, the focus will be on Gradle for Android, and Gradle itself offers a lot more than
that. The Gradle Web site hosts documentation, links to Gradle-specific books, and

links to other Gradle educational resources.

At present, the Gradle for Android documentation is limited and mostly appears on

the Android tools site. Of note is the top-level page about the new build system,
and the Gradle plugin user guide, though both may be out of date compared to the

actual tools themselves.

Visit the Trails!

There are a few more chapters in this book getting into more details about the use of
Gradle and Gradle for Android.
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* Gradle and Legacy Projects is for developers who are looking to use Gradle
with Eclipse-style projects

+ Gradle and Tasks explains how we ask Gradle to do things on our behalf
(“tasks”), such as compile our APK for us

+ Gradle and the New Project Structure gets into why the project structure
changed from what we used with Eclipse, and what capabilities we get as a
result, including the ability to configure “build types” and “product flavors”

* Gradle and Dependencies covers more about the “artifacts” mentioned
earlier in this chapter, as ways we can get packaged libraries automatically
added to our projects via just a couple of lines in our build.gradle files

There is also the “Advanced Gradle for Android Tips” chapter for other Gradle topics,
and the chapter on manifest merging in Gradle.
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(and Gradle File)

As we build EmPubLite, we will need to make a number of changes to our project’s
manifest. In this tutorial, we will take care of a couple of these changes, to show you
how to manipulate the AndroidManifest.xml file. Future tutorials will make yet
more changes.

Android Studio users will also get their first chance to work with the build.gradle
file.

This is a continuation of the work we did in the previous tutorial.

You can find the results of the previous tutorial and the results of this tutorial in the
book’s GitHub repository:

* Android Studio previous tutorial and this tutorial
* Eclipse previous tutorial and this tutorial

Some Notes About Relative Paths

In these tutorials, you will see references to relative paths, like
AndroidManifest.xml, res/layout/, and so on.

Eclipse users should interpret these paths as being relative to the project root
directory.

Android Studio users should interpret these paths as being relative to the app/src/
main/ directory within the project, except as otherwise noted. So, for example, Step
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TUTORIAL #3 - CHANGING OUR MANIFEST (AND GRADLE FILE)

#1 below will ask you to open AndroidManifest.xml — that file can be found in app/
src/main/AndroidManifest.xml from the project root.

Step #1: Supporting Screens

Our application will restrict its supported screen sizes. Tablets make for ideal ebook
readers. Phones can also be used, but the smaller the phone, the more difficult it
will be to come up with a Ul that will let the user do everything that is needed, yet
still have room for more than a sentence or two of the book at a time.

We will get into screen size strategies and their details later in this book. For the
moment, though, we will add a <supports-screens> element to keep our
application off “small” screen devices (under 3” diagonal size).

The following sections contain instructions for Android Studio and Eclipse —
choose the instructions appropriate for the IDE you are using for these tutorials.

Android Studio

Double-click on AndroidManifest.xml in your project explorer.

As a child of the root <manifest> element, add a <supports-screens> element as
follows:

<supports-screens
android:largeScreens="true"
android:normalScreens="true"
android:smallScreens="false"
android:xlargeScreens="true"/>

Eclipse

In the Package Explorer view in Eclipse, find the AndroidManifest.xml entry and
double-click on it.
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¥ 2 EmPubLite

> B src

» 28 gen [Generated Java Files]

P =) Android 4.4.2
& assets

» & bin
&= libs

> & res
2 AndroidManifest.xml
& build.xml
local.properties
E proguard-project.kxt
project.properties

Figure 66: Eclipse Package Explorer, Showing EmPubLite

Double-clicking on the file will bring the file up in Eclipse’s default editor for that

type of file. In the case of AndroidmManifest.xml, this will be a structured editor for
manifest settings:

< EmPubLite Manifest X =g

# Android Manifest

~ Manifest General Attributes
Defines general information about the AndroidManifest.xml

Package com.commonsware.empublite

Browse...
Version code 1
Version name 1.0 Browse...
Shared userid Browse...
Shared user label Browse...

Install location

Manifest Extras DEOPOEO®® ® a:
@ Uses sdk Add
- Exporting

To export the application for distribution, you have the following options:
* Use the Export Wizard to export and sign an APK
* Export an unsigned APK and sign it manually
= Links
The content of the Android Manifest is made up of three sections. You can also edit the XML directly.
[®) Application: Activities, intent filters, providers, services and receivers.
(F) Permission: Permissions defined and permissions used.
[0 Instrumentation: Instrumentation defined.
=) XML Source: Directly edit the AndroidManifest.xml file.
%' Documentation: Documentation from the Android SDK for AndreidManifest.xml.
] Manifest [&) Application| (] Permissions | (1] Instrumentation| =) AndroidManifest.xml|

Figure 67: Eclipse Manifest Editor
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You will notice that there is a series of sub-tabs at the bottom of the editor, labeled
“Manifest”, “Application”, “Permissions”, and so on. These allow you to adjust
different portions of the manifest file. The right-most sub-tab,
“AndroidManifest.xml”, allows you to edit the raw XML of this file directly, if you so
choose. This is a fairly typical pattern with the Eclipse editors: one or more sub-tabs
providing a structured way of editing the data, and the right-most sub-tab providing

raw access to the underlying XML.

In the “Manifest Extras” area of the “Manifest” sub-tab in our open manifest editor,
click the “Add..” button to the right of the extras list, to bring up a dialog of what
sort of extras we can add:

Create a new element at the top level, in Manifest.

[€] compatible Screens
© Original Package

® Package Verifier

() Protected Broadcast
(® supports Screens

@ Uses Configuration
@ Uses Feature

@ Uses sdk

Cancel | oK |

Figure 68: Eclipse Manifest Extras Options

Click on “Supports Screens”, then click “OK” to close the dialog and add a “Supports
Screens” entry in the “Manifest Extras” list. That entry will be pre-selected by the
editor, showing the available configuration options on the right:
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(ONONONUNERONORORE

(8 The supports-screens specifies the screen dimensions an
@ uses sdk Add... application supports.

® supports Screens Requires smallest width dp

Remove...
Compatible width limit dp

Up Largest width limit dp

small screens v
Normal screens v

Large screens v

Figure 69: Eclipse Supports Screens Options

Note that the attributes list on the right may have vertical scrollbar, as there are
several things we can stipulate on the <supports-screens> element, and not all can
fit on the editor at once given the editor’s design.

Using that scrollbar as needed, toggle the “Small screens” value to false and the

”» ¢

“Normal screens”, “Large screens”, and “Xlarge screens” values to true:

(8) The supports-screens specifies the screen dimensions an -
application supports.

Requires smallest width dp
Compatible width limit dp
Largest width limit dp

Small screens false v
Normal screens true v
Large screens true v
Xlarge screens true v

Figure 7o: Eclipse Supports Screens Options, Adjusted

Then you can save the file, via the main menu, the Save toolbar icon, or <Ctr1>-<S>.

Step #2: Adding our Minimum and Target SDK
Versions

We also need to teach our IDE our minimum SDK version (how old a version of
Android we will support) and our target SDK version (what version of Android we
were thinking of when writing our code).

Eclipse users will accomplish this by adding a <uses-sdk> element to the manifest.
Android Studio users could do the same, but instead we will follow the Android
Studio convention and add those values to build.gradle.
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The following sections contain instructions for Android Studio and Eclipse —
choose the instructions appropriate for the IDE you are using for these tutorials.

Android Studio

Double-click on app/build.gradle, off of the project root, in the Project Explorer.
You should see in there a defaultConfig closure that looks like:

defaultConfig {
applicationId "com.commonsware.empublite"
versionCode 1
versionName "1.0"

}

Add the minSdkVersion 15 and targetSdkVersion 18 statements to it, so that it
looks like:

defaultConfig {
applicationId "com.commonsware.empublite"
versionCode 1
versionName "1.0"
minSdkVersion 15
targetSdkVersion 18
b

You may get a yellow banner at the top of the editor, indicating that a “project sync”
is requested. If you do, click the “Sync Now” link in that banner to synchronize the
* . iml files with the changes you made to this build.gradle file.

Eclipse

You should already have the AndroidManifest.xml file open in Eclipse from Step #1
of this tutorial.

In the “Manifest Extras” area of the “Manifest” sub-tab in our open manifest editor,
see if you already have a “Uses Sdk” entry. If yes, click it to fill in the details pane to
the right. If you do not have a “Uses Sdk” entry, click the “Add...” button to the right
of the extras list, choose “Uses Sdk”, then click “OK” to close the dialog and add a
“Supports Screens” entry in the “Manifest Extras” list:
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DOPOEOO®EOCO A:
The

L= Add... tag describes the SDK features that the containing package must be

(8 supports Screens
@ Uses sdk running on to operate correctly.

Remove... . &
Min SDK version Browse...

Target SDK version Browse...

Max SDK version

Figure 71: Eclipse Manifest Extras, Showing “Uses Sdk”

In the “Min SDK version” field, fill in 15, meaning that we will support Android 4.0.3
and higher.

In the “Target SDK version” field, fill in 18.

Leave the “Max SDK version” field blank, as that is unused in Android and most
marketplaces.

Then you can save the file, via the main menu, the Save toolbar icon, or <Ctr1>-<S>.

In Our Next Episode...

... we will make some changes to the resources of our tutorial project
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Some Words About Resources

It is quite likely that by this point in time, you are “chomping at the bit” to get into
actually writing some code. This is understandable. That being said, before we dive
into the Java source code for our stub project, we really should chat briefly about
resources.

Resources are static bits of information held outside the Java source code. Resources
are stored as files under the res/ directory in your Android project layout (whether
that is in the project root for Eclipse or in the main/ sourceset for Android Studio).
Here is where you will find all your icons and other images, your externalized strings
for internationalization, and more.

These are not only separate from the Java source code because they are different in
format. They are separate because you can have multiple definitions of a resource, to
use in different circumstances. For example, with internationalization, you will have
strings for different languages. Your Java code will be able to remain largely oblivious
to this, as Android will choose the right resource to use, from all candidates, in a
given circumstance (e.g., choose the Spanish string if the device’s locale is set to
Spanish).

We will cover all the details of these resource sets later in the book. Right now, we
need to discuss the resources in use by our stub project, plus one more.

This chapter will refer to the res/ directory. Android Studio users will find that in
the app/src/main/ directory of their project, while Eclipse users will find it in the
project root directory.
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String Theory

Keeping your labels and other bits of text outside the main source code of your
application is generally considered to be a very good idea. In particular, it helps with
internationalization (I18N) and localization (L1oN). Even if you are not going to
translate your strings to other languages, it is easier to make corrections if all the
strings are in one spot instead of scattered throughout your source code.

Plain Strings

Generally speaking, all you need to do is have an XML file in the res/values
directory (typically named res/values/strings.xml), with a resources root
element, and one child string element for each string you wish to encode as a
resource. The string element takes a name attribute, which is the unique name for
this string, and a single text element containing the text of the string:

<resources>
<string name="quick">The quick brown fox...</string>
<string name="laughs">He who laughs last...</string>
</resources>

One tricky part is if the string value contains a quote or an apostrophe. In those
cases, you will want to escape those values, by preceding them with a backslash (e.g.,
These are the times that try men\'s souls). Or, if it is just an apostrophe, you
could enclose the value in quotes (e.g., "These are the times that try men's
souls.").

For example, a project’s strings.xml file could look like this:

<?xml version="1.0" encoding="utf-8"?>
<resources>

<string name="app_name">EmPubLite</string>
<string name="hello_world">Hello world!</string>

</resources>

We can reference these string resources from various locations, in our Java source
code and elsewhere. For example, the app_name string resource often is used in the
AndroidManifest.xml file:

<?xml version="1.0" encoding="utf-8"?>
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.commonsware.empublite"
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android:versionCode="1"
android:versionName="1.0">

<supports-screens
android:largeScreens="true"
android:normalScreens="true"
android:smallScreens="false"
android:xlargeScreens="true"/>

<uses-sdk
android:minSdkVersion="15"
android:targetSdkVersion="18"/>

<application

android:allowBackup="false"
android:icon="@drawable/ic_launcher"
android:label="@string/app_name"
android:theme="@style/AppTheme">
<activity

android:name="EmPubLiteActivity"

android:label="@string/app_name">

<intent-filter>

<action android:name="android.intent.action.MAIN"/>

<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>
</application>

</manifest>

Here, the android:label attribute of the <application> element refers to the
app_name string resource. This will appear in a few places in the application, notably
in the list of installed applications in Settings. So, if you wish to change how your
application’s name appears in these places, simply adjust the app_name string
resource to suit.

The syntax @string/app_name tells Android “find the string resource named
app_name”. This causes Android to scan the appropriate strings.xml file (or any
other file containing string resources in your res/values/ directory) to try to find
app_name.

Styled Text

Many things in Android can display rich text, where the text has been formatted
using some lightweight HTML markup: <b>, <i>, and <u>. Your string resources
support this, simply by using the HTML tags as you would in a Web page:
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<resources>
<string name="b">This has <b>bold</b> in it.</string>

<string name="i">Whereas this has <i>italics</i>!</string>
</resources>

CDATA. CDATA Run. Run, DATA, Run.

Since a strings resource XML file is an XML file, if your message contains <, >, or &
characters (other than the formatting tags listed above), you will need to use a CDATA
section:

<string name="report_body">

<! [CDATA[

<html>

<body>

<h1>TPS Report for: {{reportDate}}</h1>

<p>Here are the contents of the TPS report:</p>
<p>{{message}}</p>

<p>If you have any questions regarding this report, please
do <b>not</b> ask Mark Murphy.</p>

</body>

</html>

11>

</string>
The Directory Name

Our string resources in our stub project are in the res/values/strings.xml file.
Since this directory name (values) has no suffixes, the string resources in that
directory will be valid for any sort of situation, including any locale for the device.
We will need additional directories, with distinct strings.xml files, to support other
languages. We will cover how to do that later in this book.

Editing String Resources

If you double-click on a string resource file, like res/values/strings.xml, in
Android Studio, you are presented the XML and edit it that way.

When you double-click on a string resource file in Eclipse, you will be greeted with a
list of all the string resources that have been defined:
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a strings.xml &2

(ONGRORONHNONE RIS

(® app_name (String) Add..
(® hello_world (string)

(® menu_settings (String)

(® title_activity_em_pub_lite (String)

=] Resources | =] strings.xml

Figure 72: Eclipse, Showing String Resources
Clicking on a resource allows you to edit its name and value:

2 strings-xml £2 =8

@O0OOEHOEMN A

. (® skrings, with optional simple Formatting, can be stored and retrieved as
® app_name (String) Add.. resources. You can add fermatting to your string by using three standard
® hello_world (String) HTML tags: b, i, and u. If you use an apostrophe or a quote inyour string,
( menu_settings (String) Bemi:. you must either escape it or enclose the whole string in the other kind of

enclosing quotes.

® title_activity_em_pub_lite (String) Name |app_name

Do Value* EmPubLite

Figure 73: Eclipse, Editing Existing String Resources

Clicking the “Add..” button to the right of the list of strings brings up a dialog where
you can add another resource to this file, typically a string:
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Create a new element at the top level, in Resources.

© color

@ Dimension
(@ Drawable

[0 Integer Array
@ Item

(8 skring

[8) string Array
(5] style/Theme

cancel | oK |

Figure 74: Eclipse, Add String Resource Dialog

Choosing “String” in that dialog and clicking OK will add another (empty) string
resource to the list, where you can fill in the name and value.

You can always click on the strings.xml sub-tab to bring up an XML editor on the
string resources if you prefer.

Got the Picture?

Android supports images in the PNG, JPEG, and GIF formats. GIF is officially
discouraged, however; PNG is the overall preferred format. Android also supports
some proprietary XML-based image formats, though we will not discuss those at
length until later in the book.

The default directory for these so-called drawable resources is res/drawable/. Any
images found in there can be referenced from Java code or from other places (such
as the manifest), regardless of device characteristics.

However, your stub project does not have a res/drawable/ directory.

Instead, it has directories like res/drawable-mdpi/ and res/drawable-hdpi/.
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These refer to distinct resource sets. The suffixes (e.g., -mdpi, -hdpi) are filters,
indicating under what circumstances the images stored in those directories should
be used. Specifically, -1dpi indicates images that should be used on devices with
low-density screens (around 120 dots-per-inch, or “dpi”). The -mdpi suffix indicates
resources for medium-density screens (around 160dpi), -hdpi indicates resources for
high-density screens (around 240dpi). -xhdpi indicates resources for extra-high-
density screens (around 320dpi), --xxhdpi indicates extra-extra-high-density
screens (around 480dpi), -xxxhdpi indicates extra-extra-extra-high-density screens
(around 640dpi), and so on.

Inside each of those directories, you will see an ic_launcher.png file (along with
perhaps other icons). This is the stock icon that will be used for your application in
the home screen launcher. Each of the images is of the same icon, but the higher-
density icons have more pixels. The objective is for the image to be roughly the same
physical size on every device, using higher densities to have more detailed images.

For example, our EmPubLite tutorial project has directories like res/
drawable-hdpi/, res/drawable-xhdpi/, and res/drawable-mdpi/. Each could
contain a stock launcher icon (ic_launcher.png) tailored for that density.

Our AndroidManifest.xml file then references our ic_launcher icon in the
<application> element:

<?xml version="1.0" encoding="utf-8"?>

<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.commonsware.empublite"
android:versionCode="1"
android:versionName="1.0">

<supports-screens
android:largeScreens="true"
android:normalScreens="true"
android:smallScreens="false"
android:xlargeScreens="true"/>

<uses-sdk
android:minSdkVersion="15"
android:targetSdkVersion="18"/>

<application
android:allowBackup="false"
android:icon="@drawable/ic_launcher"
android:label="@string/app_name"
android:theme="@style/AppTheme">
<activity
android:name="EmPubLiteActivity"
android:label="@string/app_name">
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<intent-filter>
<action android:name="android.intent.action.MAIN"/>

<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>
</application>

</manifest>

Note that the manifest simply refers to @drawable/ic_launcher, telling Android to
find a drawable resource named ic_launcher. The resource reference does not
indicate the file type of the resource — there is no .png in the resource identifier.
This means you cannot have ic_launcher.png and ic_launcher.jpg in the same
project, as they would both be identified by the same identifier. You will need to
keep the “base name” (filename sans extension) distinct for all of your images.

Also, the @drawable/ic_launcher reference does not mention what screen density
to use. That is because Android will choose the right screen density to use, based
upon the device that is running your app. You do not have to worry about it
explicitly, beyond having multiple copies of your icon.

If Android detects that the device has a screen density for which you lack an icon,
Android will take the next-closest one and scale it.

Getting Android Drawables

You may be a graphic designer. Or, you may know a graphic designer. In those cases,
you can create your own icons, ideally following Google’s design guidelines for

iconography.

If you are not a graphic designer and do not have ready access to one, you will need
to come up with your drawable resources by other means. There are plenty of icon
libraries available from third parties, but the following sections outline some of
Google’s solutions for putting icons in your app.

Android Icon Set Wizard

Both Android Studio and Eclipse offer an icon set wizard. This wizard is designed to
take a starter image and give you icons, in a variety of densities, that use that image
for a particular image role, such as your home screen launcher icon (the
ic_launcher.png file we saw earlier in this chapter).

124

Licensed solely for use by Qiwen Chen


http://developer.android.com/design/style/iconography.html
http://developer.android.com/design/style/iconography.html

SoME WORDS ABOUT RESOURCES

We will explore how to use this wizard, for both Android Studio and Eclipse, in the

next tutorial.

Android Asset Studio

The same basic functionality found in the icon set wizard is available outside any
IDE (but inside a Chrome browser) in the form of the Android Asset Studio. As with
the icon set wizard, you can choose a type of icon (e.g., launcher icons):

m p -~ |~y M Ar o -
Launcher Icon Generator
Foreground IMAGE CLIPART  TEXT

TRIM m DONTTRIM

paDDING —@————————————— 0%
o . .'—u%
Scaling CROP m
Shape NONE m SQUARE CIRCLE

Background

DOWNLOAD ZIP GENERATE WEB ICON

hdpi mdpi. web, hi-res

Figure 75: Android Asset Studio, Launcher Icon Page

Then you can specify the source of the base image (uploaded file, canned clipart, or
free-form text) and other configuration data. The resulting images, in various
densities, can be downloaded at the bottom of the page:
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¢ ANDROID ASSET STUDIO

L auncher lcon Generator

Foreground m CLIPART TEXT
TRIM m DONTTRIM @

PADDING — @——————————— %

Celor ..7 0%
Scaling CROP
Shape NONE m SQUARE  CIRCLE

Background

DOWNLOAD ZIP GENERATE WEB ICON
i xxhdpi

Figure 76: Android Asset Studio, Launcher Icon Page, with Icons

The Action Bar Icon Pack

Much of the clipart used by the icon set wizard and Android Asset Studio comes
from Google’s Action Bar Icon Pack, which is a set of icons, at various densities,
designed to be used as icons for toolbar-style buttons in the action bar. We will talk
more about what the action bar is and how you use it later in the book, and in a
subsequent tutorial we will download and use icons from the Action Bar Icon Pack.

Editing Existing Drawable Resources
Neither Android Studio nor Eclipse ships with any sort of image editor that you

could use for PNG and JPEG files. Hence, you will find yourself editing these images
using other tools outside of your IDE.

Dimensions

Dimensions are used in several places in Android to describe distances, such as a
widget’s size. There are several different units of measurement available to you:
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1. px means hardware pixels, whose size will vary by device, since not all
devices have the same screen density

2. inand mm for inches and millimeters, respectively, based on the actual size of
the screen

3. pt for points, which in publishing terms is 1/72nd of an inch (again, based on
the actual physical size of the screen)

4. dip (or dp) for density-independent pixels — one dip equals one hardware
pixel for a ~160dpi resolution screen, but one dip equals two hardware pixels
on a ~320dpi screen

5. sp for scaled pixels, where one sp equals one dip for normal font scale levels,
increasing and decreasing as needed based upon the user’s chosen font scale
level in Settings

Dimension resources, by default, are held in a dimens.xml file in the res/values/
directory that also holds your strings.

To encode a dimension as a resource, add a dimen element to dimens.xml, with a
name attribute for your unique name for this resource, and a single child text
element representing the value:

<resources>
<dimen name="thin">10dip</dimen>
<dimen name="fat">1in</dimen>
</resources>

In a layout, you can reference dimensions as @dimen/. . ., where the ellipsis is a
placeholder for your unique name for the resource (e.g., thin and fat from the
sample above). In Java, you reference dimension resources by the unique name
prefixed with R.dimen. (e.g., Resources.getDimension(R.dimen.thin)).

While our stub project does not use dimension resources, we will be seeing them
soon enough.

Editing Dimension Resources

As with most types of XML resources, Android Studio just has you edit the XML
directly, when you double-click on the resource in the project explorer.

In Eclipse, much like editing string resources, when you double-click on a
dimension resource file (e.g., res/values/dimens.xml), you will be presented with a
list of existing dimensions. Clicking on one will let you change its definition:

127

Licensed solely for use by Qiwen Chen



SoME WORDS ABOUT RESOURCES

2 dimens.xml £ =a
oL
@O0O0OOEHOEMD - :
@ You can create common dimensions to use For various screen elements
® padding_small (Dimension) A, by defining dimension values in XML. A dimension resource is a number
® padding_medium (Dimension) (f_ollzwe}d by a(ur!iliof Tea?ur?(ner]t.ESu[;[;grlt):cli)ugits(gre p;( [pigels}, ié] :
: ; N Fo—— inches), mm (millimeters), pt (points a , dp (density-independen
© padding_large (Dimension) pixels) and sp (scale-independent pixels)

Mame  padding_small

D Value* 8dp

Figure 77: Eclipse, Editing Existing Dimension Resources

Clicking the “Add..” button to the right of the list of dimensions brings up a dialog
where you can add another resource to this file, typically a dimension. Choosing
“Dimension” and clicking “OK” will add an empty dimension resource to the file, for
which you can supply the name and value.

And, as always, you can click on a sub-tab with the name of your file (e.g.,
dimens.xml) to bring up an XML editor on that resource’s content:

o dimens.xml 3

1 <resources>

2

3 <dimen name="padding small">8dp</dimen>
4  <dimen name="padding medium">8dp</dimen>
5 <dimen name="padding large">16dp</dimen>
6

l 7 </resources>
Figure 78: Eclipse, Dimension Resources in XML Editor

The Resource That Shall Not Be Named... Yet

Your stub project also has a res/layout/ directory, in addition to the ones described
above. That is for Ul layouts, describing what your user interface should look like.
We will get into the details of that type of resource as we start examining our user

interfaces in an upcoming chapter.
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Our EmPubLite project has some initial resources. However, the defaults are not
what we want for the long term. So, in addition to adding new resources in future
tutorials, we will fix the ones we already have in this tutorial.

This is a continuation of the work we did in the previous tutorial. |

You can find the results of the previous tutorial and the results of this tutorial in the
book’s GitHub repository:

* Android Studio previous tutorial and this tutorial
* Eclipse previous tutorial and this tutorial

Step #1: Changing the Name

Our application shows up everywhere as “EmPubLite”:

* In the title bar of our activity

* As the caption under our icon in the home screen launcher
* In the Application list in the Settings app

+ And so on

We should change that to be “EmPub Lite”, adding a space for easier reading, and to
illustrate that this is a “lite” version of the full EmPub application.

The following sections contain instructions for Android Studio and Eclipse —
choose the instructions appropriate for the IDE you are using for these tutorials.
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Android Studio

Double-click on the res/values/strings.xml file in your project explorer.

In the XML editor for the string resources, you will find an element that looks like:
<string name="app_name">EmPubLite</string>

Change the text node in this element to EmPub Lite. Then save your changes, giving
you something like:

<resources>

<string name="app_name">EmPub Lite</string>
<string name="hello_world">Hello world!</string>

</resources>
Eclipse

In the Package Explorer, open up the res/values/ folder — you should see a
strings.xml file in there:

* @src
» &2 gen [Generated Java Files]
> =i Android 4.4.2
&= assets
» & bin
& libs
v & res
> = drawable-hdpi
= drawable-ldpi
* = drawable-mdpi
» = drawable-xhdpi
» (= drawable-xxhdpi
> = layout
¥ = menu
¥ = values
[¥) strings.xml
% styles.xml
* = valuesv11
* = values-vi4
< AndroidManifest.xml
£ build.xml
|2 ic_launcher-web.png
[El local.properties
[E proguard-project.kxt
[ project.properties

Figure 79: Eclipse Package Explorer, Showing EmPubLite
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Double-click on strings.xml to open it in the string resources editor:
o strings.xml &2

o000 OHEMDNME A

® app_name (String)
® hello_world (String)
(® menu_settings (String)

Add...

Figure 8o: Eclipse String Resources Editor

This shows a list of the defined string resources (denoted by the green S in the
circle) in this file.

Click the app_name resource, to bring up its details on the right:

< strings.xml &2 =5

[ONCRONONHNONHRUN IS

® Strings, with optional simple formatting, can be stored and retrieved as resources.
(8 app_name (String)

Add. You can add Formatting te your string by using three standard HTML tags: b, i, and
® hello_world (String) u. Ifyouusean apest(ophe ora quoterin your string,you must either escapeitor
® menu_settings (String) Remove... enclose the whole string in the other kind of enclosing quotes.

Name app_name
Value* [EmPubLite
Down

Figure 81: Eclipse String Resources Editor with Details

The app_name name for the resource is fine, as that is how this string is referenced
from the manifest. Change the value to be “EmPub Lite” (adding the space).

Step #2: Changing the Icon

The build tools provide us with a stock icon to use for the launcher — the actual
image used varies by Android tools release. However, we can change it to something
else. For example, we could use the icon portion of the CommonsWare logo:
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Figure 82: CommonsWare

First, download the original image and save it somewhere on your development
machine.

The following sections contain instructions for Android Studio and Eclipse —
choose the instructions appropriate for the IDE you are using for these tutorials.

Android Studio

Click on the app/ entry in the project explorer, then choose File > New... from the
main menu. This should pop up a small window for you to choose something new to
create:
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=T
2 Module
El File
[ Directory
-ﬁi Image Asset
i AIDL b
& Activities >
i Activity >
i Folder b
-ﬁ- Fragment b
W Google I
-ﬁ- Other b
-ﬁ- Senvice r
-ﬁ- Ul Component F
W Widget b
i XML b

Figure 83: Android Studio New Item Dialog

In there, choose “Image Asset”. This will bring up an “Asset Studio” wizard for
creating images:
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> Asset Studio

Asset Type: iLauncher Icons B Preview
Foreground: (¢)image (O clipart ) Text |ﬁ'
Image file: ‘ e-projects/MewandroidModule/root/res/drawable-xhdpific_launcher.png H:|
(] Trim surrounding blank space HEE!
Additional padding: &
Foreground scaling:  (®) crop (O Center 'ﬁ'
Shape: (® None (O Square () Circle HDPI
Background color: | :
Resource name: | ic_launcher | lal
XHDFI
KHXHDPI

Description
A drawable resource named ic_launcher already exists and will be overwritten,

e cencel ] b
Figure 84: Android Studio “Asset Studio” Wizard, First Page

Ensure that the “Asset Type” drop-down is set to “Launcher Icons”, and the
“Foreground” option is set to “Image”. Then, use the “.” button next to the “Image
file” field to choose the image that you downloaded above.

Then, set the “Foreground scaling” to “Center”, leaving you with a wizard page that
should resemble:
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(< Asset Studio

Asset Type: iLauncher lcons B Preview
Foreground: () Image () clipart () Text @
Image file: ‘ ftmp/molecule.png H_|

= MDPI

() Trim surrounding blank space

Additional padding: @ &d
Foreground scaling: () Crop  (®) Center
Shape: (®) Mone () Square () Circle HDPI

Background color:

Resource name: | ic_launcher | &d

XXHDPI

Description
A drawable resource named ic_launcher already exists and will be overwritten,

[Prevecs | [ cancel | [_rep_|
Figure 85: Android Studio “Asset Studio” Wizard, First Page, Filled In

Click “Next” to bring up the second page of the wizard, which is there to confirm
where you want the images written and what images will be created:
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e Asset Studio

Target Module: | Madule: 'app’ B

Res Directaory: Isrcfmainfres

Qutput Directories: Mires

3 drawable-«hdpi

% ic_launcher.png

[ drawable-hdpi

&_o/ ic_launcher.png

[ drawable-mdpi
e}o’ ic_launcher.png

[ drawable-othdpi

Some existing files will be overwritten by this operation. Files which replace existing files are marked red in the preview
above,

s e e
Figure 86: Android Studio “Asset Studio” Wizard, Second Page

Click “Finish”, and your original icons will be replaced with ones based on your
chosen image.

Eclipse

From the Eclipse main menu, choose File > New > Other > Android. In the resulting
dialog, choose “Android Icon Set” and press Next.
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@ Create Asset Set

Choose Icon Set Type

Select the type of icon set to create:

@® Launcher Icons
Action Bar and Tab Icons (Android 3.04)
Notification Icons
Pre-Android 3.0 Tab Icons
Pre-Android 3.0 Menu Icons

Project: | EmPublLite

Icon Name: [ ncher]
Resource: @drawable/ic_launcher Copy Name ko Clipboard
@ <Back | Next> | cancel

Figure 87: Eclipse Icon Set Wizard, First Page

The defaults on the first page of the icon set wizard are to create launcher icons,
with a file base name of ic_launcher, to be added to the EmPubLite project. If the
values that you see in the wizard do not match that, adjust the wizard, then press
Next.
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@ Create Asset Set

Configure Icon Set

Configure the attributes of the icon set

i [per=-0] Preview:
Foreground: |Image || Clipart || Texk| =

Idpi

Text: “aA I

Font: | Arial Bold |

Trim Surrounding Blank Space
Additional Padding:
1 »115%

Foreground Scaling: | Crop | Center |

Shape | None || Squarel, Circle |

Background Color:| - |

Foreground Color: [ NN

@ | ssBack. | Xt cancel | [ Finish |

Figure 88: Eclipse Icon Set Wizard, Second Page

In the second page of the icon set wizard, click the “Image” button in the
“Foreground” row. This will change the wizard slightly, giving you a space to supply
the path to some image:
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@ @ Create Asset Set

Configure Icon Set

@ selectanimage

= Preview:
Foreground: | Image | Clipart | Text

Image File: Browse...

[ Trim Surrounding Blank Space

Additional Padding:
1 +15%

Foreground Scaling: | Crop|| Center

shape MNone || Square | Circle

Background Color: -

(@ <Back Next Cancel Finish

Figure 89: Eclipse Icon Set Wizard, Second Page, Image Mode

Click the “Browse...” button and open the molecule.png file you downloaded above.
That will display the results in the wizard:
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Create Asset Set

Configure Icon Set

Configure the attributes of the icon set

Foreground: | Image || Clipart | Text

Image File: | /tmp/molecule.png | Browse... |

& Trim Surrounding Blank Space

Additional Padding:
1 *'15%

Foreground Scaling: | Crop|| Center

Shape None || Square | Circle

Background Color: |

@) <Back Next Cancel Finish

Figure go: Eclipse Icon Set Wizard, Second Page, Image Mode, Showing Molecule

Click the “None” button in the “Shape” row, to remove the square background. Then,
click Finish. You will be prompted for whether you want to overwrite the existing
images — click “Yes to All”.

You may wind up with a bunch of error markers on your project for all of the new
images in the Package Explorer. If this occurs, choose Project > Clean from the
Eclipse main menu, ensure that EmPublLite is checked in the project list, and choose
OK. This should get rid of those error markers.

Step #3: Running the Result

If you run the resulting app, you will see that it shows up with the new name and
icon, such as in the launcher:
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WIDGETS

API Demos Browser Calculator Calendar

O #

Custom
Locale

Downloads Email EmPub Lite

Gestures Messaging Music

Builder

Search Settings

Figure 91: EmPubLite with New Icons

However, Eclipse users may encounter some problems in running the result. When
you wish to run an Android project from Eclipse, you must pay close attention to
what part of the Eclipse Ul has the focus. The focus cannot be on an editor for a
resource. So, for example, had you gone back to the string resource editor, done
some changes there, then attempted to run the project, nothing would have
happened.

Instead, the focus has to be pretty much anywhere else for the Run option in the
toolbar to work:

* On the manifest
* On some Java code
* On the Package Explorer

This is a bug, one that will hopefully get fixed someday. However, since that
preceding sentence has been in this book for a couple of years, it is unlikely that the
bug will be addressed any time soon.
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In Our Next Episode...

... we will add a progress indicator to the UI of our tutorial project.
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The Theory of Widgets

There is a decent chance that you have already done work with widget-based Ul
frameworks. In that case, much of this chapter will be review, though checking out
the section on the absolute positioning anti-pattern should certainly be worthwhile.

There is a chance, though, that your Ul background has come from places where you
have not been using a traditional widget framework, where either you have been
doing all of the drawing yourself (e.g., game frameworks) or where the Ul is defined
more in the form of a document (e.g., classic Web development). This chapter is
aimed at you, to give you some idea of what we are talking about when discussing
the notion of widgets and containers.

What Are Widgets?

Wikipedia has a nice definition of a widget:

In computer programming, a widget (or control) is an element of a
graphical user interface (GUI) that displays an information arrangement
changeable by the user, such as a window or a text box. The defining
characteristic of a widget is to provide a single interaction point for the
direct manipulation of a given kind of data. In other words, widgets are
basic visual building blocks which, combined in an application, hold all the
data processed by the application and the available interactions on this
data.

(quote from the 7 March 2014 version of the page)

Take, for example, this Android screen:
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Phone-only, unsynced co.. [}
Name
4

Compan
Title
PHONE
Phone E

4
EMAIL

4

ADDRESS

Address

A

Figure 92: A Sample Android Screen

Here, we see:

+ some text, like “Phone-only, unsynced co...” and “PHONE”

* anicon of a contact “Rolodex” card

+ some data entry fields with hints like “Name” and “Company”

+ some “spinner” drop-down lists (the items with the arrowheads pointing
southeast)

+ some gray divider lines

Everything listed above is a widget. The user interface for most Android screens
(“activities”) is made up of one or more widgets.

This does not mean that you cannot do your own drawing. In fact, all the existing
widgets are implemented via low-level drawing routines, which you can use for
everything from your own custom widgets to games.

This also does not mean that you cannot use Web technologies. In fact, we will see

later in this book a widget designed to allow you to embed Web content into an
Android activity.

However, for most non-game applications, your Android user interface will be made
up of several widgets.

144

Licensed solely for use by Qiwen Chen



THE THEORY OF WIDGETS

Size, Margins, and Padding

Widgets have some sort of size, since a zero-pixel-high, zero-pixel-wide widget is not
especially user-friendly. Sometimes, that size will be dictated by what is inside the
widget itself, such as a label (TextView) having a size dictated by the text in the
label. Sometimes, that size will be dictated by the size of whatever holds the widget
(a “container”, described in the next section), where the widget wants to take up all
remaining width and/or height. Sometimes, that size will be a specific set of
dimensions.

Widgets can have margins. As with CSS, margins provide separation between a
widget and anything adjacent to it (e.g., other widgets, edges of the screen). Margins
are really designed to help prevent widgets from running right up next to each other,
so they are visually distinct. Some developers, however, try to use margins as a way
to hack “absolute positioning” into Android, which is an anti-pattern that we will

examine later in this chapter.

Widgets can have padding. As with CSS, padding provides separation between the
contents of a widget and the widget’s edges. This is mostly used with widgets that
have some sort of background, like a button, so that the contents of the widget (e.g.,
button caption) does not run right into the edges of the button, once again for visual
distinction.

What Are Containers?

Containers are ways of organizing multiple widgets into some sort of structure.
Widgets do not naturally line themselves up in some specific pattern — we have to
define that pattern ourselves.

In most GUI toolkits, a container is deemed to have a set of children. Those children
are widgets, or sometimes other containers. Each container has its basic rule for how
it lays out its children on the screen, possibly customized by requests from the
children themselves.

Common container patterns include:

+ put all children in a row, one after the next

+ put all children in a column, one below the next

+ arrange the children into a table or grid with some number of rows and
columns
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+ anchor the children to the sides of the container, according to requests made
by those children

+ anchor the children to other children in the container, according to requests
made by those children

+ stack all children, one on top of the next

+ and so on

In the sample activity above, the dominant pattern is a column, with things laid out
from top to bottom. Some of those things are rows, with contents laid out left to
right. However, as it turns out, the area with most of those widgets is scrollable.

Android supplies a handful of containers, designed to handle most common
scenarios, including everything in the list above. You are also welcome to create your
own custom containers, to implement business rules that are not directly supported
by the existing containers.

Note that containers also have size, padding, and margins, just as widgets do.

The Absolute Positioning Anti-Pattern

You might wonder why all of these containers and such are necessary. After all, can’t
you just say that such-and-so widget goes at this pixel coordinate, and this other
widget goes at that pixel coordinate, and so on?

Many developers have taken that approach — known as absolute positioning — over
the years, to their eventual regret.

For example, many of you may have used Windows apps, back in the 1990’s, where
when you would resize the application window, the app would not really react all
that much. You would expand the window, and the UI would not change, except to
have big empty areas to the right and bottom of the window. This is because the
developers simply said that such-and-so widget goes at this pixel coordinate, and
this other widget goes at that pixel coordinate, regardless of the actual window
size.

In modern Web development, you see this in the debate over fixed versus fluid Web
design. The consensus seems to be that fluid designs are better, though frequently
they are more difficult to set up. Fluid Web designs can better handle differing
browser window sizes, whether those window sizes are because the user resized
their browser window manually, or because those window sizes are dictated by the
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screen resolution of the device viewing the Web page. Fixed Web designs —
effectively saying that such-and-so element goes at such-and-so pixel coordinate and
so on — tend to be easier to build but adapt more poorly to differing browser
window sizes.

In mobile, particularly with Android, we have a wide range of possible screen
resolutions, from QVGA (320x240) to beyond 1080p (1920x1080), and many values in
between. Moreover, any device manufacturer is welcome to create a device with
whatever resolution they so desire — there are no rules limiting manufacturers to
certain resolutions. Hence, as developers, having the Android equivalent of fluid
Web designs is critical, and the way you will accomplish that is by sensible use of
containers, avoiding absolute positioning. The containers (and, to a lesser extent,
the widgets) will determine how extra space is employed, as the screens get larger
and larger.

The Theme of This Section: Themes

In Web development, we have had stylesheets for quite a while. Through such
Cascading Style Sheets (CSS) files, we can stipulate various rules about how our Web
pages should look. This includes:

+ Establishing a default look for certain HTML tags by tag name (e.g., setting
the font and size for all <h1> and <h2> elements)

+ Establishing a look for specific HTML elements by class or ID (e.g., setting
the width of a specific <div> to a certain number of CSS pixels)

In Android, the equivalent concepts can be found in styles and themes. Styles are a
collection of values for properties (e.g., have a foreground color of red). These can be
applied to specific widgets (e.g., this label should adopt this style), or they can be
employed by “themes” that provide the default look for all sorts of widgets and other
elements of our Ul

Of course, you do not have to declare any theme for your app. Android will give you
a default look-and-feel without any specific theme. That look-and-feel has varied
over the years, though, affecting the visual fundamentals of various Android
widgets. These themes have names by which we refer to them: Theme, Theme .Holo,
and Theme.Material.
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In the Beginning, There Was “Theme”, And It Was Meh
Way back in Android 1.0, the default theme was known simply as Theme. Technically,
all themes inherit from Theme, much as how later CSS stylesheets effectively “inherit”

the settings established by prior stylesheets.

The Theme Ul had a particular look to it:

Dl O 11:54em

Figure 93: Labels, Fields, and Buttons in Theme

For example:

* At the top of the screen, we had a thin gray “title bar” with the name of our
app

* The focused field (an EditText widget) had a bright orange outline, whereas
normally it was a plain white rectangle

+ The buttons (“OK” and “Cancel”) were... well... buttons

Holo, There!

Android 3.0 (API Level 1) introduced a new default theme, Theme .Holo, with the so-
called “holographic widget theme”. This changed the look of our Ul somewhat:
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*%’ RelativeLayoutDemo

Cancel OK

Figure 94: Labels, Fields, and Buttons in Theme.Holo

Now:

At the top of the screen, we have an “action bar”, containing our app’s logo
and name

*+ The focused field has a blue “underbracket”, whereas normally it is gray

* The buttons are styled slightly differently, with a bigger font, alternative
backgrounds, etc.

Considering the Material

Android 5.0 changed the default theme yet again, to Theme.Material:
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RelativeLayoutDemo

URL: |

CANCEL

Figure 95: Labels, Fields, and Buttons in Theme.Material

Now:

* The action bar at the top of the screen no longer shows the app icon

* Our field is indicated by an underline, which is teal when focused or gray
when unfocused

* The buttons are now forced into all-caps font, with a slightly smaller font
size and subtly different background than we had with Theme.Holo

Doing More with Themes

Of course, we can do a lot more than just use these. There are other stock themes,
with different characteristics. Furthermore, we can customize the themes, by
defining our own (inheriting from a stock theme) and changing some of the
properties (e.g., replacing the teal color with something else).

We will get much more into creating custom styles and themes later in the book.

However, we will see the effects of Theme, Theme.Holo, and Theme.Material on stock
widgets in an upcoming chapter.
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The project you created in an earlier tutorial was just the default files generated by
the Android build tools — you did not write any Java code yourself. In this chapter,
we will examine the basic Java code and resources that make up an Android activity.

The Activity

The Java source code that you maintain will be in a standard Java-style tree of
directories based upon the Java package you chose when you created the project
(e.g., com.commonsware.android results in com/commonsware/android/). Where
those files reside depends upon what tools you are using:

*+ Android Studio will have that source, by default, in app/src/main/java/ off
of the top-level project root
+ Eclipse will have that source be in src/ off of the top-level project root

If you checked the checkbox in your IDE’s new-project wizard to create an activity,
you will have, in the innermost directory, a Java source file representing an activity
class.

A very simple activity looks like:

package com.commonsware.empublite;

import android.app.Activity;
import android.os.Bundle;

public class EmPubLiteActivity extends Activity {
@Override
protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
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setContentView(R.layout.main);
}
}

Dissecting the Activity

Let’s examine this Java code piece by piece:

package com.commonsware.empublite;

import android.app.Activity;
import android.os.Bundle;

By default, the package declaration is the same as the one you used when creating
the project. And, like any other Java project, you need to import any classes you
reference. Most of the Android-specific classes are in the android package.

Remember that not every Java SE class is available to Android programs! Visit the
Android class reference to see what is and is not available.

public class EmPubLiteActivity extends Activity {

Activities are public classes, inheriting from the android.app.Activity base class
(or, possibly, from some other class that itself inherits from Activity). You can have
whatever data members you decide that you need, though the initial code has none.

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.main);

}

The onCreate() method is invoked when the activity is started. We will discuss the
Bundle parameter to onCreate() in a later chapter. For the moment, consider it an
opaque handle that all activities receive upon creation.

The first thing you normally should do in onCreate() is chain upward to the
superclass, so the stock Android activity initialization can be done. The only other
statement in our stub project’s onCreate() is a call to setContentView(). This is
where we tell Android what the user interface is supposed to be for our activity.

This raises the question: what does R.layout.main mean? Where did this R come
from?
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To explain that, we need to start thinking about layout resources and how resources
are referenced from within Java code.

Using XML-Based Layouts

As noted in the previous chapter, Android uses a series of widgets and containers to
describe your typical user interface. These all inherit from an android.view.View
base class, for things that can be rendered into a standard widget-based activity.

While it is technically possible to create and attach widgets and containers to our
activity purely through Java code, the more common approach is to use an XML-
based layout file. Dynamic instantiation of widgets is reserved for more complicated
scenarios, where the widgets are not known at compile-time (e.g., populating a
column of radio buttons based on data retrieved off the Internet).

With that in mind, it’s time to break out the XML and learn how to lay out Android
activity contents that way.

What Is an XML-Based Layout?

As the name suggests, an XML-based layout is a specification of its widgets’
relationships to each other — and to containers — encoded in XML format.
Specifically, Android considers XML-based layouts to be resources, and as such
layout files are stored in the res/layout/ directory inside your Android project (or,
as we will see later, other layout resource sets, like res/layout-1land/ for layouts to
use when the device is held in landscape). As has been noted elsewhere in this book,
the location of res/ is either in the project root for Eclipse or in app/src/main/ for
Android Studio.

Each XML file contains a tree of elements specifying a layout of widgets and
containers that make up one View. The attributes of the XML elements are
properties, describing how a widget should look or how a container should behave.
For example, if a Button element has an attribute value of android: textStyle =
"bold", that means that the text appearing on the face of the button should be
rendered in a boldface font style.

For example, here is a res/layout/main.xml file that could be used with the
aforementioned activity:

<Relativelayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"

153

Licensed solely for use by Qiwen Chen



THE ANDROID USER INTERFACE

android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context=".EmPubLiteActivity">

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_centerHorizontal="true"
android:layout_centerVertical="true"
android:text="@string/hello_world"/>

</RelativelLayout>

The class name of a widget or container — such as Relativelayout or TextView —
forms the name of the XML element. Since TextView is an Android-supplied widget,
we can just use the bare class name. If you create your own widgets as subclasses of
android.view.View, you would need to provide a full package declaration as well
(e.g., com.commonsware.android.MyWidget).

The root element needs to declare the Android XML namespace
(xmlns:android="http://schemas.android.com/apk/res/android"). All other
elements will be children of the root and will inherit that namespace declaration.

The attributes are properties of the widget or container, describing what it should
look and work like. For example, the android:layout_centerHorizontal="true"
attribute on the TextView element indicates that the TextView should be centered
within its RelativelLayout parent.

We will get into details about these attributes, their possible values, and their uses,
in upcoming chapters. Note that those attributes in the tools namespace (e.g.,
tools:context) are there solely to support the Android build tools, and do not
affect the runtime execution of your project.

Android’s SDK ships with a tool (aapt) which uses the layouts. This tool will be
automatically invoked by your Android tool chain (e.g., Android Studio, Eclipse). Of
particular importance to you as a developer is that aapt generates an R. java source
file, allowing you to access layouts and widgets within those layouts directly from
your Java code. In other words, this is where that magic R value used in
setContentView() comes from. We will discuss that a bit more later in this chapter.
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XML Layouts and Your IDE
If you are using Android Studio or Eclipse, and you double-click on the res/layout/
main.xml file in your project, you will not initially see that XML. Instead, you will be

taken to the graphical layout editor:

@ activity_mainxml * ‘

Palette 0 [L- MNewsd- (- @appTheme | ™ Mainactivity~ @+ §i21- | Component Tree IE %
£ Layouts &l- Bl @ QB¢ #v §DeviceScreen
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[MLinearLayout (Ho

EllinearLayout (Ve

[l TableLayout
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1 Widgets
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Medium Text

TextView - @string/hello_wor
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[e6l Small Text layout:height match parent
o Button style
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® RadioButton alpha
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o Switch backgroundTint

~ ToggleButton backgroundTinte

H ImageButton clickable O
& ImageView contentDescripti
== ProgressBar (Lar elevation
== ProgressBar (Mol

Focusable ]
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Figure 96: Android Studio Graphical Layout Editor
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Figure 97: Eclipse Graphical Layout Editor

A sub-tab (e.g., “Text” on Android Studio) will show you the raw XML. The default
“Design” or “Graphical Layout” sub-tab, though, shows you a preview of what your
layout would look like, if it were to be used for an activity. The “Palette” on the left
shows all sorts of widgets and containers, which you can drag into the preview area
to add an instance of your chosen widget or container to your layout. Right-clicking
over a widget or container will give you an extensive context menu to configure the
item, and the toolbar immediately above the preview area will let you configure
common properties of a selected widget or container.

We will go into much more detail about using the graphical layout editor in an
upcoming chapter, as we start to work more with specific widgets and containers.

Why Use XML-Based Layouts?

Almost everything you do using XML layout files can be achieved through Java code.
For example, you could use setText() to have a button display a certain caption,
instead of using a property in an XML layout. Since XML layouts are yet another file
for you to keep track of, we need good reasons for using such files.
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Perhaps the biggest reason is to assist in the creation of tools for view definition,
such as the aforementioned graphical layout editors in Android Studio and Eclipse.
Such GUI builders could, in principle, generate Java code instead of XML. The
challenge is re-reading the definition in to support edits — that is far simpler if the
data is in a structured format like XML than in a programming language. Moreover,
keeping the generated bits separated out from hand-written code makes it less likely
that somebody’s custom-crafted source will get clobbered by accident when the
generated bits get re-generated. XML forms a nice middle ground between
something that is easy for tool-writers to use and easy for programmers to work with
by hand as needed.

Also, XML as a GUI definition format is becoming more commonplace. Microsoft’s
XAML, Adobe’s Flex, Google’s GWT, and Mozilla’s XUL all take a similar approach to
that of Android: put layout details in an XML file and put programming smarts in
source files (e.g., JavaScript for XUL). Many less-well-known GUI frameworks, such
as ZK, also use XML for view definition. While “following the herd” is not necessarily
the best policy, it does have the advantage of helping to ease the transition into
Android from any other XML-centered view description language.

Using Layouts from Java

Given that you have painstakingly set up the widgets and containers for your view in
an XML layout file named main.xml stored in res/layout/, all you need is one
statement in your activity’s onCreate() callback to use that layout, as we saw in our
stub project’s activity:

setContentView(R. layout.main);

Here, R. layout.main tells Android to load in the layout (1ayout) resource (R) named
main.xml (main).
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Basic Widgets

Every GUI toolkit has some basic widgets: fields, labels, buttons, etc. Android’s
toolkit is no different in scope, and the basic widgets will provide a good
introduction as to how widgets work in Android activities. We will examine a
number of these in this chapter.

Common Concepts

There are a few core features of widgets that we need to discuss at the outset, before
we dive into details on specific types of widgets.

Widgets and Attributes

As mentioned in a previous chapter, widgets have attributes that describe how they
should behave. In an XML layout file, these are literally XML attributes on the
widget’s element in the file. Usually, there are corresponding getter and setter
methods for manipulating this attribute at runtime from your Java code.

If you visit the JavaDocs for a widget, such as the JavaDocs for TextView, you will see
an “XML Attributes” table near the top. This lists all of the attributes defined
uniquely on this class, and the “Inherited XML Attributes” table that follows lists all
those that the widget inherits from superclasses, such as View. Of course, the
JavaDocs also list the fields, constants, constructors, and public/protected methods
that you can use on the widget itself.

Those attributes can be modified by a “Properties” view in the graphical layout
editor of the IDE:
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Figure 98: Properties View in Android Studio Graphical Layout Editor
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Figure 99: Properties View in Eclipse Graphical Layout Editor

This book does not attempt to explain each and every attribute on each and every
widget. We will, however, cover the most popular widgets and the most commonly-
used attributes on those widgets.
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Referencing Widgets By ID

Many widgets and containers only need to appear in the XML layout file and do not
need to be referenced in your Java code. For example, a static label (TextView)
frequently only needs to be in the layout file to indicate where it should appear.

Anything you do want to use in your Java source, though, needs an android: id.

The convention is to use @+id/ . .. as the id value, where the . .. represents your
locally-unique name for the widget in question, for the first occurrence of a given id
value in your layout file. The second and subsequent occurrences in the same layout
file should drop the + sign.

Android provides a few special android: id values, of the form @android:id/... —
we will see some of these in various chapters of this book.

To access our identified widgets, use findviewById(), passing it the numeric
identifier of the widget in question. That numeric identifier was generated by
Android in the R class as R.1id.something (where something is the specific widget
you are seeking).

This concept will become important as we try to attach listeners to our widgets (e.g.,
finding out when a checkbox is checked) or when we try referencing widgets from
other widgets in a layout XML file (e.g., with RelativelLayout). All of this will be
covered later in this chapter.

Size

Most of the time, we need to tell Android how big we want our widgets to be.
Occasionally, this will be handled for us — we will see an example of that with
TablelLayout in an upcoming chapter. But generally we need to provide this
information ourselves.

To do that, you need to supply android:layout_width and android:layout_height
attributes on your widgets in the XML layout file. These attributes’ values have three
flavors:

1. You can provide a specific dimension, such as 125dip to indicate the widget
should take up exactly a certain size (here, 125 density-independent pixels)
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2. You can provide wrap_content, which means the widget should take up as
much room as its contents require (e.g., a TextView label widget’s content is
the text to be displayed)

3. You can provide match_parent, which means the widget should fill up all
remaining available space in its enclosing container

The latter two flavors are the most common, as they are independent of screen size,
allowing Android to adjust your view to fit the available space.

Note that you will also see fill_parent. This is an older synonym for match_parent.
match_parent is the recommended value going forward, but fill_parent will
certainly work.

This chapter focuses on individual widgets. Size becomes much more important
when we start combining multiple widgets on the screen at once, and so we will be
spending more time on sizing scenarios in later chapters.

The layout_ prefix on these attributes means that these attributes represent
requests by the widget to its enclosing container. Whether those requests will be
truly honored will depend a bit on what other widgets there are in the container and
what their requests are.

Assigning Labels

The simplest widget is the label, referred to in Android as a TextView. Like in most
GUI toolkits, labels are bits of text not editable directly by users. Typically, they are
used to identify adjacent widgets (e.g., a “Name:” label before a field where one fills
in a name).

In Java, you can create a label by creating a TextView instance. More commonly,
though, you will create labels in XML layout files by adding a TextView element to
the layout, with an android: text property to set the value of the label itself. If you
need to swap labels based on certain criteria, such as internationalization, you may
wish to use a string resource reference in android: text instead (e.g., @string/
label).

For example, in our last tutorial, we still are using the automatically-generated res/
layout/main.xml file, containing, among other things, a TextView:

<Relativelayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"
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android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context=".EmPubLiteActivity">

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_centerHorizontal="true"
android:layout_centerVertical="true"
android:text="@string/hello_world"/>

</RelativelLayout>

Android Studio Graphical Layout Editor

The TextView widget is available in the “Widgets” category of the Palette in the
Android Studio graphical layout editor:
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Figure 100: Palette, “Plain TextView” in Widgets Category

The “Large Text”, “Medium Text”, and “Small Text” items beneath “Plain TextView”
are also TextView widgets, with different default font sizes.

You can drag that TextView from the palette into a layout file in the main editing
area to add the widget to the layout. Or, drag it over the top of some container you
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see in the Component Tree pane of the editor to add it as a child of that specific
container:

Compaonent Tree T = #%-

[ pevice Screen

RelativeLayout
| TextView - @string/hello_world

Figure 101: Component Tree Pane

Clicking on the resulting TextView in the Component Tree pane, or in the preview
area, will set up the Properties pane with the various attributes of the widget, ready
for you to change as needed:
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Figure 102: Properties Pane, for a TextView Inside a RelativeLayout

Editing the Text

The “Text” property will allow you to choose or define a string resource to serve as
the text to be displayed:
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Figure 103: Properties Pane, with TextView “text” Property Selected

Clicking on the value will allow the property to be edited:
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translationZ
typeface
viewName

visibility

Figure 104: Properties Pane, with TextView “text” Property Editable

You can either type a literal string right in the Properties pane row, or you can click
the “.” button to the right of the field to pick a string resource:
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o Resources

Project | system |
[ string
B action_settings
F app_name

(¢ ] hello_waorld

Hello world!

¥ New Resource | | Cancel

Figure 105: String Resources Dialog

You can highlight one of those resources and click “OK” to use it. Or, in the bottom
of that dialog, there is a “New Resource” drop-down. When viewing string resources,
that drop-down will contain a single command: “New String Value...”. Choosing it
will allow you to define a new string resource via another dialog:
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e New String Value Resource

Resource name: |

Resource value! |

Source set: |main n

File name: |strings.xml

Create the resource in directories:

™ values +
O values-w820dp

‘ Cancel |

Figure 106: New String Resource Dialog

You can give your new string resource a name, the actual text of the string itself, the
filename in which the string resource should reside (strings.xml by default), and
which values/ directory the string should go into (values by default). You will also
choose the “source set” — for now, that will just be main. Once you accept the dialog,
your new string resource will be applied to your TextView.

Editing the ID

The “id” property will allow you to change the android:id value of the widget:
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Properties ?7 Y
ellipsize
enabled O
focusable O
focusablelinTouchMod ]
fantFamily
gravity [
height
hint
I T
importantForaccessit
inputMethod
inputType [l
labelFor
lines
linksClickable O
longClickable O
maxHeight

Figure 107: Properties Pane, with TextView “id” Property Selected
The value you fill in here is what goes after the @+id/ portion (e.g., textView2).

Eclipse Graphical Layout Editor

The TextView widget is available in the “Form Widgets” portion of the Palette in the
Eclipse graphical layout editor:
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1 Palette
% Palette =

= Form Widgets
tentvize: | @rge Medium small | Butlon

Small QOFF ¥ [heckBing

®  RadinButtnn Chacked TextView

Spinner

g %

Figure 108: Form Widgets Palette, TextView in Upper Left

You can drag that TextView from the palette into a layout file in the main editing
area to add the widget to the layout. Or, drag it over the top of some container you
see in the Outline pane of the editor to add it as a child of that specific container:

Structure 4
g outline
v [ RelativeLayout
ot TextView - "Hello world!"

Figure 109: Outline Pane
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Clicking on the resulting TextView in the Outline pane, or in the preview area, will
set up the Properties pane with the various attributes of the widget, ready for you to
change as needed:

= Properties LS =
L]
= Layout Paramet... []
To Left OF
To Right OF
Above
Below
Align Baseline
Align Left
Align Top
Align Right
Align Bottom
Align Parent Left|[[]
Align Parent Top |[F]
Align ParentRi... |[E]
Align Parent B... [
Center In Parent [
Center Horizon...|[¥ltrue
Center Vertical |[F]true
Align WithPar... [
width wrap_conkent
Height wrap_content
& Margins [
Text @string/hello_world (Hell... (=]
Hint
Text Color
Text Appearance ?android:attr/textAppeara...[=]
Text Size
Content Descri...
= TextView [
Text @string/hello_world (Hell... [=
Hint
Text Color )
Text Color Hint |M®android:color/hint_for... [

Text Appearance 7android:attr/textAppeara...[=
Tavk Ciza Bl =

Figure 110: Properties Pane, for a TextView Inside a RelativeLayout

Editing the Text

The “Text” property will allow you to choose or define a string resource to serve as
the text to be displayed. By default, it brings up a list of existing string resources:
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 Resource Chooser

Choose a string resource

@ Project Resources

System Resources

l

app_name
hello

New String...
@ | Clear Cancel | | oK |

Figure 111: String Resource Chooser

You can highlight one of those resources and click “OK” to use it, or you can click
the “New String..” button to define a brand-new string resource.

Editing the ID

The “Id” property will allow you to change the android: id value of the widget. Be
sure to include the @+id/ prefix, as Android will not add that automatically for you.

Notable TextView Attributes
TextView has numerous other attributes of relevance for labels, such as:

1. android:typeface to set the typeface to use for the label (e.g., monospace)

2. android:textStyle to indicate that the typeface should be made bold
(bold), italic (italic), or bold and italic (bold_italic)

3. android:textColor to set the color of the label’s text, in RGB hex format

(e.g., #FF0000 for red) or ARGB hex format (e.g., #88FF0000 for a translucent
red)

These attributes, like most others, can be modified through the Properties pane.
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For example, in the Basic/Label sample project, you will find the following layout
file:

<?xml version="1.0" encoding="utf-8"?>

<TextView xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:text="@string/profound"
/>

Just that layout alone, with the stub Java source provided by Android’s project
builder (e.g., android create project) and appropriate string resources, gives you:

*@" LabelDemo

rething profound?

Figure 112: The LabelDemo Sample Application

A Commanding Button

Android has a Button widget, which is your classic push-button “click me and
something cool will happen” widget. As it turns out, Button is a subclass of
TextView, so everything discussed in the preceding section in terms of formatting
the face of the button still holds.

For example, in the Basic/Button sample project, you will find the following layout
file:
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<?xml version="1.0" encoding="utf-8"?>

<LinearlLayout xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:orientation="vertical">

<Button
android:id="@+id/button1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="@string/button"/>

</LinearlLayout>

Just that layout alone, with the stub Java source provided by Android’s project
builder (e.g., android create project) and appropriate string resources, gives you:

Figure 113: Button Widget, in Theme
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*@’ ButtonDemo

Button

Figure 114: Button Widget, in Theme.Holo

ButtonDemo

BUTTON

Figure 115: Button Widget, in Theme.Material
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Android Studio Graphical Layout Editor

As with the TextVview widget, the Button widget is available in the “Widgets” portion
of the Palette in the Android Studio graphical layout editor:

Palette o
[H Relativelayout
Widgets
|86 Plain Textview
[Bb] Large Text
(86| Medium Text
[8t] Small Text
Small Button
@) RadioButton
[#]checkBox
1 Switch
- ToggleButton
E ImageButton
& Image\iew
= ProgressBar (Large)
= ProgressBar (Normal]
= ProgressBar (Small)
= ProgressBar (Horizom
o1 5eekBar
# RatingBar
Spinner
D WebView
Text Fields
Plain Text
Person Name
Password
Password (Numeric)
E-mail
Phone
Postal Address
Multiline Text
Time
Date
Mumber
Mumber (Signed)
Number (Decimal)
Containers
- |RadioGroup
= ListView
T Gridview
Z= Expandablelistview

Figure 116: Widgets Palette, Button Shown Highlighted

You can drag that Button from the palette into a layout file in the main editing area
to add the widget to the layout. The Properties pane will then let you adjust the
various attributes of this Button. Since Button inherits from TextView, most of the
options are the same (e.g., “Text”).

Eclipse Graphical Layout Editor

As with the TextView widget, the Button widget is available in the “Form Widgets”
portion of the Palette in the Eclipse graphical layout editor:

175

Licensed solely for use by Qiwen Chen



BAsic WIDGETS

1 Palette

> Palette -
= Form Widgets

tessviz Large Medium small  Butlon
Small aOFF w CheckBng

®  RadinButtnn Chacked TextView

Spinner

-
b
oer

Figure 117: Form Widgets Palette, Button in Upper Right

You can drag that Button from the palette into a layout file in the main editing area
to add the widget to the layout. The Properties pane will then let you adjust the
various attributes of this Button. Since Button inherits from TextView, most of the
options are the same (e.g., “Text”).

Tracking Button Clicks

Buttons are command widgets — when the user presses a button, they expect
something to happen.

To define what happens when you click a Button, you can:

1. Define some method on your Activity that holds the button that takes a
single View parameter, has a void return value, and is public

2. In your layout XML, on the Button element, include the android:onClick
attribute with the name of the method you defined in the previous step

For example, we might have a method on our Activity that looks like:

public void someMethod(View theButton) {
// do something useful here
}
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Then, we could use this XML declaration for the Button itself, including
android:onClick:

<Button
android:onClick="someMethod"

/>

This is enough for Android to “wire together” the Button with the click handler.
When the user clicks the button, someMethod() will be called.

Another approach is to skip android:onClick, instead calling

setOnClickListener () on the Button object in Java code. When a Button is used
directly by an activity, this is not typically used — android:onClick is a bit cleaner.
However, when we start to talk about fragments, you will see that android:onClick
does not work that well with fragments, and so we will use setOnClickListener() at
that point.

Fleeting Images

Android has two widgets to help you embed images in your activities: ImageView and
ImageButton. As the names suggest, they are image-based analogues to TextView
and Button, respectively.

Each widget takes an android:src attribute (in an XML layout) to specify what
picture to use. These usually reference a drawable resource (e.g., @drawable/icon).

ImageButton, a subclass of ImageView, mixes in the standard Button behaviors, for
responding to clicks and whatnot.

For example, take a peek at the main.xml layout from the Basic/ImageView sample
project:

<?xml version="1.0" encoding="utf-8"?>

<ImageView xmlns:android="http://schemas.android.com/apk/res/android"
android:id="@+id/icon"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:adjustViewBounds="true"
android:src="@drawable/molecule"/>

The result, just using the code-generated activity, is simply the image:
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*#" ImageViewDemo

Figure 118: The ImageViewDemo sample application

Android Studio Graphical Layout Editor

The ImageView widget can be found in the “Widgets” portion of the Palette in the
Android Studio Graphical Layout editor:
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palette Foa
|HIRelativelayout
widgets
4] Plain Textview
[Bb] Large Test
26 Medium Text
[Be] Small Text
o Button
2% Small Button
@ RadioButton
[ Checkeox
o Switch
- ToggleButton
M ImageButton
= ProgressBar (Large)
= ProgressBar (Normal;
= ProgressBar (Small)
= ProgressBar (Horizom
o1 SeekBar
# RatingBar
Spinner
D WebView
Text Fields
Plain Text
Person Mame
[ |Password
Password (Numeric)
E-mail
Phone
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Multiline Text
Time
Date
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Mumber (Decimal)
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[Z1RadioGroup
= Listview
[ Gridview
= ExpandableListview

Figure 119: Widgets Palette, ImageView Shown Highlighted

ImageButton appears alongside ImageView in that tool palette.

You can drag these into a layout file, then use the Properties pane to set their
attributes. Like all widgets, you will have an “id” option to set the android: id value
for the widget. Two others of importance, though, are more unique to ImageView
and ImageButton:

+ “src” allows you to choose a drawable resource to use as the image to be
displayed

+ “scaleType” opens a drop-down menu where you can choose how the image
is to be scaled:

| src =unset=
q matrix
statelistAnimator oo
textalignment fitStart
e fitCenter
fitEnd
center
Evel] centerCrop

Figure 120: Scale Types in Android Studio Properties Pane
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We will examine those scale types more later in this chapter.

Eclipse Graphical Layout Editor

The ImageView widget can be found in the “Images & Media” portion of the Palette
in the Graphical Layout editor:

= Images & Media
ImageView
(| ImageButton
1 Gallery
(»| MediaController
3 videoview
Figure 121: Images & Media Widgets Palette, ImageView in Upper Left

The ImageButton widget is adjacent to the ImageView widget in the Palette.

You can drag these into a layout file, then use the Properties pane to set their
attributes. Like all widgets, you will have an “Id” option to set the android:id value
for the widget. Two others of importance, though, are more unique to ImageView
and ImageButton:

+ “Src” allows you to choose a drawable resource to use as the image to be
displayed

*+ “Scale Type” opens a drop-down menu where you can choose how the image
is to be scaled:
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=
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1

]
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Figure 122: Scale Types in Eclipse Properties Pane
We will examine those scale types more in the next section.

Scaling Images

It is possible, perhaps even probable, that our ImageView size will not exactly match
the size of the images that we are trying to display. ImageView supports a variety of
“scale types” that indicate how Android should try to deal with the discrepancy

between the size/aspect ratio of the image and the size/aspect ratio of the ImageView
itself.

These values can be seen in the JavaDocs in the ImageView.ScaleType class. The
default (“fitCenter”) simply scales up the image to best fit the available space.

Of note, a choice of “center” will center the image in the available space but will not
scale up the image:
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*%" ImageViewDemo

Figure 123: The ImageViewDemo Sample, Set to center

A choice of “centerCrop” will scale the image so that its shortest dimension fills the
available space and crops the rest:
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*3” ImageViewDemo

Figure 124: The ImageViewDemo Sample, Set to centerCrop

A choice of “fitXY” will scale the image to fill the space, ignoring the aspect ratio:
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*%” ImageViewDemo

Figure 125: The ImageViewDemo Sample, Set to fitXY

Fields of Green. Or Other Colors.

Along with buttons and labels, fields are the third “anchor” of most GUI toolkits. In
Android, they are implemented via the EditText widget, which is a subclass of the
TextView used for labels.

Along with the standard TextView attributes (e.g., android: textStyle), EditText
has others that will be useful for you in constructing fields, notably
android:inputType, to describe what sort of input your EditText expects (numbers?
email addresses? phone numbers?). A thorough explanation of android: inputType
and its interaction with input method editors (a.k.a., “soft keyboards”) will be
discussed in an upcoming chapter.

For example, from the Basic/Field sample project, here is an XML layout file
showing an EditText:

<?xml version="1.0" encoding="utf-8"?>

<EditText xmlns:android="http://schemas.android.com/apk/res/android"
android:id="@+id/field"
android:layout_width="match_parent"
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android:layout_height="match_parent"
android:inputType="textMultiLine"
android:text="@string/license"

/>

Note that we have android:inputType="textMultiLine", so users will be able to
enter in several lines of text. We also have defined the initial text to be the value of a

license string resource.

The result, once built and installed into the emulator, is:

|Licensed under the Apache License,
Version 2.0 (the "License"); you may
not use this file exceptin
compliance with the License. You
may obtain a copy of the License at
http://www.apache.org/licenses/
LICENSE-2.0

| — — _—

Figure 126: FieldDemo, in Theme
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*3" FieldDemo

Licensed under the Apache License,
Version 2.0 (the "License"); you may

not use this file except in
compliance with the License. You
may obtain a copy of the License at
http://www.apache.org/licenses/
LICENSE-2.0

Figure 127: FieldDemo, in Theme.Holo

FieldDemo

Licensed under the Apache License,
Version 2.0 (the "License"); you may

not use this file except in compliance
with the License. You may obtain a
copy of the License at http:/
www.apache.org/licenses/
LICENSE-2.0

Figure 128: FieldDemo, in Theme.Material
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Android Studio Graphical Layout Editor

The Android Studio Graphical Layout’s Palette has a whole section dedicated
primarily to EditText widgets, named “Text Fields™

Text Fields

| Plain Text
Person Mame
Passwaord
Password (Mumeric)
E-mail
Phone
Postal Address
Multiline Text
Time
Date
Mumber
Mumber (Signed)
Mumber (Decimal)

Figure 129: Text Fields Palette

The first entry is a general-purpose EditText. The rest come pre-configured for
various scenarios, such as a person’s name or a password.

You can drag any of these into your layout, then use the Properties pane to configure

relevant attributes. The “Id” and “Text” attributes are the same as found on
TextView, as are many other properties, as EditText inherits from TextView.

Eclipse Graphical Layout Editor

The Graphical Layout’s Palette has a whole section dedicated primarily to EditText
widgets, named “Text Fields™
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= Text Fields

I | Plain Text

L Person Name

I~ | Password

[L | Password (Numeric)

I | E-mail X! Phone

I | Postal Address

[T ] Multiline Text X! Time
i1 | Date [I| Number

I | Number (Signed)

I | Number (Decimal)

|z | AutoCompleteTextView
a:| MultiAutoCompleteText

Figure 130: Text Fields Palette

The first entry is a general-purpose EditText. The rest come pre-configured for
various scenarios, such as a person’s name or a postal address.

You can drag any of these into your layout, then use the Properties pane to configure
relevant attributes. The “Id” and “Text” attributes are the same as found on
TextView, as are many other properties, as EditText inherits from TextView.

Notable EditText Attributes

The “Hint” item in the Properties pane allows you to set a “hint” for this EditText.
The “hint” text will be shown in light gray in the EditText widget when the user has
not entered anything yet. Once the user starts typing into the EditText, the “hint”
vanishes. This might allow you to save on screen space, replacing a separate label
TextView.

The “Input Type” item in the Properties pane allows you to describe what sort of
input you are expecting to receive in this EditText, lining up with many of the types
of fields you can drag from the Palette into the layout:
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none O
text (]
textCapCharacter (]

textCapWords O
textCapSentence: ]
textAutoCorrect [
textAutoComplete (]
textMultiLine O
textimeMultiline [
textMoSuggestion [
textUri O
textEmailaddress [
textEmailsubject [J
textShortMessage [
textLongMessage [J
textPersonMame [
textPostaladdress [
textPassword (]
textvisiblePasswo [
textWebEditText [
textFilter O
textPhonetic (]
textWebEmailadd []
textWebPassword []
number O
numbersigned  [J
numberDecimal  []
numberPassword [
phone (]

Figure 131: Android Studio’s Text Fields InputType Drop-Down

€ select Flag Values

text
textCapCharacters
textCapWords
textCapSentences
textAutoCorrect
textAutoComplete
® textMultiLine
textimeMultiLine
textNoSuggestions
textUri
textEmailAddress

Cancel | | 0K J

Figure 132: Eclipse’s Text Fields InputType Dialog

The inputType attribute will be covered in greater detail in an upcoming chapter.
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More Common Concepts

All widgets, including the ones shown above, extend View. The View base class gives
all widgets an array of useful attributes and methods beyond those already

described.

Padding

Widgets have a minimum size, one that may be influenced by what is inside of
them. So, for example, a Button will expand to accommodate the size of its caption.
You can control this size using padding. Adding padding will increase the space
between the contents (e.g., the caption of a Button) and the edges of the widget.

Padding can be set once in XML for all four sides (android:padding) or on a per-
side basis (android:paddingLeft, etc.). Padding can also be set in Java via the
setPadding() method.

The value of any of these is a dimension — a combination of a unit of measure and a
count. So, 10dip is 10 density-independent pixels, 2mm is 2 millimeters, etc.

Margins

By default, widgets are tightly packed, one next to the other. You can control this via
the use of margins, a concept that is reminiscent of the padding described
previously.

The difference between padding and margins comes in terms of the background. For
widgets with a transparent background — like the default look of a Textview —
padding and margins have similar visual effect, increasing the space between the
widget and adjacent widgets. However, for widgets with a non-transparent
background — like a Button — padding is considered inside the background while
margins are outside. In other words, adding padding will increase the space between
the contents (e.g., the caption of a Button) and the edges, while adding margin
increases the empty space between the edges and adjacent widgets.

Margins can be set in XML, either on a per-side basis (e.g.,
android:layout_marginTop) or on all sides via android:layout_margin. Once again,
the value of any of these is a dimension — a combination of a unit of measure and a
count, such as 5dp for 5 density-independent pixels.
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Colors

There are two types of color attributes in Android widgets. Some, like
android:background, take a single color (or a drawable to serve as the background).
Others, like android: textColor on TextView (and subclasses) can take a
ColorStatelist, including via the Java setter (in this case, setTextColor()).

A ColorStateList allows you to specify different colors for different conditions. For
example, when you get to selection widgets in an upcoming chapter, you will see
how a TextView has a different text color when it is the selected item in a list
compared to when it is in the list but not selected. This is handled via the default
ColorStatelList associated with TextView.

If you wish to change the color of a TextView widget in Java code, you have two main
choices:

« Use ColorStatelList.valueOf(), which returns a ColorStatelList in which
all states are considered to have the same color, which you supply as the
parameter to the valueOf() method. This is the Java equivalent of the
android: textColor approach, to make the TextView always be a specific
color regardless of circumstances.

* Create a ColorStatelList with different values for different states, either via
the constructor or via an XML drawable resource. This will be covered much
later in the book.

Other Useful Attributes

Some additional attributes on View most likely to be used include:

1. android:visibility, which controls whether the widget is initially visible

2. android:nextFocusDown, android:nextFocusLeft,
android:nextFocusRight, and android:nextFocusUp, which control the
focus order if the user uses the D-pad, trackball, or similar pointing device

3. android:contentDescription, which is roughly equivalent to the alt
attribute on an HTML <img> tag, and is used by accessibility tools to help
people who cannot see the screen navigate the application — this is very
important for widgets like ImageView

We will see more about the focus attributes and android:contentDescription in
the chapter on focus management and accessibility, later in this book.

191

Licensed solely for use by Qiwen Chen



BAsic WIDGETS

Useful Methods

You can toggle whether or not a widget is enabled via setEnabled() and see if it is
enabled via isEnabled(). One common use pattern for this is to disable some
widgets based on a CheckBox or RadioButton checked state. We will explore
CheckBox, RadioButton, and similar sorts of widgets a bit later in the book.

You can give a widget focus via requestFocus() and see if it is focused via
isFocused(). You might use this in concert with disabling widgets as mentioned
above, to ensure the proper widget has the focus once your disabling operation is
complete.

To help navigate the tree of widgets and containers that make up an activity’s overall
view, you can use:

1. getParent() to find the parent widget or container

2. findVviewById() to find a child widget with a certain ID

3. getRootView() to get the root of the tree (e.g., what you provided to the
activity via setContentView())

Visit the Trails!

You can learn more about Android’s input method framework — what you might
think of as soft keyboards — in a later chapter.

Another chapter in the trails covers the use of fonts, to tailor your TextView widgets
(and those that inherit from them, like Button).

Yet another chapter in the trails covers rich text formatting, both for presenting
formatted text in a TextView (e.g., inline boldface) and for collecting formatted text
from the user via a customized EditText.
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Now that we are starting to manipulate layouts and Java code more significantly, the
odds increase that we are going to somehow do it wrong, and our app will crash.

Unfortunately, com.
commonsware.android.

skeleton has stopped.

(0]¢

Figure 133: A Crash Dialog on Android 4.0.3

In this chapter, we will cover a few tips on how to debug these sorts of issues.
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Get Thee To a Stack Trace

If you see one of those “Force Close” or “Has Stopped” dialogs, the first thing you will
want to do is examine the Java stack trace that is associated with this crash. These
are logged to a facility known as LogCat, on your device or emulator.

To view LogCat, you have three choices:

1. Use the adb logcat command at the command line (or something that uses
adb logcat, such as various colorizing scripts available online)

2. Use the LogCat tab in the standalone Android Device Monitor utility (run
monitor from the command line)

3. Use the LogCat view in your IDE (Eclipse or Android Studio)

There are also LogCat apps on the Play Store, such as aLogCat, that will display the
contents of LogCat. However, for security and privacy reasons, on Jelly Bean and
higher devices, such apps will only be able to show you their LogCat entries, not
those from the system, your app, or anyone else. Hence, for development purposes,
it is better to use one of the other alternatives outlined above.

LogCat in Android Studio

The LogCat view is available at any time, from pretty much anywhere in Android
Studio, by means of clicking on the Android tool window entry, usually docked at
the bottom of your IDE window:

[E Terminal 1 B Android =| 0: Messages = TODO

Figure 134: Minimized Tool Windows in Android Studio, Showing Android Tool
Window Entry

Tapping on that will bring up some Android-specific logs in an “Android DDMS”
tool window, with a tab for “Devices | logcat™
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[‘android DDMS: - L
Devices | logeat | ADB logs - (2 Log level: |Verbose B4 (Q- ) [N Fitters

i Devices | |an& logcat

07-20 08:32:54,487 12514-12514/7 D/SilentWidget . UpdateService calling buildupdate()

07-20 08:32:54, 487 12514-12514/7 D/SilentWidget. UpdateService Which ringer mode are we in?: 1
07-20 08:32:54, 487 12514-12514/7 D/silentWidget UpdateService. Set the pending intent for the silent button
07-20 08:32:54.487 12514-12514/7 I/Silentwidget.UpdateService. Going to update the app widget
07-20 08:32:54,497 12514-12514/7 D/SilentWidget UpdateService onDestroy ()

07-20 08:33:24,320 30112-13493/7 I/k9 Committing preference changes

07-20 08:33:24,329 30112-13493/? I/k9 Preferences commit took &nms

07-20 08:33:24,359 30112-30126/7 I/k9. Committing preference changes

07-20 08:33:24.429 30112-30126/? I/k9. Preferences commit took G4ms

07-20 08:33:24,439 30112-13494/7 I/k9 Committing preference changes

07-20 08:33:24.449 30112-13494/7 T/k9 Preferences commit took 9nms

8 .

& =
™ | [ LGE Nexus 4 Android 4.4.4 (API 19) [E3

ol « >

Figure 135: Android DDMS Tool Window, Showing LogCat

LogCat will show your stack traces, diagnostic information from the operating
system, and anything you wish to include via calls to static methods on the
android.util.Log class. For example, Log.e () will log a message at error severity,
causing it to be displayed in red.

If you want to send something from LogCat to somebody else, such as via an issue
tracker, just highlight the text and copy it to the clipboard, as you would with any
text editor.

The “trash can” icon atop the tool strip on the right is the “clear log” tool. Clicking it
will appear to clear LogCat. It definitely clears your LogCat view, so you will only see
messages logged after you cleared it. Note, though, that this does not actually clear
the logs from the device or emulator.

In addition, you can:

+ Use the “Log level” drop-down to filter lines based on severity, where
messages for your chosen severity or higher will be displayed

* Use the search field to the right of the “Log level” drop-down to filter items
based on a search string

+ Set up more permanent filters via the drop-down to the right of the search

field

LogCat in Eclipse

The LogCat view is available at any time, from pretty much anywhere in Eclipse, by
means of clicking on the LogCat icon in the status bar of your Eclipse window:
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Figure 136: Scaled Up Rendition of LogCat Icon

LogCat will show your stack traces, diagnostic information from the operating
system, and anything you wish to include via calls to static methods on the
android.util.Log class. For example, Log.e () will log a message at error severity,
causing it to be displayed in red.

® DDMS - Now/src/com/commonsware/android/skeleton/Now.java - Eclipse Platform

File Edit Run Source Navigate Search Project Refactor Window Help

mid 8 |@r |84 W o [@ooms
& v = v

2 LogCat ==

savedFilters # = gf verbose :| W B [m n

Allmessages (no fiters) (0 e PID  Application Tag Text

Eom.chmmonswate Sndit D} 03-28 08:47:34.353 645 com.commonsware.android.skele dalvikvm Not late—enahllng CheckJNI (already on)
D 03-28 08:47:34.833 | 645 | com.commonsware.android.skele| AndroidRuntime | Shutting down VM
E|03-28 08:47:34.873 645 com. commonsware.android.skele AndroidRuntime FATAL EXCEPTION: main
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele| AndroidRuntime | java.lang.RuntimeException: Unable to s
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele| AndroidRuntime at android.app.ActivityThread.p
E{03-28 08:47:34.873 645 com. commonsware.android.skele! AndroidRuntime at ar\drold.app.A(tlvltyThread.h
E|03-28 08:47:34.873 645 | com.commonsware.android.skele| AndroidRuntine at android.app.ActivityThread.a
£)03-28 08:47:34.873 | 645 | com.commonsware.android.skele| AndroidRuntime at android.app.ActivityThreadsH
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele| AndroidRuntine at android.os.Handler .dispatchi
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele| AndroidRuntine at android. os.Looper. loop(Loope
E|03-28 08:47:34.873 645 com. commonsware.android.skele! AndroidRuntime at android.app.ActivityThread.m
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele! AndroidRuntime at java.lang.reflect.Method.inv
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skelef AndroidRuntime at java.lang.reflect.Method.inv
E|{03-28 08:47:34.873 645 com. commonsware.android.skele! AndroidRuntime at (om.androld.lnternal.cs.zygc
E|03-28 08:47:34.873 645 | com.commonsware.android.skele| AndroidRuntine at com.android. internal.os.Zygo
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele] AndroidRuntime at dalvik.system.NativeStart.ma
E|03-28 08:47:34.873 645 com. commonsware.android.skele! AndroidRuntime Caused b\/ ]ava.lang.NullPolnterEx(eptl
E|03-28 08:47:34.873 | 645 | com.commonsware.android.skele| AndroidRuntime at com. commonsware. android. skel
E|03-28 08:47:34.873 645 | com.commonsware.android.skele| AndroidRuntime at android.app.Activity.perforr
E{03-28 08:47:34.873 645 com. commonsware.android.skele! AndroidRuntime at ar\drold.app.Instrumentatlon.
E|03-28 08:47:34.873 645 | com.commonsware.android.skele| AndroidRuntine at android.app.ActivityThread.p
E{03-28 08:47:34.873 645 com. commonsware.android.skele| AndroidRuntime ... 11 more

y s (@)

Figure 137: Eclipse Window with LogCat View Maximized

By default, when developing your app, if your app crashes, LogCat will display
messages from your app alone, via a filter on the left, with the name of your app’s
package (e.g., com.commonsware.android.skeleton). Switching the filter to “All
messages (no filters)” will show all LogCat messages, regardless of origin.

196

Licensed solely for use by Qiwen Chen



DEBUGGING YOUR APP

There is a scrollbar towards the bottom of the main log area that will let you see
more of your stack trace:

DDMS - Now/src/com/commonsware/android/skeleton/Now.java - Eclipse Platform

File Edit Run Source Navigate Search Project Refactor Window Help

5 v Oy Qv # [©poms

2 LogCat 3 ==
savedFilters & = gf verbose :| H B |m| n
All messages (no filters) (¢
com.commonsware.andr¢

Text
Not late-enabling CheckJNI (already on)
Shutting down VM

FATAL EXCEPTION: main
java.lang.RuntimeException: Unable to start activity ComponentInfo{com.commonsware.android.skeleton/com.commonsware
at android.app.ActivityThread.performLaunchActivity(ActivityThread.java:1956)
at android.app.ActivityThread.handlelaunchActivity(ActivityThread.java:1981)
at android.app.ActivityThread.access$600(ActivityThread.java:123)
at android.app.ActivityThread$H.handleMessage(ActivityThread.java: 1147)
at android.os.Handler.dispatchMessage(Handler.java:99)
at android.os.Looper.loop(Looper.java:137)
at android.app.ActivityThread.main(ActivityThread.java:4424)
at java.lang.reflect.Method.invokeNative(Native Method)
at java.lang.reflect.Method.invoke(Method.java:511)
at com.android.internal.os.ZygoteInit$MethodAndArgsCaller. run(ZygoteInit.java:784)
at com.android.internal.os.ZygoteInit.main(ZygoteInit.java:551)
at dalvik.system.NativeStart.main(Native Method)
Caused by: java.lang.NullPointerException
at com.commonsware.android.skeleton.Now.onCreate(Now.java:31)
at android.app.Activity.performCreate(Activity.java:4465)
at android.app.Instrumentation.callActivityonCreate(Instrumentation.java:1049)

at android.app.ActivityThread.performLaunchActivity(ActivityThread.java:1920)
.. 11 more

L -]

Figure 138: Eclipse Window with LogCat View Scrolled Right

Your stack trace will typically consist of two or more “stanzas”. Your own code will
typically be in the last of these. So, in the screenshot above, we have
java.lang.RuntimeException: Unable to start activity..., followed by
Caused by: java.lang.NullPointerException, as a pair of stanzas. The point
where our code crashed shows up in that second stanza (at
com.commonsware.android.skeleton.Now.onCreate(Now.java:31)).

If you double-click on a line in the stack trace corresponding with your code, you
will be taken to a Java editor on that source file and line, so you can see what code
triggered the exception.

If you wish to save one of these stack traces as a file, to attach to an issue in an issue
tracker or something, highlight the lines you want in LogCat (click on the first line,
then <Shift>-click on the last line), then click on the “Export Selected Items to Text
File” icon (looks like a 3.5-inch floppy disk or a classic “save” icon). This will bring up
your platform’s “Save As” dialog, where you can specify where to write out the file.
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The icon immediately to the right is the “clear” icon:

HE

Figure 139: LogCat Save and Clear Icons

Clicking it will appear to clear LogCat. It definitely clears your LogCat view, so you
will only see messages logged after you cleared it. Note, though, that this does not
actually clear the logs from the device or emulator.

The Case of the Confounding Class Cast

If you crash, the stack trace might suggest that there is a problem tied to your
resources. One common flavor of this is a ClassCastException when you call
findviewById(). For example, you might call (Button)findviewById(R.id.button),
yet get a ClassCastException: android.widget.LinearLayout as a result,
indicating that while you thought your findviewById() call would return a Button,
it really returned a LinearLayout.

Often times, this is not your fault. Sometimes, the R values get out of sync with pre-
compiled classes from previous builds. This most often occurs just after you change
your mix of resources (e.g., add a new layout).

To resolve this, you need to clean your project:

* In Android Studio, choose “Build > Clean Project” from the main menu
+ In Eclipse, select the project, then choose Project > Clean from the main
menu

So, if you get a strange crash that seems like it might be related to resources, clean
your project. If the problem goes away, you are set — if the problem persists, you
will need to do a bit more debugging.
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Point Break

One of the hallmarks of Java IDEs is the ability to do real-time debugging, using
breakpoints and the like. In that respect, Android Studio and Eclipse work for
Android apps in the same way that Intelli] IDEA and Eclipse work for Java apps. You
can debug on an emulator or any Android device for which you enabled USB
debugging (as you may have done in Tutorial #1).

Lacking any Android Studio-specific documentation, you will wind up referring to
the documentation for Intelli] IDEA to learn how to use its debugger. Similarly, you
can turn to the documentation for Eclipse for details of how to use the Eclipse
debugger.

Note that if you set up Eclipse to catch all unhandled exceptions, those exceptions
will not be logged to LogCat unless you allow execution to proceed past the point of
the exception. While this may not matter much to you during development, the
LogCat stack trace is often easier for other developers to read, away from your
Eclipse environment. So, if you wish to post a stack trace on an issue or on a support
forum (e.g., Stack Overflow), use the LogCat stack trace.
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LinearLayout and the Box Model

LinearLayout represents Android’s approach to a box model — widgets or child
containers are lined up in a column or row, one after the next.

Some GUI toolkits use the box as their primary unit of layout. If you want, you can
use LinearLayout in much the same way, eschewing some of the other containers.
Getting the visual representation you want is mostly a matter of identifying where
boxes should nest and what properties those boxes should have, such as alignment
with respect to other boxes.

Concepts and Properties

To configure a LinearLayout, you have four main areas of control besides the
container’s contents: the orientation, the fill model, the weight, the gravity.

Orientation

Orientation indicates whether the LinearLayout represents a row or a column. Just
add the android:orientation property to your LinearLayout element in your XML
layout, setting the value to be horizontal for a row or vertical for a column.

The orientation can be modified at runtime by invoking setOrientation() on the
LinearLayout, supplying it either HORIZONTAL or VERTICAL.

Fill Model

The point behind a LinearLayout — or any of the Android container classes - is to
organize multiple widgets. Part of organizing those widgets is determining how
much space each gets.
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LinearLayout takes an “eldest child wins” approach towards allocating space. So, if
we have a LinearLayout with three children, the first child will get its requested
space. The second child will get its requested space, if there is enough room
remaining, and likewise for the third child. So if the first child asks for all the space
(e.g., thisis a horizontal LinearLayout and the first child has
android:layout_width="match_parent"), the second and third children will wind
up with zero width.

Weight

But, what happens if we have two or more widgets that should split the available free
space? For example, suppose we have two multi-line fields in a column, and we want
them to take up the remaining space in the column after all other widgets have been
allocated their space.

To make this work, in addition to setting android: layout_width (for rows) or
android:layout_height (for columns), you must also set android:layout_weight.
This property indicates what proportion of the free space should go to that widget. If
you set android:layout_weight to be the same non-zero value for a pair of widgets
(e.g., 1), the free space will be split evenly between them. If you set it to be 1 for one
widget and 2 for another widget, the second widget will use up twice the free space
that the first widget does. And so on.

The weight for a widget is zero by default.

Another pattern for using weights is if you want to allocate sizes on a percentage
basis. To use this technique for, say, a horizontal layout:

1. Set all the android:layout_width values to be 0 for the widgets in the layout

2. Set the android:layout_weight values to be the desired percentage size for
each widget in the layout

3. Make sure all those weights add up to 100

If you want to have space left over, not allocated to any widget, you can add an
android:weightSum attribute to the LinearLayout, and ensure that the sum of the
android:layout_weight attributes of the children are less than that sum. The
children will each get space allocated based upon the ratio of their
android:layout_weight compared to the android:weightSum, not compared to the
sum of the weights. And there will be empty space that takes up the rest of the room
not allocated to the children.
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To see android:layout_weight in action, take a look at the Containers/
LinearPercent sample project. Here, we have a res/layout/main.xml file containing
a vertical LinearLayout with three Button widgets as children:

<?xml version="1.0" encoding="utf-8"?>

<LinearlLayout xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:orientation="vertical">

<Button
android:layout_width="match_parent"
android:layout_height="0dip"
android:layout_weight="50"
android:text="@string/fifty_percent"/>

<Button
android:layout_width="match_parent"
android:layout_height="0dip"
android:layout_weight="30"
android:text="@string/thirty_percent"/>

<Button
android:layout_width="match_parent"
android:layout_height="0dip"
android:layout_weight="20"
android:text="@string/twenty_percent"/>

</LinearlLayout>

Each of the three Button widgets declares its height to be 0dip. However, each also
has an android:layout_weight attribute, with the top Button requesting a weight of
50, the middle Button a weight of 30, and the bottom Button a weight of 20.

The result is that the Button widgets’ heights are allocated based solely upon those
weights:
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*@" Linear Percent Demo

Fifty Percent

Thirty Percent

Twenty Percent

Figure 140: The LinearPercent Sample Application

Gravity

By default, everything in a LinearLayout is left- and top-aligned. So, if you create a
row of widgets via a horizontal LinearLayout, the row will start flush on the left side
of the screen.

If that is not what you want, you need to specify a gravity. Unlike the physical world,
Android has two types of gravity: the gravity of a widget within a LinearLayout, and
the gravity of the contents of a widget or container.

The android:gravity property of some widgets and containers — which also can be
defined via setGravity() in Java — tells Android to slide the contents of the widget
or container in a particular direction. For example, android:gravity="right" says
to slide the contents of the widget to the right; android:gravity="right|bottom"
says to slide the contents of the widget to the right and the bottom.

Here, “contents” varies. TextView supports android:gravity, and the “contents” is
the text held within the TextView. LinearLayout supports android:gravity, and the
“contents” are the widgets inside the container. And so on.
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Children of a LinearLayout also have the option of specifying
android:layout_gravity. Here, the child is telling the LinearLayout “if there is
room, please slide me (and me alone) in this direction”. However, this only works in
the direction opposite the orientation of the LinearLayout - the children of a
vertical LinearLayout can use android:layout_gravity to control their
positioning horizontally (left or right), but not vertically.

For a row of widgets, the default is for them to be aligned so their texts are aligned
on the baseline (the invisible line that letters seem to “sit on”), though you may wish
to specify a gravity of center_vertical to center the widgets along the row’s vertical
midpoint.

Android Studio Graphical Layout Editor

The LinearLayout container can be found in the “Layouts” portion of the Palette of
the Android Studio graphical layout editor:

| Layouts
Ij FramelLayout
|_i LinearLayout (Horizon
lj LinearLayout (Vertica
-] TableLayout
;:1 TableRow
._' GridLayout

[ RelativeLayout
Figure 141: Layouts Palette in Android Studio Graphical Layout Editor

You can drag either the “LinearLayout (Vertical)” or “LinearLayout (Horizontal)” into
a layout XML resource, then start dragging in children to go into the container.

When your LinearLayout is the selected widget, a few new toolbar buttons will
appear over the preview:

] [T][:3]~

Figure 142: LinearLayout Toolbar Buttons
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The left two buttons toggle the width and height between match_parent and
wrap_content, while the third button changes the gravity of the LinearLayout.

When one of the children of the LinearLayout is the selected widget, the toolbar
changes:

Figure 143: LinearLayout Toolbar Buttons, For Selected Child

From left to right, the buttons:

+ Toggle the parent LinearLayout between horizontal and vertical
orientations

+ Align the child widgets’ baselines (where a “baseline” is the invisible line that
text appears to sit upon)

+ Change the android:layout_gravity value for the child

+ Toggle the width between match_parent and wrap_content

+ Toggle the height between match_parent and wrap_content

+ Distribute the weights of the selected children evenly

+ Assign this widget all of the weight, at the expense of other children of the
LinearLayout

* Set the weight to a specific value

* Clear the weights from the children

The Properties pane for the selected widget also allows you to get to the
LinearLayout container to make adjustments to its attributes.

Eclipse Graphical Layout Editor

The LinearLayout container can be found in the “Layouts” portion of the Palette of
the Eclipse graphical layout editor:
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= Layouts

||| LinearLayout (Horizontal

(] RelativeLayout

¢ 1 Include Other Layout

Figure 144: Layouts Palette in Eclipse Graphical Layout Editor

You can drag either the “LinearLayout (Vertical)” or “LinearLayout (Horizontal)” into
a layout XML resource, then start dragging in children to go into the container.

When your LinearLayout is the selected widget, a toolbar will appear over the
preview:

| B =
Figure 145: LinearLayout Toolbar in Eclipse Graphical Layout Editor

The left two buttons toggle your LinearLayout between vertical and horizontal
modes. The two immediately to the right of the divider toggle the width and height
between match_parent and wrap_content.

When one of the children of the LinearLayout is the selected widget, the toolbar
changes:

m | = E - @O
Figure 146: LinearLayout Contents Toolbar in Eclipse Graphical Layout Editor

The left two buttons still toggle the orientation of the LinearLayout. The width and
height buttons to their right toggle the width and height of the selected widget.

The right-most six buttons, from left to right, allow you to:
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+ Change the margins on the selected widget

+ Change the gravity of the selected widget

* Give all widgets in the LinearLayout equal weight

* Give the selected widget all the weight

* Manually assign the weight to the selected widget

* Clear all weights from all widgets in the LinearLayout

The Properties pane for the selected widget also allows you to get to the
LinearLayout container to make adjustments to its attributes.
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Other Common Widgets and
Containers

In the chapter on basic widgets, we left out all of the classic “two-state” widgets,
such as checkboxes and radio buttons. We will examine those and other related
widgets in this chapter.

Beyond LinearLayout, Android supports a range of containers providing different
layout rules. In this chapter, we will look at two other commonly-used containers:
Relativelayout (a rule-based model) and TableLayout (the grid model), along with
ScrollView and HorizontalScrollView, containers that allow their contents to
scroll. We will examine all of these containers in this chapter as well.

Just a Box to Check

The classic checkbox has two states: checked and unchecked. Clicking the checkbox
toggles between those states to indicate a choice (e.g., “Add rush delivery to my
order”).

In Android, there is a CheckBox widget to meet this need. It has TextView as an
ancestor, so you can use TextView properties like android: textColor to format the
widget.

Within Java, you can invoke:
1. isChecked() to determine if the checkbox has been checked

2. setChecked() to force the checkbox into a checked or unchecked state
3. toggle() to toggle the checkbox as if the user clicked upon it
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Also, you can register a listener object (in this case, an instance of
OnCheckedChangeListener) to be notified when the state of the checkbox changes.

For example, from the Basic/CheckBox sample project, here is a simple checkbox
layout:

<?xml version="1.0" encoding="utf-8"?>

<CheckBox xmlns:android="http://schemas.android.com/apk/res/android"
android:id="@+id/check"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="@string/unchecked" />

The corresponding CheckBoxDemo. java retrieves and configures the behavior of the
checkbox:

package com.commonsware.android.checkbox;

import android.app.Activity;

import android.os.Bundle;

import android.widget.CheckBox;
import android.widget.CompoundButton;

public class CheckBoxDemo extends Activity implements
CompoundButton.OnCheckedChangelListener {
CheckBox cb;

@Override

public void onCreate(Bundle icicle) {
super.onCreate(icicle);
setContentView(R.layout.main);

cb=(CheckBox)findViewById(R.id.check);
cb.setOnCheckedChangelListener(this);
h

public void onCheckedChanged(CompoundButton buttonView,
boolean isChecked) {
if (isChecked) {
cb.setText(R.string.checked);
}
else {
cb.setText(R.string.unchecked);
}
}
}

Note that the activity serves as its own listener for checkbox state changes since it
implements the OnCheckedChangeListener interface (set via
cb.setOnCheckedChangelListener (this)). The callback for the listener is
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onCheckedChanged( ), which receives the checkbox whose state has changed and
what the new state is. In this case, we update the text of the checkbox to reflect what
the actual box contains.

The result? Clicking the checkbox immediately updates its text, as shown below:

*3" CheckBoxDemo

This checkbox is: unchecked

Figure 147: CheckBoxDemo Sample App, in Theme.Holo, with CheckBox Unchecked
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*3" CheckBoxDemo

+ This checkbox is: checked

Figure 148: CheckBoxDemo Sample App, in Theme.Holo, with CheckBox Checked

+" This checkbox is: checked

Figure 149: CheckBoxDemo Sample App, in Theme, with CheckBox Checked
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CheckBoxDemo

This checkbox is: checked

Figure 150: CheckBoxDemo Sample App, in Theme.Material, with CheckBox Checked

Android Studio Graphical Layout Editor

The CheckBox widget can be found in the “Widgets” portion of the Palette in the
Android Studio Graphical Layout editor:

: 1 Widgets
[ab| Plain Textview
[ab| Large Text
[3E] Medium Text
[30] small Text
ok Button
ok Small Button
| (® RadioButton
| = Switch
— ToggleButton

Figure 151: Widgets Palette, CheckBox Shown Highlighted
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You can drag it into the layout and configure it as desired using the Properties pane.
As CheckBox inherits from TextView, most of the settings are the same as those you
would find on a regular TextView.

Eclipse Graphical Layout Editor

The CheckBox widget appears in the “Form Widgets” section of the Palette in the
Graphical Layout editor. You can drag it into the layout and configure it as desired
using the Properties pane. As CheckBox inherits from TextView, most of the settings
are the same as those you would find on a regular TextView.

Don’t Like Checkboxes? How About Toggles or
Switches?

A similar widget to CheckBox is ToggleButton. Like CheckBox, ToggleButton is a
two-state widget that is either checked or unchecked. However, ToggleButton has a
distinct visual appearance:

*@ ToggleButton Demo

Figure 152: ToggleButtonDemo Sample, Unchecked, in Theme.Holo
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*@" ToggleButton Demo

Figure 153: ToggleButtonDemo Sample, Checked, in Theme.Holo

Otherwise, ToggleButton behaves much like CheckBox. You can put it in a layout file,
as seen in the Basic/ToggleButton sample:

<?xml version="1.0" encoding="utf-8"?>

<ToggleButton xmlns:android="http://schemas.android.com/apk/res/android"
android:id="@+id/toggle"
android:layout_width="wrap_content"
android:layout_height="wrap_content" />

You can also set up an OnCheckedChangeListener to be notified when the user
changes the state of the ToggleButton.

Similarly, Android has a Switch widget, showing the state via a small “ON/OFF”
slider:
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*3" Switch Demo

Figure 154: SwitchDemo Sample, Unchecked, in Theme.Holo

*g" Switch Demo

Figure 155: SwitchDemo Sample, Checked, in Theme.Holo
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Switch Demo

Figure 156: SwitchDemo Sample, Unchecked, in Theme.Material

Switch Demo

Figure 157: SwitchDemo Sample, Checked, in Theme.Material
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Switch, like CheckBox and ToggleButton, inherits from CompoundButton, and
therefore shares a common API, for methods like toggle(), isChecked(), and
setChecked(). And, as with the others, you can put it in a layout file, as seen in the

Basic/Switch sample:

<?xml version="1.0" encoding="utf-8"?>

<Switch xmlns:android="http://schemas.android.com/apk/res/android"
android:id="@+id/toggle"
android:layout_width="wrap_content"
android:layout_height="wrap_content" />

The biggest limitation with Switch is that it was only added to the Android SDK in
API Level 14. If your minSdkVersion is set to 14 or higher, you are welcome to use
Switch. If your minSdkVersion is set to something lower than 14, though, you will
either need to choose something else or get into more complicated scenarios, like
using a library that offers a backport of Switch. We will cover those more
complicated scenarios later in the book; for now, it is simplest to only use Switch if
your minSdkVersion is set to 14 or higher.

Android Studio Graphical Layout Editor

The ToggleButton and Switch widgets can be found in the “Widgets” portion of the
Palette in the Android Studio Graphical Layout editor, just beneath the CheckBox
widget:

Widgets
[t Plain Textview
[ab| Large Text
ab| Medium Text
[ab) Small Text
ok Button
ok Small Button
| (® RadioButton
| =m Switch
— ToggleButton

Figure 158: Widgets Palette, ToggleButton and Switch At Bottom

You can drag either widget into the layout and configure it as desired using the
Properties pane.
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Eclipse Graphical Layout Editor

Like CheckBox, the ToggleButton and Switch widgets appear in the “Form Widgets”
section of the Palette in the Graphical Layout editor. You can drag either widget into
the layout and configure it as desired using the Properties pane.

Turn the Radio Up

As with other implementations of radio buttons in other toolkits, Android’s radio
buttons are two-state, like checkboxes, but can be grouped such that only one radio
button in the group can be checked at any time.

CheckBox, ToggleButton, Switch, and RadioButton all inherit from CompoundButton,
which in turn inherits from TextView. Hence, all the standard TextView properties
for font face, style, color, etc. are available for controlling the look of radio buttons.
Similarly, you can call isChecked() on a RadioButton to see if it is selected,
toggle() to change its checked state, and so on, like you can with a CheckBox.

Most times, you will want to put your RadioButton widgets inside of a RadioGroup.
The RadioGroup is a LinearLayout that indicates a set of radio buttons whose state
is tied, meaning only one button out of the group can be selected at any time. If you
assign an android:id to your RadioGroup in your XML layout, you can access the
group from your Java code and invoke:

1. check() to check a specific radio button via its ID (e.g.,
group.check(R.id.radio1))

2. clearCheck() to clear all radio buttons, so none in the group are checked

3. getCheckedRadioButtonId() to get the ID of the currently-checked radio
button (or -1 if none are checked)

Note that the mutual-exclusion feature of RadioGroup only applies to RadioButton
widgets that are immediate children of the RadioGroup. You cannot have other
containers between the RadioGroup and its RadioButton widgets.

For example, from the Basic/RadioButton sample application, here is an XML
layout showing a RadioGroup wrapping a set of RadioButton widgets:

<?xml version="1.0" encoding="utf-8"?>

<RadioGroup
xmlns:android="http://schemas.android.com/apk/res/android"
android:orientation="vertical"
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android:layout_width="match_parent"
android:layout_height="match_parent"
>
<RadioButton android:id="@+id/radio1"
android:layout_width="wrap_content"
android:layout_height="wrap_content
android:text="@string/rock" />

<RadioButton android:id="@+id/radio2"
android:layout_width="wrap_content"
android:layout_height="wrap_content
android:text="@string/scissors" />

<RadioButton android:id="@+id/radio3"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="@string/paper" />
</RadioGroup>

Using the stock Android-generated Java for the project and this layout, you get:

® Scissors

Paper

Figure 159: RadioButtonDemo, with “Scissors” Checked, in Theme
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*3" RadioButtonDemo

Rock
® Scissors

Paper

Figure 160: RadioButtonDemo, with “Scissors” Checked, in Theme.Holo

RadioButtonDemo

O Rock
@ Scissors
O Paper

Figure 161: RadioButtonDemo, with “Scissors” Checked, in Theme.Material
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Note that the radio button group is initially set to be completely unchecked at the
outset. To preset one of the radio buttons to be checked, use either setChecked() on
the RadioButton or check() on the RadioGroup from within your onCreate()
callback in your activity. Alternatively, you can use the android: checked attribute on
one of the RadioButton widgets in the layout file.

Android Studio Graphical Layout Editor

The RadioGroup container can be found in the “Containers” portion of the Palette in
the Android Studio Graphical Layout editor:

| Containers

B RadioGroup

= ListView

] Gridview

= ExpandableListview
[ I scroliview

ls| HorizontalScrollview
&, Searchview

= TabHost

@ videoview

Figure 162: Widgets Palette, RadioGroup Highlighted

Dragging a RadioGroup into the preview works much like dragging a LinearLayout
into the preview. You get a box into which you can drag other widgets, such as the
RadioButton found in the “Widgets” section of the Palette.

Eclipse Graphical Layout Editor

Both RadioButton and RadioGroup appear in the “Form Widgets” section of the
Palette in the Graphical Layout editor. The RadioButton widget has a radio button
with the text “RadioButton” to the right. The RadioGroup widget looks like three
radio buttons (sans text) side-by-side.

Since RadioGroup extends LinearLayout, when you drag it into the layout, you will
get the same sorts of options as a vertical LinearLayout, such as setting the gravity.
Note, though, that dragging a RadioGroup into a layout automatically gives you three
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RadioButton child widgets — a departure from any other container in the Palette.
You can configure those RadioButton widgets, delete them, add more, etc.

All Things Are Relative

Relativelayout, as the name suggests, lays out widgets based upon their
relationship to other widgets in the container and the parent container. You can
place Widget X below and to the left of Widget Y, or have Widget Z’s bottom edge
align with the bottom of the container, and so on.

Concepts and Properties

To make all this work, we need ways to reference other widgets within an XML
layout file, plus ways to indicate the relative positions of those widgets.

Positions Relative to Container

The easiest relations to set up are tying a widget’s position to that of its container:

1. android:layout_alignParentTop says the widget’s top should align with the
top of the container

2. android:layout_alignParentBottom says the widget’s bottom should align
with the bottom of the container

3. android:layout_alignParentLeft says the widget’s left side should align
with the left side of the container

4. android:layout_alignParentRight says the widget’s right side should align
with the right side of the container

5. android:layout_centerHorizontal says the widget should be positioned
horizontally at the center of the container

6. android:layout_centerVertical says the widget should be positioned
vertically at the center of the container

7. android:layout_centerInParent says the widget should be positioned both
horizontally and vertically at the center of the container

All of these properties take a simple boolean value (true or false).

Note that the padding of the widget is taken into account when performing these
various alignments. The alignments are based on the widget’s overall cell
(combination of its natural space plus the padding).

223

Licensed solely for use by Qiwen Chen



OTHER COMMON WIDGETS AND CONTAINERS

Relative Notation in Properties

The remaining properties of relevance to RelativelLayout take as a value the identity
of a widget in the container. To do this:

* Put identifiers (android: id attributes) on all elements that you will need to
address
* Reference other widgets using the same identifier value

The first occurrence of an id value should have the plus sign (@+id/widget_a); the
second and subsequent times that id value is used in the layout file should drop the
plus sign (@id/widget_a). This allows the build tools to better help you catch typos
in your widget id values — if you do not have a plus sign for a widget id value that
has not been seen before, that will be caught at compile time.

For example, if Widget A appears in the RelativelLayout before Widget B, and
Widget A is identified as @+id/widget_a, Widget B can refer to Widget A in one of
its own properties via the identifier @id/widget_a.

Positions Relative to Other Widgets

There are four properties that control position of a widget vis-a-vis other widgets:

1. android:layout_above indicates that the widget should be placed above the
widget referenced in the property

2. android:layout_below indicates that the widget should be placed below the
widget referenced in the property

3. android:layout_toLeftOf indicates that the widget should be placed to the
left of the widget referenced in the property

4. android:layout_toRightOf indicates that the widget should be placed to
the right of the widget referenced in the property

Beyond those four, there are five additional properties that can control one widget’s
alignment relative to another:

1. android:layout_alignTop indicates that the widget’s top should be aligned
with the top of the widget referenced in the property

2. android:layout_alignBottom indicates that the widget’s bottom should be
aligned with the bottom of the widget referenced in the property

3. android:layout_alignLeft indicates that the widget’s left should be aligned
with the left of the widget referenced in the property
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4. android:layout_alignRight indicates that the widget’s right should be
aligned with the right of the widget referenced in the property

5. android:layout_alignBaseline indicates that the baselines of the two
widgets should be aligned (where the “baseline” is that invisible line that text
appears to sit on)

The last one is useful for aligning labels and fields so that the text appears “natural”.
Since fields have a box around them and labels do not, android:layout_alignTop
would align the top of the field’s box with the top of the label, which will cause the
text of the label to be higher on-screen than the text entered into the field.

So, if we want Widget B to be positioned to the right of Widget A, in the XML
element for Widget B, we need to include android: layout_toRightOf =
"@id/widget_a" (assuming @id/widget_a is the identity of Widget A).

Example

With all that in mind, let’s examine a typical “form” with a field, a label, plus a pair
of buttons labeled “OK” and “Cancel”.

Here is the XML layout, pulled from the Containers/Relative sample project:

<?xml version="1.0" encoding="utf-8"?>

<Relativelayout
xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="wrap_content">

<TextView
android:id="@+id/label"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignBaseline="@+id/entry"
android:layout_alignParentLeft="true"
android:layout_marginLeft="4dip"
android:text="@string/url"/>

<EditText
android:id="@id/entry"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_alignParentTop="true"
android:layout_toRightOf="@id/label"
android: inputType="text"/>

<Button
android:id="@+id/ok"
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android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignRight="@id/entry"
android:layout_below="@id/entry"
android:text="@string/ok"/>

<Button
android:id="@+id/cancel"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignTop="@id/ok"
android:layout_tolLeftOf="@id/ok"
android:text="@string/cancel" />

</RelativelLayout>

First, we open up the Relativelayout. In this case, we want to use the full width of
the screen (android:layout_width = "match_parent") and only as much height as
we need (android:layout_height = "wrap_content").

Next, we define the label as a TextView. We indicate that we want its left edge
aligned with the left edge of the RelativelLayout
(android:layout_alignParentLeft="true") and that we want its baseline aligned
with the baseline of the yet-to-be-defined EditText. Since the EditText has not
been declared yet, we use the + sign in the ID
(android:layout_alignBaseline="@+id/entry").

After that, we add in the field as an EditText. We want the field to be to the right of
the label, have the field be aligned with the top of the Relativelayout, and for the
field to take up the rest of this “row” in the layout. Those are handled by three
properties:

1. android:layout_toRightOf = "@id/label"
2. android:layout_alignParentTop = "true"
3. android:layout_width = "match_parent”

Then, the OK button is set to be below the field (android:layout_below =
"@id/entry") and have its right side align with the right side of the field
(android:layout_alignRight = "@id/entry"). The Cancel button is set to be to the
left of the OK button (android:layout_toLeft = "@id/ok") and have its top aligned
with the OK button (android:layout_alignTop = "@id/ok").

With no changes to the auto-generated Java code, the emulator gives us:
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Overlap

*%’ RelativeLayoutDemo

OK

Figure 163: The RelativeLayoutDemo sample application

RelativeLayout also has a feature that LinearLayout lacks — the ability to have
widgets overlap one another. Later children of a RelativeLayout are “higher in the Z
axis” than are earlier children, meaning that later children will overlap earlier
children if they are set up to occupy the same space in the layout.

This will be clearer with an example. Here is a layout, from the Containers/
RelativeOverlap sample, with a RelativeLayout holding two Button widgets:

<?xml version="1.0" encoding="utf-8"?>

<Relativelayout xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent">

<Button

android:
android:
android:
android:
android:

<Button

layout_width="match_parent"
layout_height="match_parent"
text="@string/big"
textSize="120dip"
textStyle="bold"/>
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android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_centerInParent="true"
android:text="@string/small"/>

</RelativelLayout>

The first Button is set to fill the screen. The second Button is set to be centered
inside the parent, but only take up as much space as is needed for its caption.
Hence, the second Button will appear to “float” over the first Button:

*@" Overlap Demo

| AM

| am small

BIG

Figure 164: The RelativeOverlap sample application

Both Button widgets can still be clicked, though clicking on the smaller Button does
not also click the bigger Button. Your clicks will be handled by the widget on top in
the case of an overlap like this.

Android Studio Graphical Layout Editor

You will find RelativeLayout in the “Layouts” section of the Palette in the Android
Studio Graphical Layout editor. You can drag that into your layout XML resource.

228

Licensed solely for use by Qiwen Chen



OTHER COMMON WIDGETS AND CONTAINERS

Layouts
DFrameLayout
|| LinearLayout EHurizunE
| LinearLayout (Vertica
[l TableLayout
= TableRow
[ GridLayout

38 RelativeLayout

Figure 165: Layouts Section of Palette, RelativeLayout Highlighted

As you drag other widgets into your Relativelayout, you will see a popup indicator
of the RelativelLayout rules that will be applied if you were to drop the widget at
the current mouse pointer position:

Figure 166: Dragging a Widget in a RelativeLayout

Getting the rules that you want may or may not be possible purely through drag-
and-drop. You may need to just drop the widget into the RelativeLayout and
manually adjust the rules, whether by using the Properties pane or by editing the
XML directly.
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NOTE: There is a bug in the layout editor that renders the RelativelLayout
incorrectly on Android Studio, if your preview is set to API Level 21. If you drop the
preview to API Level 19, the RelativelLayout renders correctly. And, running the
app on a device shows that the RelativeLayout renders correctly, even on Android

5.0.

Eclipse Graphical Layout Editor

You will find RelativeLayout in the “Layouts” section of the Palette in the Eclipse
Graphical Layout editor. You can drag that into your layout XML resource.

As with Android Studio, when you drag a widget into a Relativelayout, a popup
will indicate the RelativelLayout rules that will be applied if you drop the widget at
the current location. Sometimes, you cannot get the rules that you really want,
forcing you to modify the RelativeLayout XML directly via the other editor sub-tab
or via the Properties pane to get it set up properly.

Tabula Rasa

If you like HTML tables, you will like Android’s TableLayout. It allows you to
position your widgets in a grid to your specifications. You control the number of
rows and columns, which columns might shrink or stretch to accommodate their
contents, and so on.

TablelLayout works in conjunction with TableRow. TableLayout controls the overall

behavior of the container, with the widgets themselves poured into one or more
TableRow containers, one per row in the grid.

Concepts and Properties

For all this to work, we need to figure out how widgets work with rows and columns,
plus how to handle widgets that live outside of rows.

Putting Cells in Rows

Rows are declared by you, the developer, by putting widgets as children of a
TableRow inside the overall TableLayout. You, therefore, control directly how many
rows appear in the table.
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The number of columns are determined by Android; you control the number of
columns in an indirect fashion.

First, there will be at least one column per widget in your longest row. So if you have
three rows, one with two widgets, one with three widgets, and one with four
widgets, there will be at least four columns.

However, a widget can take up more than one column by including the
android:layout_span property, indicating the number of columns the widget spans.
This is akin to the colspan attribute one finds in table cells in HTML:

<TableRow>
<TextView android:text="URL:" />
<EditText
android:id="@+id/entry"
android:layout_span="3"/>
</TableRow>

In the above XML layout fragment, the field spans three columns.

Ordinarily, widgets are put into the first available column. In the above fragment,
the label would go in the first column (column 0, as columns are counted starting
from 0), and the field would go into a spanned set of three columns (columns 1
through 3). However, you can put a widget into a different column via the
android:layout_column property, specifying the 0-based column the widget belongs
to:

<TableRow>
<Button
android:id="@+id/cancel"
android:layout_column="2"
android:text="Cancel" />
<Button android:id="@+id/ok" android:text="0K" />
</TableRow>

In the preceding XML layout fragment, the Cancel button goes in the third column
(column 2). The OK button then goes into the next available column, which is the
fourth column.

Non-Row Children of TableLayout

Normally, TableLayout contains only TableRow elements as immediate children.
However, it is possible to put other widgets in between rows. For those widgets,
TableLayout behaves a bit like LinearLayout with vertical orientation. The widgets

231

Licensed solely for use by Qiwen Chen



OTHER COMMON WIDGETS AND CONTAINERS

automatically have their width set to match_parent, so they will fill the same space
that the longest row does.

Stretch, Shrink, and Collapse

By default, each column will be sized according to the “natural” size of the widest
widget in that column (taking spanned columns into account). Sometimes, though,
that does not work out very well, and you need more control over column behavior.

You can place an android:stretchColumns property on the TableLayout. The value
should be a single column number (again, 0-based) or a comma-delimited list of
column numbers. Those columns will be stretched to take up any available space yet
on the row. This helps if your content is narrower than the available space.

Conversely, you can place an android: shrinkColumns property on the TablelLayout.
Again, this should be a single column number or a comma-delimited list of column
numbers. The columns listed in this property will try to word-wrap their contents to
reduce the effective width of the column — by default, widgets are not word-
wrapped. This helps if you have columns with potentially wordy content that might
cause some columns to be pushed off the right side of the screen.

You can also leverage an android:collapseColumns property on the TablelLayout,
again with a column number or comma-delimited list of column numbers. These
columns will start out “collapsed”, meaning they will be part of the table information
but will be invisible. Programmatically, you can collapse and un-collapse columns by
calling setColumnCollapsed() on the TableLayout. You might use this to allow
users to control which columns are of importance to them and should be shown
versus which ones are less important and can be hidden.

You can also control stretching and shrinking at runtime via
setColumnStretchable() and setColumnShrinkable().

Example

The XML layout fragments shown above, when combined, give us a TableLayout
rendition of the “form” we created for RelativelLayout, with the addition of a divider
line between the label/field and the two buttons (found in the Containers/Table
demo):

<?xml version="1.0" encoding="utf-8"?>
<TablelLayout xmlns:android="http://schemas.android.com/apk/res/android"
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android:layout_width="match_parent"
android:layout_height="match_parent"
android:stretchColumns="1">

<TableRow>

<TextView
android:layout_marginLeft="4dip"
android:text="@string/url"/>

<EditText
android:id="@+id/entry"
android:layout_span="3"
android: inputType="text"/>
</TableRow>

<View
android:layout_height="2dip"
android:background="#0000FF" />

<TableRow>

<Button
android:id="@+id/cancel"
android:layout_column="2"
android:text="@string/cancel"/>

<Button
android:id="@+id/ok"
android:text="@string/ok"/>
</TableRow>

</TablelLayout>

When compiled against the generated Java code and run on the emulator, we get:
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*%’ TableLayoutDemo

Cancel OK

Figure 167: The TableLayoutDemo sample application

Android Studio Graphical Layout Editor

You will find TableLayout in the “Layouts” section of the Palette in the Android
Studio Graphical Layout editor. You can drag that into your layout XML resource.

Layouts
| FrameLayout
::iLinearLaycut (Horizon
] LinearLayout (Wertica
= TableRow
[ GridLayout
[ RelativeLayout
Figure 168: Layouts Section of Palette, TableLayout Highlighted
You might expect that you would then drag in TableRow containers as needed for

your rows, then drag widgets into the TableRow containers. That’s not how Android
Studio chose to implement the TablelLayout drag-and-drop support.
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Instead, you drag widgets directly into the TableLayout, which will switch to a “grid
mode”, allowing you to indicate where in a table you want this widget to reside as a

cell:

8 vy o (ETENEIE

Figure 169: TableLayout Drag-and-Drop in Android Studio

Dropping the widget in a given cell position will:

* Add any necessary TableRow widgets, both for the row you requested and
any prior rows that were not already set up, and

* Add the widget into the TableRow, with an android: layout_column value if
needed to put the widget into the desired column in that row

For example, if you start with an empty TableLayout, then drag a CheckBox into “row
2, column 27, you wind up with the following layout XML:

<TablelLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"

android
android
android
android
android
android

:layout_width="match_parent"
:layout_height="match_parent"
:paddinglLeft="@dimen/activity_horizontal_margin"
:paddingRight="@dimen/activity_horizontal_margin"
:paddingTop="@dimen/activity_vertical_margin"
:paddingBottom="@dimen/activity_vertical_margin"

235

Licensed solely for use by Qiwen Chen



OTHER COMMON WIDGETS AND CONTAINERS

tools:context=".MyActivity">

<TableRow
android:layout_width="fill_parent"
android:layout_height="fill_parent"></TableRow>

<TableRow
android:layout_width="fill_parent"
android:layout_height="fill_parent"></TableRow>

<TableRow
android:layout_width="fill_parent"
android:layout_height="fill_parent">

<CheckBox
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="New CheckBox"
android:id="@+id/checkBox2"
android:layout_column="2" />
</TableRow>
</TablelLayout>

Three TableRow widgets were added (for rows o, 1, and 2), and the CheckBox is given
android:layout_column="2" to put it in column 2.

Eclipse Graphical Layout Editor

You will find TablelLayout in the “Layouts” section of the Palette in the Eclipse
Graphical Layout editor. You can drag that into your layout XML resource and start
configuring it via the context menu, notably editing the android:stretchColumns
and android:shrinkColumns values.

In addition, the toolbar above the layout will now sport an add-row button:

:!5 I | =

Figure 170: Eclipse Layout Toolbar for TableLayout

Clicking that adds a TableRow child to the TableLayout, though you will not
necessarily see a visible change. However, now if you start dragging in other widgets,
they will go in that row.
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Once you have started to populate the row and can select it, you will get some more
toolbar buttons:

EE DODEE BE =@
Figure 171: Eclipse Layout Toolbar for TableLayout, with Row Selected

The icon immediately to the right of the add-row button will remove the selected
row from the table. On the far right side of the toolbar are buttons to allow you to
toggle the height and width of the row, plus toggle on and off baseline alignment for
the contents of the row (enabled by default).

Scrollwork

Phone screens tend to be small, which requires developers to use some tricks to
present a lot of information in the limited available space. One trick for doing this is
to use scrolling, so only part of the information is visible at one time, the rest
available via scrolling up or down.

ScrollView is a container that provides scrolling for its contents. You can take a
layout that might be too big for some screens, wrap it in a ScrollView, and still use
your existing layout logic. It just so happens that the user can only see part of your
layout at one time, the rest available via scrolling.

For example, here is a ScrollView used in an XML layout file (from the Containers/
Scroll demo):

<?xml version="1.0" encoding="utf-8"?>
<ScrollView
xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="wrap_content">
<TablelLayout
android:layout_width="match_parent"
android:layout_height="match_parent"
android:stretchColumns="0">
<TableRow>
<View
android:layout_height="80dip"
android:background="#000000"/>
<TextView android:text="#000000"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
<TableRow>
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<View
android:layout_height="80dip"
android:background="#440000" />
<TextView android:text="#440000"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
<TableRow>
<View
android:layout_height="80dip"
android:background="#884400" />
<TextView android:text="#884400"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
<TableRow>
<View
android:layout_height="80dip"
android:background="#aa8844" />
<TextView android:text="#aa8844"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
<TableRow>
<View
android:layout_height="80dip"
android:background="#ffaa88" />
<TextView android:text="#ffaa88"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
<TableRow>
<View
android:layout_height="80dip"
android:background="#ffffaa" />
<TextView android:text="#ffffaa"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
<TableRow>
<View
android:layout_height="80dip"
android:background="#ffffff" />
<TextView android:text="#ffffff"
android:paddinglLeft="4dip"
android:layout_gravity="center_vertical" />
</TableRow>
</TablelLayout>
</ScrollView>

Without the ScrollView, the table would take up at least 560 density-independent
pixels (7 rows at 8o dips each, based on the View declarations). There may be some
devices with screens capable of showing that much information, but many will be
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smaller. The Scrollview lets us keep the table as-is, but only present part of it at a
time.

On the stock Android emulator, when the activity is first viewed, you see:

*@" ScrollViewDemo

#000000|

Figure 172: The ScrollViewDemo sample application

Notice how only five rows and part of the sixth are visible. You can scroll up and
down to see the remaining rows. Also note how the right side of the content gets
clipped by the scrollbar — be sure to put some padding on that side or otherwise
ensure your own content does not get clipped in that fashion.

Android also has HorizontalScrollView, which works like Scrollview... just
horizontally. This would be good for forms that might be too wide rather than too
tall. Note that Scrollview only scrolls vertically and HorizontalScrollView only
scrolls horizontally.

Also, note that you cannot put scrollable items into a ScrollView. For example, a
ListView widget — which we will see in an upcoming chapter — already knows how
to scroll. You do not need to put a ListViewin a ScrollView, and if you were to try,
it would not work very well.
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And, a ScrollView or HorizontalScrollView can only have one child — if you want
more than one, wrap the children in a suitable container class (e.g., a LinearLayout)
and put that inside the ScrollView or HorizontalScrollView.

Android Studio Graphical Layout Editor

The Scrollview and HorizontalScrollView widgets appear in the “Containers”
section of the Palette in the Graphical Layout editor. You can drag one of these into
your layout XML resource, then drag one child into it.

Eclipse Graphical Layout Editor

The Scrollview and HorizontalScrollView widgets appear in the “Composite”
section of the Palette in the Graphical Layout editor. You can drag one of these into
your layout XML resource, then drag one child into it.

Making Progress with ProgressBars

If you are going to fork background threads to do work on behalf of the user, you
will want to think about keeping the user informed that work is going on. This is
particularly true if the user is effectively waiting for that background work to
complete.

The typical approach to keeping users informed of progress is some form of progress
bar, like you see when you copy a bunch of files from place to place in many desktop
operating systems. Android supports this through the ProgressBar widget.

A ProgressBar keeps track of progress, defined as an integer, with 0 indicating no
progress has been made. You can define the maximum end of the range — what
value indicates progress is complete — via setMax(). By default, a ProgressBar
starts with a progress of 0, though you can start from some other position via
setProgress().

If you prefer your progress bar to be indeterminate — meaning that it will show a
general animated effect, rather than a specific amount of progress — use
setIndeterminate(), setting it to true.

In your Java code, you can either positively set the amount of progress that has been
made (via setProgress()) or increment the progress from its current amount (via
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incrementProgressBy()). You can find out how much progress has been made via
getProgress().

We will see a ProgressBar in action in the next chapter, another one of our
tutorials.

Visit the Trails!

The trails portion of the book contains a widget catalog, providing capsule
descriptions and samples for a number of widgets not described elsewhere in this
book.

You might also be interested in GridLayout, which is an alternative to the classic
LinearLayout, Relativelayout, and TablelLayout containers.
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When we actually get around to opening the digital book for display, there will be a
slight delay as the HTML and other assets are read into memory. To help assure the
user that their device has not frozen, we will add a ProgressBar to our user interface
in this tutorial.

This is a continuation of the work we did in the previous tutorial.

You can find the results of the previous tutorial and the results of this tutorial in the
book’s GitHub repository:

* Android Studio previous tutorial and this tutorial
* Eclipse previous tutorial and this tutorial

Step #1: Removing The “Hello, World”

Right now, our user interface consists of a highly-sophisticated “Hello, World” string,
shown in a TextView. While no doubt it is eligible for many design awards, this is
not the user interface we need. So, we need to get rid of it.

The following sections contain instructions for Android Studio and Eclipse —
choose the instructions appropriate for the IDE you are using for these tutorials.

Android Studio

Double-click on the res/layout/main.xml file. This should bring up the graphical
layout editor on your initial layout:
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Figure 173: main. xml Layout in Android Studio

Click on the “Hello, world!” TextView in the middle of that layout to highlight it,
then press the Delete key to delete it. At this point, you can save your file.

Also, we no longer need the hello_world string resource. To remove it, open the
res/values/strings.xml file. Find the <string> element that has a name of
hello_world, delete that element, and save the file.

The resulting XML should resemble:

<?xml version="1.0" encoding="utf-8"?>
<resources>

<string name="app_name">EmPub Lite</string>

</resources>
Eclipse
Double-click on the res/layout/main.xml file in your project in Eclipse’s Package

Explorer. If you do not have such a file, but you have some other layout resource
(e.g., res/layout/activity_main.xml), rename it to main.xml by right-clicking over
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the file in the Package Explorer and choosing Refactor > Rename from the right-
mouse menu. Then double-click on the newly-renamed file.

This will bring up our current user interface:

| Bl ma nl 2 a)

+ — Palette — | ~ Structure —
@ v @Nexusone v B v AppTheme v @ MainActivity v v :
| Palette == PP Ly, % Outline
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CheckBox
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8 ProgressBar (Normal)
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Figure 174: EmPubLiteActivity, in Eclipse

Click on the “Hello World!” string, then press the <Delete> key. You can now save
your file (e.g., <Ctrl>-<S>).

Also, we no longer need the hello_world string resource. To remove it, double-click
on the res/values/strings.xml file, select the hello_world string resource, click

the “Remove..” button, click “Yes” on the confirmation dialog. Then you can save the
file.

Step #2: Adding a ProgressBar

Now that the TextView is out of the way, we can add our ProgressBar in its place.

The following sections contain instructions for Android Studio and Eclipse —
choose the instructions appropriate for the IDE you are using for these tutorials.
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Android Studio

Go back to res/layout/main.xml in Android Studio. In the “Widgets” portion of the
tool palette, you will see a few ProgressBar widget entries:

Widgets
[8E] Plain Textview
[4b] Large Text
[80] Medium Text
[8B] Small Text
k& Button
It small Button
(@) RadioButton
(| CheckBox
o Switch
ToggleButton
E ImageButton
B Imageview
== ProgressBar (Mormal]
== PragressBar (Small)
= ProgressBar (Horizomr
o SeekBar
‘% RatingBar
Spinner
@ WebView

Figure 175: ProgressBar Widgets in the Tool Palette

Drag the “Large” one out of the palette and onto the preview of our activity. You will
see a tooltip pointing out the RelativelLayout rules that the drag-and-drop
operation will apply if you drop the widget in its current location. Slide the
ProgressBar around until you center it and the tooltip shows that it will use
centerHorizontal and centerVertical rules. If you wind up with centerInParent
instead of those other two settings, that is fine as well.

In the Properties list on the right, find the “id” row, and change the value for the “id”
to progressBar1 (to match what Eclipse’s drag-and-drop GUI builder uses, to keep
the two sets of instructions synchronized).

At this point, you can save your file.
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Eclipse

Go back to res/layout/main.xml in Eclipse. In the “Form Widgets” portion of the
tool palette, you will see a few ProgressBar widget entries:

1 Palette
™ Palette -

= Form Widgets

tensvizw: | arge Medium small - Bulton

Small QFF " ChenkAiny

®  HAadinButtnn Chacked TextView

Spinner

[}

L

Figure 176: ProgressBar Widgets in the Tool Palette

Drag the “Large” one out of the palette and onto the preview of our activity. You will
see a tooltip pointing out the RelativelLayout rules that the drag-and-drop
operation will apply if you drop the widget in its current location. Slide the
ProgressBar around until you center it and the tooltip shows that it will use
android:layout_centerHorizontal="true" and
android:layout_centerVertical="true". If you wind up with
android:layout_centerInParent="true" instead of those other two settings, that is
fine as well.

If you are having difficulty centering it, drop it anywhere in the white part of the
preview area. Then, from the toolbar above the preview, press the center-horizontal
and center-vertical toolbar buttons in succession:

2 = 8@
Figure 177: The Centering Toolbar Buttons (Third and Fourth from Right)
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Then, you can save your file.

Step #3: Seeing the Results

If you run the app in a device or emulator, you will see your ProgressBar widget,
sitting there, all alone, waiting for somebody to write more code in support of it:

& EmPub Lite

Figure 178: EmPubLite, With ProgressBar

Note that if you have not yet set up the x86 emulator, you might wish to consider
doing so, as we will become increasingly dependent upon the emulator, and the
ARM emulator is slow. There is a section later in the book that covers how to set up
the x86 emulator.

In Our Next Episode...

... we will attach a third-party library to our tutorial project.
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GUI Building, Continued

If you are using an IDE, and you have been experimenting with the graphical layout
editor and drag-and-drop GUI building, this chapter will cover some other general
features of this editor that you may find useful.

Even if you are not using an IDE, you may want to at least skim this chapter, as you
will find a few tricks that will be relevant for you as well.

Making Your Selection

Clicking on a widget makes it the selected widget, meaning that the toolbar buttons
will affect that widget (or, sometimes, its container, depending upon the button).
Selected widgets have a thin blue border with blue square “grab handles” for
adjusting its size and position.
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Fifty Percent

Thirty Percent

Twenty Percent

Figure 179: Android Studio, Selected Widget in Graphical Layout Editor

Clicking on a container also selects it. However, there may or may not be a blue
border — in particular, containers that fill the screen (match_parent for width and
height) do not seem to get the border.

Sometimes, though, you want to select a container that you cannot reach, because
its contents are completely filled with widgets. That occurs with the LinearPercent
sample from a previous chapter - the entire LinearLayout is filled with the three
Button widgets. In these cases, click on the widget or container in the Component
Tree (Android Studio) or Outline (Eclipse) pane to select it.

Including Includes

Sometimes, you have a widget or a collection of widgets that you want to reuse
across multiple layout XML resources. Android supports the notion of an “include”
that allows this. Simply create a dedicated layout XML resource that contains the
widget(s) to reuse, then add them to your main layouts via an <include> element:

<include layout="@layout/thing_we_are_reusing" />
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You can even assign the <include> element a width or height if needed, as if it were
just a widget or container.

The IDE makes it easy for you to take widgets from an existing layout XML resource

and extract them into a separate layout XML resource, replacing them with an
<include> element.

In Android Studio, select the widget(s) that you want to reuse, then choose Refactor
> Extract Layout from the context menu. This will display a dialog where you can fill
in the file name of your resulting resource:

Extract Android Layout

File name: ||

Source set; |main T

Directory name; | layout

Awailable qualifiers: Chosen qualifiers:

N Country Code

@ Network Code
@ Language

i@ Region

= Layout Direction |
E Smallest Screen width | |
& Screen Width I
[ Screen Height

H size

[ Ratio

% Enter a new name
| OK ‘ | Cancel ‘
Figure 180: Android Studio Extract Layout Dialog
In Eclipse, select the widget(s) that you want to reuse, then right-click over them

and choose “Extract Include” from the context menu. This will bring up a dialog
where you can specify a name to give the new layout XML resource:
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@ Extract as Include

New Layout Name: || |

& Replace occurrences in all layouts with include to new layout

@ Provide a name for the new layout

Cancel

Figure 181: Extract as Include Dialog

By default, Eclipse will search all your layout files for these widgets and replace them
with the <include>, though you can uncheck the checkbox to disable this behavior
and only affect the layout XML resource you are presently editing.

If you are extracting multiple widgets that are not wrapped in their own container,
the IDE will automatically wrap them in a <merge> element:

<?xml version="1.0" encoding="utf-8"?>

<merge xmlns:android="http://schemas.android.com/apk/res/android">
</-- widgets go here -->

</merge>

This is necessary purely from an XML standpoint — you cannot have multiple root
elements in an XML file. When the <merge> is added to another layout via
<include>, the <merge> element itself evaporates, leaving behind its children.

Wrap It Up (In a Container)

Sometimes, after you have added a widget to your layout, you later determine that
you really needed it to be in some sort of container. For example, perhaps you
thought you only needed one TextView but later decided to stack two TextView
widgets in a vertical LinearLayout, in which case you somehow need to introduce
this LinearLayout into the mix.

In Eclipse, the simplest way to do that is to right-click over the widget that needs a
new container (in the preview pane or the Outline pane) and choose “Wrap In
Container...” from the context menu. This will bring up a dialog allowing you to
choose the class of the container (with a reasonable default pre-selected) and give
the container an android:id value (which, for some strange reason, is mandatory).
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€ Wrap in Container

Type of Container: | LinearLayout (Horizontal) =

New Layout Id:

@ D required

Cancel

Figure 182: Wrap In Container Dialog

Similarly, if a widget is wrapped in a container, where the container is no longer
necessary, “Remove Container” will get rid of the container.

Note that Android Studio does not offer this feature.

Morphing Widgets

Occasionally, you might configure a widget, only to decide later on that you really
want it to be a different type of widget. For example, perhaps you start with a
CheckBox and later want to switch it to be a ToggleButton.

To do this in Android Studio, right-click over the widget (in the preview pane or the
Component Tree pane) and choose Morphing from the context menu. This brings
up a fly-out menu of possible alternative classes; choosing one will automatically
convert your widget into the selected type.

To do this in Eclipse, right-click over the widget (in the preview pane or the Outline
pane) and choose “Change Widget Type” from the context menu. This will bring up
a dialog box for you to choose a replacement widget class, with a likely candidate
pre-selected for you:

€ Change Widget Type

New Widget Type: | CheckBox |

Preview> | | oK | Cancel

Figure 183: Change Widget Type
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After making the selection, Eclipse will alter your element to the new widget type.
Note that you may need to make other changes yourself, for attributes that you no
longer need or now need to add.

Preview of Coming Attractions

At the top of the graphical layout editor, you will find a series of drop-downs that
allow you to tailor what the preview looks like:

L+ [0 Nexus 4+ » @Hola | T+ @~ @L-

Figure 184: Android Studio Preview Controls

default [ NexusOnev Ev YrThemew

Figure 185: Eclipse Preview Controls

Your IDE will choose some likely defaults based upon your project settings, but you
are welcome to change them as you see fit. Notable changes include:

* What version of Android is used for the preview (as widget styling changes
from time to time in Android releases)

+ What language is used for your string resources?

* What size and resolution of screen is used?

+ Is it displayed in portrait or landscape?

These only affect the preview, so they show you (approximately) what your layout
will look like under those conditions, but they do not modify anything about your
layout XML itself.
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If you want the user to choose something out of a collection of somethings, you
could use a bunch of RadioButton widgets. However, Android has a series of more
flexible widgets than that, ones that this book will refer to as “selection widgets”.

These include:

* ListView, which is your typical “list box”

* Spinner, which (more or less) is a drop-down list

* GridView, offering a two-dimensional roster of choices

* ExpandableListView, a limited “tree” widget, supporting two levels in the
hierarchy

and many more.

At their core, these are ordinary widgets. You will find them in your tool palette of
your IDE’s graphical layout editor, and can drag them and position them as you see
fit.

The key is that these all have a common superclass: AdapterView, so named because

they partner with objects implementing the Adapter interface to determine what
choices are available for the user to choose from.

Adapting to the Circumstances

An Adapter is your bridge between your model data and that data’s visual
representation in the AdapterView:
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* an Adapter might “adapt” an Invoice into a View that would serve as a row
inalistView

* an Adapter might “adapt” a Book into a View that would serve as a cell in a
GridView

* and so on

Android ships with several Adapter classes ready for your use, where the different
adapter classes are designed to “adapt” different sorts of collections (e.g., arrays
versus results of database queries). Android also has a BaseAdapter class that can
serve as the foundation for your own Adapter implementation, if you need to
“adapt” a collection of data that does not fit any of the Adapter classes supplied by
Android.

Using ArrayAdapter

The easiest adapter to use is ArrayAdapter — all you need to do is wrap one of these
around a Java array or java.util.List instance, and you have a fully-functioning
adapter:

String[] items={"this", "is", "a", "really", "silly", "list"};

new ArrayAdapter<String>(this,
android.R.layout.simple_list_item_1,
items);

One flavor of the ArrayAdapter constructor takes three parameters:

1. The Context to use (typically this will be your activity instance)

2. The resource ID of a view to use (such as a built-in system resource ID, as
shown above)

3. The actual array or list of items to show

By default, the ArrayAdapter will invoke toString() on the objects in the list and
wrap each of those strings in the view designated by the supplied resource.
android.R.layout.simple_list_item_1 simply turns those strings into TextView
objects. Those TextView widgets, in turn, will be shown in the list or spinner or
whatever widget uses this ArrayAdapter. If you want to see what
android.R.layout.simple_list_item_1 looks like, you can find a copy of it in your
SDK installation — just search for simple_list_item_1.xml.

We will see in a later section how to subclass an Adapter and override row creation,
to give you greater control over how rows and cells appear.
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Lists of Naughty and Nice

The classic listbox widget in Android is known as ListView. Include one of these in
your layout, invoke setAdapter () to supply your data and child views, and attach a
listener via setOnItemSelectedListener() to find out when the selection has
changed. With that, you have a fully-functioning listbox.

However, if your activity is dominated by a single list, you might well consider
creating your activity as a subclass of ListActivity, rather than the regular
Activity base class. If your main view is just the list, you do not even need to supply
a layout — ListActivity will construct a full-screen list for you. If you do want to
customize the layout, you can, so long as you identify your ListView as
@android:id/list, so ListActivity knows which widget is the main list for the
activity.

For example, here is a layout pulled from the Selection/List sample project:

<?xml version="1.0" encoding="utf-8"?>
<LinearlLayout
xmlns:android="http://schemas.android.com/apk/res/android"
android:orientation="vertical"
android:layout_width="match_parent"
android:layout_height="match_parent" >
<TextView
android:id="@+id/selection"
android:layout_width="match_parent"
android:layout_height="wrap_content"/>
<ListView
android:id="@android:id/1list"
android:layout_width="match_parent"
android:layout_height="match_parent"
/>
</LinearlLayout>

It is just a list with a label on top to show the current selection.

The Java code to configure the list and connect the list with the label is:

package com.commonsware.android.list;

import android.app.ListActivity;
import android.os.Bundle;

import android.view.View;

import android.widget.ArrayAdapter;
import android.widget.ListView;
import android.widget.TextView;
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public class ListViewDemo extends ListActivity {
private TextView selection;

private static final String[] items={"lorem", "ipsum", "dolor",
"sit", "amet",
"consectetuer", "adipiscing", "elit", "morbi", "vel",
"ligula", "vitae", "arcu", "aliquet", "mollis",
"etiam", "vel", "erat", "placerat", "ante",
"porttitor", "sodales", "pellentesque", "augue", "purus"};
@Override

public void onCreate(Bundle icicle) {
super.onCreate(icicle);
setContentView(R.layout.main);
setListAdapter(new ArrayAdapter<String>(this,
android.R.layout.simple_list_item_1,

items));

selection=(TextView)findViewById(R.id.selection);

}

@Override

public void onListItemClick(ListView parent, View v, int position,

long id) {

selection.setText(items[position]);

}

}

With ListActivity, you can set the list adapter via setListAdapter() — in this
case, providing an ArrayAdapter wrapping an array of Latin strings. To find out
when the list selection changes, override onListItemClick() and take appropriate
steps based on the supplied child view and position (in this case, updating the label
with the text for that position).

The results?
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Figure 186: ListViewDemo, After User Taps on “consecteteur”

The second parameter to our ArrayAdapter —
android.R.layout.simple_list_item_1 — controls what the rows look like. The
value used in the preceding example provides the standard Android list row: a big
font with lots of padding to offer a large touch target for the user.

Clicks versus Selections

One thing that can confuse some Android developers is the distinction between
clicks and selections. One might think that they are the same thing — after all,
clicking on something selects it, right?

Well, no. At least, not in Android. At least not all of the time.

Android is designed to be used with touchscreen devices and non-touchscreen
devices. Historically, Android has been dominated by devices that only offered
touchscreens. However, there are various devices powered by Android and
connected to TVs. Most TVs are not touchscreens, and so users of those TV-using
Android devices will use some sort of remote control to drive Android. And some
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Android devices offer both touchscreens and some other sort of pointing device —
D-pad, trackball, arrow keys, etc.

To accommodate both styles of device, Android sometimes makes a distinction
between selection events and click events. Widgets based off of the “spinner”
paradigm — including Spinner — treat everything as selection events. Other
widgets — like ListView and Gridview — treat selection events and click events
differently. For these widgets, selection events are driven by the pointing device,
such as using arrow keys to move a highlight bar up and down a list. Click events are
when the user either “clicks” the pointing device (e.g., presses the center D-pad
button) or taps on something in the widget using the touchscreen.

Choice Modes

By default, ListView is set up simply to collect clicks on list entries. Sometimes,
though, you want a list that tracks a user’s choice, or possibly multiple choices.
ListView can handle that as well, but it requires a few changes.

First, you will need to call setChoiceMode() on the ListView in Java code to set the
choice mode, classically supplying either CHOICE_MODE_SINGLE or
CHOICE_MODE_MULTIPLE as the value. You can get your ListView from a ListActivity
via getListView(). You can also declare this via the android: choiceMode attribute
in your layout XML.

Then, rather than use android.R.layout.simple_list_item_1 as the layout for the
list rows in your ArrayAdapter constructor, you can use either
android.R.layout.simple_list_item_single_choice or
android.R.layout.simple_list_item_multiple_choice for single-choice or
multiple-choice lists, respectively.

For example, here is an activity layout from the Selection/Checklist sample
project:

<?xml version="1.0" encoding="utf-8"?>

<ListView

xmlns:android="http://schemas.android.com/apk/res/android"
android:id="@android:id/1list"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:drawSelectorOnTop="false"
android:choiceMode="multipleChoice"

/>
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It is a full-screen ListView, with the android:choiceMode="multipleChoice"
attribute to indicate that we want multiple choice support.

Our activity just uses a standard ArrayAdapter on our list of Latin words, but uses
android.R.layout.simple_list_item_multiple_choice as the row layout:

package com.commonsware.android.checklist;
import android.app.ListActivity;

import android.os.Bundle;

import android.widget.ArrayAdapter;

public class ChecklistDemo extends ListActivity {

private static final String[] items={"lorem", "ipsum", "dolor",
"sit", "amet",
"consectetuer", "adipiscing", "elit", "morbi", "vel",
"ligula", "vitae", "arcu", "aliquet", "mollis",
"etiam", "vel", "erat", "placerat", "ante",
"porttitor", "sodales", "pellentesque", "augue", "purus"};
@Override

public void onCreate(Bundle icicle) {
super.onCreate(icicle);
setContentView(R.layout.main);
setListAdapter(new ArrayAdapter<String>(this,
android.R.layout.simple_list_item_multiple_choice,
items));
}
}

What the user sees is the list of words with checkboxes down the right edge:
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Figure 187: Multiple-Choice Mode

If we wanted, we could call methods like getCheckedItemPositions() on our
ListView to find out which items the user checked, or setItemChecked() if we
wanted to check (or un-check) a specific entry ourselves.

Clicks versus Selections, Revisited

If the user clicks a row in a ListView, a click event is registered, triggering things
like onListItemClick() in an OnItemClickListener. If the user uses a pointing
device to change a selection (e.g., pressing up and down arrows to move a highlight
bar in the ListView), that triggers onItemSelected() in an
OnItemSelectedListener.

Many times, particularly if the ListView is the entire Ul at present, you only care
about clicks. Sometimes, particularly if the ListView is adjacent to something else
(e.g., on a TV, where you have more screen space and do not have a touchscreen),
you will care more about selection events. Either way, you can get the events you
need.
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Spin Control

In Android, the Spinner is the equivalent of the drop-down selector you might find
in other toolkits. Clicking the Spinner drops down a list for the user to choose an

item from. You basically get the ability to choose an item from a list without taking
up all the screen space of a ListView, at the cost of an extra click to make a change.

As with ListView, you provide the adapter for data and child views via
setAdapter () and hook in a listener object for selections via
setOnItemSelectedListener ().

To tailor the view used when displaying the drop-down perspective, you need to
configure the adapter, not the Spinner widget. Use the setDropDownViewResource()
method to supply the resource ID of the view to use.

For example, culled from the Selection/Spinner sample project, here is an XML
layout for a simple view with a Spinner:

<?xml version="1.0" encoding="utf-8"?>
<LinearlLayout
xmlns:android="http://schemas.android.com/apk/res/android"
android:orientation="vertical"
android:layout_width="match_parent"
android:layout_height="match_parent"
>
<TextView
android:id="@+id/selection"
android:layout_width="match_parent"
android:layout_height="wrap_content"
/>
<Spinner android:id="@+id/spinner"
android:layout_width="match_parent"
android:layout_height="wrap_content"
/>
</LinearlLayout>

This is the same view as shown in a previous section, just with a Spinner instead of a
ListView.

To populate and use the Spinner, we need some Java code:

public class SpinnerDemo extends Activity
implements AdapterView.OnItemSelectedListener {
private TextView selection;
private static final String[] items={"lorem", "ipsum", "dolor",
"sit", "amet",
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"consectetuer", "adipiscing", "elit", "morbi", "vel",
"ligula", "vitae", "arcu", "aliquet", "mollis",

"etiam", "vel", "erat", "placerat", "ante",

"porttitor", "sodales", "pellentesque", "augue", "purus"};

@Override

public void onCreate(Bundle icicle) {
super.onCreate(icicle);
setContentView(R.layout.main);
selection=(TextView)findViewById(R.id.selection);

Spinner spin=(Spinner)findViewById(R.id.spinner);
spin.setOnItemSelectedListener(this);

ArrayAdapter<String> aa=new ArrayAdapter<String>(this,
android.R.layout.simple_spinner_item,
items);

aa.setDropDownViewResource(
android.R.layout.simple_spinner_dropdown_item);
spin.setAdapter(aa);
}

@Override
public void onItemSelected(AdapterView<?> parent,
View v, int position, long id) {
selection.setText(items[position]);
}

@0override
public void onNothingSelected(AdapterView<?> parent) {
selection.setText("");
¥
¥

Here, we attach the activity itself as the selection listener
(spin.setOnItemSelectedListener(this)), as Spinner widgets only support
selection events, not click events. This works because the activity implements the
OnItemSelectedListener interface. We configure the adapter not only with the list
of fake words, but also with a specific resource to use for the drop-down view (via
aa.setDropDownViewResource()). Also note the use of
android.R.layout.simple_spinner_item as the built-in View for showing items in
the spinner itself. Finally, we implement the callbacks required by
OnItemSelectedListener to adjust the selection label based on user input.

What we get is:
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Figure 188: SpinnerDemo, as Initially Launched

amet

consectetuer

adipiscing

elit

Figure 189: SpinnerDemo, with Spinner Drop-Down List Displayed
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Grid Your Lions (Or Something Like That...)

As the name suggests, GridView gives you a two-dimensional grid of items to choose
from. You have moderate control over the number and size of the columns; the
number of rows is dynamically determined based on the number of items the
supplied adapter says are available for viewing.

There are a few properties which, when combined, determine the number of
columns and their sizes:

1. android:numColumns spells out how many columns there are, or, if you
supply a value of auto_fit, Android will compute the number of columns
based on available space and the properties listed below.

2. android:verticalSpacing and android:horizontalSpacing indicate how
much whitespace there should be between items in the grid.

3. android:columnWidth indicates how wide each column should be, in terms
of some dimension value (e.g., 40dp or @dimen/grid_column_width).

4. android:stretchMode indicates, for grids with auto_fit for
android:numColumns, what should happen for any available space not taken
up by columns or spacing — this should be columnWidth to have the
columns take up available space or spacingWidth to have the whitespace
between columns absorb extra space.

Otherwise, the Gridview works much like any other selection widget — use
setAdapter () to provide the data and child views, invoke
setOnItemClickListener () to find out when somebody clicks on a cell in the grid,
etc.

For example, here is an XML layout from the Selection/Grid sample project,
showing a GridView configuration:

<?xml version="1.0" encoding="utf-8"?>

<LinearlLayout
xmlns:android="http://schemas.android.com/apk/res/android"
android:orientation="vertical"
android:layout_width="match_parent"
android:layout_height="match_parent"
>

<TextView
android:id="@+id/selection"
android:layout_width="match_parent"
android:layout_height="wrap_content"
/>

<GridView
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android:id="@+id/grid"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:verticalSpacing="40dip"
android:horizontalSpacing="5dip"
android:numColumns="auto_fit"
android:columnWidth="100dip"
android:stretchMode="columnWidth"
android:gravity="center"
/>

</LinearlLayout>

For this grid, we take up the entire screen except for what our selection label
requires. The number of columns is computed by Android (android:numColumns =
"auto_fit") based on our horizontal spacing (android:horizontalSpacing =
"5dip") and columns width (android:columnWidth = "100dip"), with the columns
absorbing any “slop” width left over (android:stretchMode = "columnWidth").

The Java code to configure the GridVview is:

package com.commonsware.android.grid;

import android.app.Activity;

import android.os.Bundle;

import android.view.View;

import android.widget.AdapterView;
import android.widget.ArrayAdapter;
import android.widget.GridView;
import android.widget.TextView;

public class GridDemo extends Activity
implements AdapterView.OnItemClickListener {
private TextView selection;

private static final String[] items={"lorem", "ipsum", "dolor",
"sit", "amet",
"consectetuer", "adipiscing", "elit", "morbi", "vel",
"ligula", "vitae", "arcu", "aliquet", "mollis",
"etiam", "vel", "erat", "placerat", "ante",
"porttitor", "sodales", "pellentesque", "augue", "purus"};
@Override

public void onCreate(Bundle icicle) {
super.onCreate(icicle);
setContentView(R.layout.main);
selection=(TextView)findViewById(R.id.selection);

GridView g=(GridView) findViewById(R.id.grid);
g.setAdapter(new ArrayAdapter<String>(this,
R.layout.cell,
items));
g.setOnItemClickListener(this);
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@Override
public void onItemClick(AdapterView<?> parent, View v,
int position, long id) {
selection.setText(items[position]);
}
}

The grid cells are defined by a separate res/layout/cell.xml file, referenced in our
ArrayAdapter as R.layout.cell:

<?xml version="1.0" encoding="utf-8"?>

<TextView
xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:textSize="14dip"

/>

With the vertical spacing from the XML layout (android:verticalSpacing =
"40dip"), the grid overflows the boundaries of the emulator’s screen:

*g” GridDemo

lorem Ipsum

consectetuer

adipiscing morbi

ligula

aliquet mollis

etiam

placerat porttitor

sodales pellentesque augue

Figure 190: GridDemo, as Initially Launched
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Figure 191: GridDemo, Scrolled to the Bottom of the Grid

GridView, like ListView, supports both click events and selection events. In this
sample, we register an OnItemClickListener to listen for click events.

Fields: Now With 35% Less Typing!

The AutoCompleteTextView is sort of a hybrid between the EditText (field) and the
Spinner. With auto-completion, as the user types, the text is treated as a prefix filter,
comparing the entered text as a prefix against a list of candidates. Matches are
shown in a selec